SWITCH kit with The Legend of Zelda:

Breath of the Wild & Just Dance 2017

» 326B Internal Storage » Custom NVIDIA Tegra Pracessor

» 6.2 1280 x 720 Capacitive Touchscreen

» Includes Two Joy-Con Controllers & Grip

» Three to Six Hours of Battery Life » IWirelessly Link up to Eight
Systems » [Expandable Storage via microSD Cards

Switch Kit with The Legend of Zelda: Breath of the Wild & Just

Dance 2017 (Gray Joy-Con) (NISWITCHGYCK) .........oooocoo 489.95
Switch Kit with The Legend of Zelda: Breath of the Wild & Just
Dance 2017 (Neon Blue & Red Joy-Con) (NISWITCHNBRK).............. 489.95

Switch Pro

Controller

» Compatible with
the Nintendo Switch
» Mation Controls
» HD Rumble
» Built-In amiibo Functionality

(NIHACAFSSKAJ............. 69.99

Razer OSVR
Hacker Dev Kit v2.0

» Open-Source Virtual Reality Headset

» User Upgradeable

» Dual-Display 2160 x 1200
Resolution

» OLED Display with 441 PPI
at 90 FPS » IR Positioning with Faceplate and Camera

» Individual Eye Focus Adjustments

» Accelerometer, Gyroscope, Compass » Belt Box Module

(RAOSVRV2)

399.99

VR GAMING & ACCESSORIES

i

NINTENDO

SWITCH

Nunchuk Controller
Wii & Wii U, Black

» Connects to a Wii Remate Plus

» Nintendo Wii & Wii U Compatible
» Motion Sensitive

» Built-In Analog Stick

» Ergonomic Grip

» Ambidextrous Design

(NIRVLAFK3)

THRUSTMASTER"® T150
Force Feedback Racing Wheel

» Force Feedback Haptic Response 1
» 270-1080° Wheel Rotation /A
» 13 Actions Buttons & D-Pad [

» Two Wheel-Mounted B

Paddle Shifters

» Large, Optimized Pedal Set .
» Internal Memory & Upgradeable Firmware
» Compatible with PS3, PS4 & Windows PCs

(THT150RS) 195.54

COMPUTERS

elgato GameCapture HD60S

High Definition Game Recorder

» Capture Gameplay in 1080p at 60 fps
» Live Stream to Twitch and YouTube
» Stream Command

» Flashback Recording

» Advanced H.264 Encoding

» HDMI Pass-Through to TV

» Record Gameplay to a PC or Mac
» For PS4, Xbox One, Wii U, & Xbox 360

(EL6CHDAO0S) S 154.99

elgato Game Capture HD60 Pro
High Definition Game Recorder

» Capture Gameplay in 1080p at 60 fps
» Live Stream to Twitch and YouTube
» Stream Command

» Flashback Recording

» Advanced H.264 Encoding
» HDMI Pass-Through to TV
» Record Gameplay to a Windows PC
» For PS4, Xbox One, Wii U, & Xbox 360

(ELGCHD6OPRO) 188.95

THRUSTMASTER® HOTAS
Warthog Flight Stick and Throttle

» Replica Joystick / Dual Thrattles

» Replica Backlit Control Panel w/ 5 LEDs
» b1 Programmable Action Buttons
» T Hat Buttons and 1 Trim Wheel
» USB Plug-and-Play

» Realistic Idle and Afterburner Detent
» 3-D Magnetic Sensor Technology

» Realistic Weighted and Metal Design
(THHOTAS)

444,48

The trend of action figures interacting with the latest hot
game titles brings toys-to-life, utilizing a third-person
camera view and in-game power-up figures. Using the near
field communication (NFC) protocol, gamers can determine
the individual figuring’s proximity and save progress data
within the figure. Available individual figures and game
packs include Disney Infinity and amiibo. Check out the B&H
Interactive Gaming Figures page for the available figures.

B&H carries a wide assortment of console and PC games,
compatible with Sony, Xbox, Nintendo and Windows
based titles for every serious gamer. Games including
Minecraft, MLB 15, Madden NFL, Guitar Hero, FIFA 16,
NBA 2K16, PGA Tour, Dragonbakk Xenoverse, Need for
Speed, Star Wars Battlefront, Duck Dynasty and many
more. Check out the B&H Gaming page for the latest
available titles.

P mra
2R XBOX ONE

www.BandH.com BSH



COMPUTERS

SONY PlayStation 4 Pro Gaming Console

Go beyond 1080p with the Sony PlayStation 4 Pro Gaming Console. With updated graphics architecture and
support for 4K gaming, the PS4 Pro provides increased detail, higher-resolution graphics. High Dynamic Range
(HDR) gaming and content is also supported, which takes advantage of increased color depth and contrast.

» AMD Radeon Polaris Architecture » 8GB of GDDRb RAM » 1TB Storage Capacity

» Blu-Ray Disc Player » Sony DualShock 4 Wireless Controller » 4K Gaming Support

» High Dynamic Range (HDR) Support » 4K Video Streaming Services Supported

» 802.11ac Wi-Fi, Bluetooth 4.0 + LE » Optional PlayStation Plus Membership

PS4 Playstation 4 Pro Console only (SOPS41T8)

GAMING CONSOLES & ACCESSORIES

P mra

PS4 Slim Uncharted 4 Bundle (SOPS4UBA4US)

PS4 Playstation 4 Pro Gaming Console & Extra Controller Kit (SOPS41TBCK)

THRUSTMASTER" T300RS Ferrari

Integral Racing Wheel Alcantara Edition

» Replica Wheel of the Ferrari 599XX EVo

» 11080° Force Feedback

» Detachable Racing Wheel

» Fully Adjustable Metal Pedals

» Thrustmaster Quick Release
System

» Hand-Stitched Alcantara Wrapping

» Compatible with Sony PS3 & PS4 and PC

(THT300FRWAE)

469.99

NYKO TypePad
for PS4

» QWERTY Keyboard

» Bluetooth Connectivity

» Attaches to the
DualShock 4 Controller

» Sony PlayStation 4 Compatible

(NYFOKBDSA) oo 16,90

(®  DualShock 4

Powers  Charging Station

» Charges 2
DualShock 4
Controllers

» Sony PlayStation 4
Compatible

[POPSACS) o 1879

%ﬁ’razzx Enzo
Gaming Chair

» Ergonomic Design

» Padded Backrest, Armrest, & Seat
» Height Adjustable

» 270 lbs. Max Capacity

» Synthetic PU Leather

» Available in Black, Blue, Green,
Red, White & Orange
BLUE (AREGCBLU) oo

THRUSTMASTER® T300RS
Racing Wheel

» Fully Adjustable Metal Pedals

» Detachable Racing Wheel

» 1080° Force Feedback

» Thrustmaster Quick
Release System

» Robust & Versatile
Attachment System

» Features Official PlayStation 4 Buttons

(THT300RSRW).....ooooo o

B ) [ |

21B Upgrade Kit

B . for PlayStation 4

”~
» 21B 5400 rpm
Hard Drive

-

» 86B Flash Drive Included » Aluminum External Enclosure
Included » PlayStation 3 & 4 Compatible

(FAPSA2TBKIT) ..o

v 117.95

7ma DIY1TB HDD

Drive Upgrade Bundle for the
PlayStation 4

»

(OWCSPSAHEST0) ..o . 87,50

oPLawseat. Evolution
Alcantara Gaming Seat

» Supports Most
Driving Wheels
&Pedals

» Black Alcantara
Seat Covers

» 270 b (122 kg)
Maximum Weight

» Compatible with Most Gaming Systems

(PLEBSALC...ccrre

- 381,99

SONY DualShock 4
Wireless Controller (Black, 2016 Version)

» Share Button, PS Button
» Clickable 2-Point Capacitive
Touch Pad
» Dual Analog Sticks, D-Pad,
Game Buttons
» Micro-USB Port, Stereo Headset Jack
» Built-In Mona Speaker » Light Bar, Vibration Support e
» Bluetooth 2.1+EDR Wireless Connectivity
Available in White, or Black (S03001538) .............................. 44.30

THRUSTMASTER"® T80
Racing Wheel

» Officially Licensed
by PlayStation

» Wheel and Pedal Set

» Rubber Texture Grip

» Two Sequential Gear Shift Paddles

» 11 Action Buttons + D-Pad

» Brake Pedal Has Progressive Resistance

» Central Clamping System

(THTBORW) 89.99

NYKO PS4

Intercooler

~

» Power Pass-Through Technology
» Pushes Hot Air Away from Console
» Matches the PlayStation 4

» User-Friendly, Clip-On Installation
» Sony PlayStation 4 Compatible
(NYINPSAB) . 16,89

SONYY PlayStation (PS4)

Camera

» Navigate, Play,
and Share

» Hands-Free System Navigation

» Head and Gesture Tracking

» Voice Commands » Live Broadcasting

[SOPSACAMUS) - 65,20

oPLawseat. Racing F1
Seat (Red Bull)

» Supports Most
Driving Wheels
& Pedals
» Red Bull Racing F1 -
Design
» 270 lbs (122 kg)
Maximum Weight
» Compatible with Most Gaming Systems

[PLETRSRB) o 1,199.00

800-947-3308 - 212-444-6691




Microsoft Xhox0ne Gaming Console

The Xbox One Gaming Console from Microsoft delivers a next-gen experience in both gaming and multimedia.
With high-res graphics and fast performance, the Xbox One allows you to game on your own terms. You can
snap two windows together on the same screen so you can watch TV while you play your game.
Xbox Live allows you to test your skills against other players around the world. Xbox SmartGlass
allows you to connect your smartphone or tablet to your Xbox One for intuitive access and control.

» AMD Radeon Graphics Core Next Engine > Custom 8-Core x86 AMD
Processor » 86B of RAM + 32MB of ESRAM » 10/100/1000 Mbps
Gigabit Ethernet » 802.11n Wi-Fi » Blu-ray Optical Drive

» Xbox SmartGlass Support » Xbox One Wireless Controller Included

» Xbox Live Gold Subscription Support

Micresoft Xbox One Wireless Controller
(2016 Version, White)
» Built-in Stereo Headset Jack

» Impulse Triggers

» Refined Bumpers

Tt
e
® - 8.0

» Textured Grips

» Bluetoath Technology

» Up to 2X the Wireless Range . .

» Xbox One/Windows 7, 8, & 10 Compatible

Available in Black, Blue, White (MIXBOWLC) 59.00
Xbox One Gears of War 4 Crimson Omen (MIWL300001) ... 69.00

THRUSTNVIASTER" TMX Force

Feedback Racing Wheel

» 11" Ergonomic,
Rubber-Coated Wheel

» 270-900° Wheel Rotation

» 12 Action Buttons & D-Pad

» Two Wheel-Mounted
Paddle Shifters » Large, Optimized Pedal Set » Built-In Official
Xbox One Buttons » Adjustable Force Feedback System

» Officially Certified for Xbox One

[THRWPSXOW) . 199,00

THRUSTMASTER" Ferrari 458 Spider
Racing Wheel for Xbox One

» For Xbox One D
» Officially Licensed n‘

by Ferrari/Xbox One o) N
» Wheel and Pedal Set & § 4
» Two Red Rubber- T 4

Textured Grips
» Metal Paddle Shifters » Adjustable Sensitivity
» Kinect Detection LED » Central Clamping System

(THSRW) 99.99

Microsoft Kinect Sensor
for Xbox One

)

» Cortana Integration
» Use Your Voice & Gestures
» Microsoft Xbox One Compatible

(MIKSXBOBLK) .. 99,99

www.BandH.com

GAMING CONSOLES & ACCESSORIES

2% XBOX ONE

Xbox One S Minecraft Favorites Bundle with Additional Controller Kit
(White) (MIXB1S500MCK) 344.44
Xbox One S Minecraft Favorites Bundle (MIXB1S500MCB)........ 299.99

Microsoft Xbox One Wireless Controller
2015 Version

» Built-in Stereo Headset Jack

» Refined Bumpers

» Wireless Firmware
Updates

» 18 Wireless Range

» Xbox One/Windows 7, 8
and 10 Compatible

(MILWLCXBOBK)......cccoce

B A ]

THRUSTMASTER"® T\ Racing Wheel
Leather Edition

» Wheel, Base, and Pedal Set

» TM Leather 28 GT Wheel

» TX Racing Wheel Servo Base

» 3-Pedal T3PA Pedal Set

» Force Feedback Base

» Hall Effect AccuRate Technology

» Dual-Belt Mechanism » USB Connector » Central Clamping
System » Compatible with Xbox One and Windows

(THTXRWLEBLK) o 469,99

THRUSTMASTER® T3PA-PRO
Add-On Gaming Pedal Set

» Floor-Mounted Position (F1 Style)
» Suspended Position (GT Style)

» AUl-Metal Pedals

» Fully Adjustable Pedals

» Pedals with Individual Pressure Settings ¥
» Spring Brake Mod Included

» Supports T-Series Racing Wheels
» Compatible with PC, Xbox One, PS3, PS4
(THT3PAPRO)

NYKO Intercooler

for Xbox One

» Matches the Xbox Ong
» Allows Access to All Ports
» Pushes Hat Air Away from Console
» USB Powered (Turns on with Console)
» Microsoft Xbox One Compatible

(NYICXBOXONEB) 19.69

COMPUTERS

Microsoft Xhox Elite

Wireless Controller

» & Paddles and
Hair Trigger Locks

» 3 Different Sets of
Thumbsticks

» Faceted and Traditional
D-Pads

» 3.5mm Stereo Headset Jack » Xbox Elite Controller App

» Microsoft Xbox One Compatible » Windows Compatible

(MIEWLCXBIBK) ... Call or Log-On

Microsoft Xbox One Wireless Controller
With Play & Charge Kit

» Built-in Stereo Headset Jack

» Refined Bumpers

» Wireless Firmware Updates

» 18" Wireless Range

» Includes Charging Cable

» Rechargeable Battery
Pack Included

» Xbox One/Windows 7, 8, and 10 Compatible

[MILCPNCXBA) . 14,00

THRUSTMASTER® THSA
Add-On Shifter

» H-Pattern or Sequential Shift-Plates
» Hall Effect AccuRate Technology

» Metal Gear Stick and Construction

» 360° Adjustable Clamping System

» PC/PS3 /PS4 [ Xbox One Compatible

(THTHBAAOGBSH)

Razer Atrox Arcade Stick

Gaming Controller for Xbox One

» Premium Quality Sanwa Components
» 8 x Tournament-Grade

Sanwa Buttons
» 1x Precision 8-Way Joystick
» Internal Storage Compartments
» One-Touch Access to Internals & Storage
» 13" Detachable Screw-Lock USB Cable
» Additional Bat Top Included

(RAAASXBONE)

199.99

Razer Wildcat
Gaming Controller for Xbox One
» Wired Braided-Fiber Micro-USB Cable
» 2 x Shoulder Multi-Function Bumpers
» 2 x Removable Multi-Function Triggers
» 4 x ABXY Action Buttons

» Iero Slow-Turn Analog Joysticks
» 3.5mm Audio Port

» Optional Trigger Stops for Rapid-Fire
» Quick-Release Cable
(RAWCGCXBT) oo

i 169.99
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The Console Wars
By Alec Kubas-Meyer

The Console Wars are basically as old as video
games themselves. With each new generation, the
big companies throw their wares into the ring and
duke it out for consumers” affection, loyalty, and—
most crucially—money. Since Sega was knocked out
back in the sixth generation, we've been seeing three
companies vie for our attention: Nintendo, Sony, and
Microsoft. In 2017, though, we're in the midst of
something new: a half-generation. Nintendo’s Wii U,
which kicked off the eighth generation, has already
been replaced by its successor, the Switch. The Play-
Station 4 has gotten the sleeker, more attractive
form factor we've come to expect at this point in a
console’s life cycle, but it's now accompanied by the
PlayStation 4 Pro, a beefier system that plays all the same games but can do so at higher resolutions, with higher frame rates, and/
or with more detail. The Xbox One saw the more typical mid-cycle upgrade with the also-great Xbox One S, but Microsoft's “Project
Scorpio” is on the horizon, which purports to be more of a “Pro”-style upgrade.

This all has the unfortunate side effect of making the already complex decision of choosing the right system for your needs even
more confusing. But fortunately, you have in your hands a catalog that features an article containing the words you are reading
right now, and they can help you figure out what's best for you. (I have a word limit, and that digression made my editor furious—so
did this onel). [Not true. ~Editor]

ap

HINTENDO
SWITCH

The Switch

The Switch is the newest entrant, so let's
start there: Nintendo’s latest is a system
that works best for people who like playing
games with friends in a shared geographic
location. The system, which is basically a

portable tablet that can be hooked up in-
stantly to your TV when placed into a dock-
ing station, allows you to play your games
wherever you want, which is awesome. But
what makes it particularly compelling is
how heavily integrated local multiplayer is
to the whole experience: The Switch comes
with two “Joy-Con” controllers, shockingly
small controller-halves that can be used
together like a traditional controller or in-
dividually by separate players.

This means that you don't need to buy any
extra accessories to get in
on some multi-player action.
With the system’s built-in
kickstand, you can bring your
system anywhere, take off the
Joy-Con, hand one over, and
then play two-playerin games
like the adarable Snipperclips
or nostalgic Sonic Mania.
It may
not
be the

ideal way to play, but the fact that it's even vi-
able is something of a triumph. Other games,
like 7, 2, Switch—ostensibly the Wii Sports, or
perhaps Warioware, of this generation—use
the Joy-Con in unique ways and give you ex-
periences that you'll only ever get with Nin-
tendo. But it's not just that, of course: There
are also more traditional games, like the
excellent Legend of Zelda: Breath of the Wild,
though you'll want to pick up a Pro Control-
ler before you go and lose a few dozen hours
to that one. (The Pro Controller is awesome.)

PlayStation 4

For most of the generation,
the PlayStation 4 has been
my top recommendation

B:H 800-947-3308 + 212-444-6691



for someone who was only
going to get one console.
That's still kind of true—the

PlayStation 4 is a great console with argu-
ably the best overall library—but it's become
a more complicated recommendation. For
someone who has an old HDTV and no plans
to upgrade in the coming years, a PlaySta-
tion 4 will probably do you fine. If you've got a
4K HDR TV or an interest in VR (which, if you
don’t, you really should), then you'll want the
Pro (and a PlayStation VR headset). The im-
provements found on Pro-optimized games
are definitely worth it for those with newer
display tech. For the moment, it is objec-
tively the most powerful gaming console on
the market by a fairly sizable margin, and
games that take advantage of it look great.
A recent update allows even non-optimized
games to benefit from the extra power,
which further cements its value proposition.

Beyond all that, though, there’s a whole lot
to like. It has some excellent exclusives; the
DualShock 4 continues to be one of my fa-
vorite controllers
ever, and the Play-
Station Plus online
service is probably
the best deal in
gaming. The free
titles each month

L Playstation Plus

THE CONSOLE WARS [e{e] 410§ =23

may not always be the best of the best, but
they're not bottom-barrel either. Sony was
the first one to do it, and | still think they
do it best, though I'm glad that Microsoft
picked up on it. (Even Nintendo is now ex-
perimenting with something like it—in its
Nintendo way:.)

Xbox One

Speaking of Microsoft: the
Xbox One. Of all the consoles
this generation, this has
changed the most. What Mi-
crosoft originally announced
ended up being very differ-
ent than the console they
launched in 2013, and the
console they launched in
2013 is very different from
the one we have three and a half years
later. There has been a refocusing on Mi-
crosoft’'s part, pushing some of the enter-
tainment features that had originally been
so fundamental to the idea of the One to the
side and focusing more on games them-
selves. (The Xbox One S is the only console
to play UHD Blu-rays; a strange omission
from the PS4 Pro, considering that the
PlayStation 3's use of Blu-rays is one of the
reasons that format ultimately won its own
war)

The Xbox One Sis a very good upgrade to an
already very good machine. It added HDR
playback—something available on both
versions of the PS4—and generally slimmed

things down. While
h we wait for more
information on

Project Scorpio, | can understand some
trepidation about making the plunge,
but if you're embedded in the Xbox Live
ecosystem and love Halo, Gears of War, and
those other Microsoft exclusives, then you
really can’t go wrong with an Xbox One S.

So... What Do | Get?

As has been the case since back in 2006,
with the launch of the Wii, my best recom-
mendation is to get two consoles: one Nin-
tendo and one Something Else. If you prefer
the DualShock 4 to the Xbox One controller,
geta PS4. Ifall your friends are on Xbox Live,
then your decision has already been made. If
you really want to play Rez Infinite in VR, that
PlayStation 4 Pro is going to make you very
happy. But you don't need both. The Switch,
though, is just something different, a gaming
tablet/console hybrid that is great for groups
and on-the-go (and plays Mario games).

If you can only choose one, though? Well...
good luck, have fun!



COMPUTERS

g
@ Authorized Reseller iPad Pro
The iPad Pra from Apple now has an expansive Retina display, double the CPU power of the iPad Air 2,
improved Multi-Touch technology and access to over 850,000 apps. With up to 5.6 million pixels, the iPad
Pro makes it easier to work in professional environments including editing 4k video.

» Fingerprint Identity Sensor Built Into
The Home Button

» Apple A9X CPU with 64-Bit Architecture
» 2.bx Faster Than iPad Air

» 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.2
» Touch ID Fingerprint Reader

12.9”

» 2732 x 2048 Native Resolution
» Wi-Fi + Cellular & Wi-Fi Only Models available
» 25668, 125868 & 32Gb Configurations
STARTING AT (WI-FI ONLY)
STARTING AT (WI-FI+CELLULAR)....
*Available in space gray, silver and go

iPAD

» iSight Camera with 8MP photos

» Video Recording with Slo-Mo,

Stabilization & Time Lapse » i0S 8 and iCloud
» Front 1.2-Megapixel FaceTime HD Camera
» Rear b-Megapixel iSight Camera

» Lightning Connector, AirPlay Mirroring

9.7”

» 2048 x 1536 Native Resolution

» Wi-Fi + Cellular & Wi-Fi Only models available
» 25668, 12586B & 326b configurations
STARTING AT (WI-FI ONLY)

STARTING AT (WI-FI+CELLULAR)...........
*Available in space gray, silver and gold finishes

.’ Authorized Reseller Apple Smart Case

Apple Pencil (APPENCIL)

ACCESSORIES

’
' Authorized Reseller iPad mini &

The iPad mini 4 from Apple is just 6.Tmm thin and weighs less than

1 pound. Its smaller form factor makes it easier to hold in one hand.
This iPad mini 4 comes in a space gray, silver and gold finishes. The
tablet's 7.9" Retina Display features a native resolution of 2048 x 1536
at 326 ppi. The Retina Display’s capacitive touchscreen lets you utilize
all the multi-touch gestures of i0S 8.

» 7.9” IPS LCD Multi-Touch Retina Display
» 2048 x 1536 Native Resolution

» Touch ID Fingerprint Reader

» Apple A8 CPU with 64-bit architecture

» 1.3x faster than iPad mini 2

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2
»i0S 9 and iCloud

» iSight Camera with 8MP photos

» Video Recording now includes Slo-mo function
» 105 8 and iCloud

» Lightning Connector, AirPlay Mirroring

Wi-Fi + Cellular
STARTING AT ..o 529.00

Wi-Fi Only
STARTING AT oo 399.00

’
' Authorized Reseller iPad

Learn, create and surf with the iPad from Apple. The LED-backlit
9.7" 2048 x 1536 Retina IPS LCD display's anti-reflective
coating reduces glare by 56% and uses a single-layer
design to eliminate internal reflectance for richer
colors, greater contrast, and sharper images. The
iPad features Apple Touch ID technology, which
uses your fingerprint to unlock your device as
well as make secure purchases in iTunes,
iBooks, and the App Store. The 1.2MP front
and 8MP rear camera let you take high-
resolution phatos and videos as well as videochat

in HD while dual microphones reduce background noise. The iPad runs i0S 10, featuring Siri and iCloud.

» 9.7 IPS LCD Multi-Touch Retina Display

» 2048 x 1536 Native Resolution

» A9 chip with 64-bit architecture with M9 Chip
» 1.03 b and 7.5 mm thin

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2

» Touch ID Fingerprint Sensor

» Front 1.2-Megapixel FaceTime HD Camera
» Rear 8-Megapixel 1080p iSight Camera

» Lightning Connector, AirPlay, AirDrap

» Gyro, Accelerator, Ambient Light Sensor

Wi-Fi + 4G LTE
STARTING AT
*Available in space gray, silver and gold finishes

Wi-Fi Only
STARTING AT
*Available in space gray, silver and gold finishes

459.00 329.00

99.99 Q Apple Lightning to SD Card Camera Reader

iPad Air 2 -~ Apple Smart Keyboard (APIPPSKB) 169.00 > ForiPad Air, iPad 4th Gen & iPad mini
» Protects Al Sides of Your iPad Air 2 Apple Lightning Digital AV Adapter » View Photos From SD Card » Supports JPEG, RAW, H.264, MPEG-4
» Leather Exterior » Male Lightning Connector » Female HDMI Port APMLSDCR 29.00
» Color-Matched Microfiber Lining APMDBZ6AMA 44.95  Apple EarPods with Remote and Mic
» Folds into Typing or Viewing Stand ! Apple Lightning To USB Charge & Sync Cable » Enhanced Bass Response » Resistant to Sweat and Water Damage
» Open the Cover to Wake, Close to Sleep 3.3 (APLUSBC)...............17.00 6.5 (APMDSTIAMA) .. 29.00  APIPODEP 27.99
APSCIAZBL 79.00  Apple Lightning to USB Camera Adapter Apple Lightning to 30-pin Adapter

» For iPad with Retina Display or iPad Mini » Supports USB Audio
iPad mini APMLUCADP 2900  (APLSOP). ... 29.00 8" (APL3OPAD) ... 38.99
» Protects Back and Touchscreen » Thin, Minimal Design Apple Lightning to VGA Adapter Apple Lightning to Micro USB Adapter
» Leather Exterior » Soft Microfiber Lining » For iPhone, iPad and iPod » For iPhone/iPod/iPad With Lightning
» Enables Wake/Sleep » Folds into Typing/Viewing Stand » Mirror Device's Display on Bigger Screen » Connects to Micro USB Cable » Charge and Sync Device
APSCIPMBR 69.00  (APMLVADP) 41.99  APMD820AMA 17.50

B:H 800-947-3308 * 212-444-6691



@ LG 86BGPad7.0”
Wi-Fi Tablet (Black)

» 7.0" IPS Multi-Touch Display » HD 1280 x 800 Native Resolution
» 1.2 GHz Snapdragon Quad-Core CPU

» 16B of RAM & 8GB of Onboard Storage

» microSDHC Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.0
» 1.3 MP Front Camera + 3 MP Rear Camera

» (-Pair 2.0 Smartphone Sharing Technology

» 4000mAh Battery Capacity » Android Lollipop 5.0

(L6V4008)

/iU’ TenPad 8.0 Z380M

The dark gray ASUS ZenPad 8.0 Z380M 16GB Tablet offers powerful
performance in a sleek, fashion-inspired design.

» 1.3 GHz MediaTek MT8163 Quad-Core CPU

» 26B of RAM + 16GB Onboard Storage

» §" IPS 10-Point Touch Display » 1280 x 800 Screen
Resolution » Mali-450 GPU » 2MP Front + 5MP PixelMaster
Rear Camera » 802.11a/b/g/n Wi-Fi, Bluetooth 4.0

» Micro-USB, microSD Slot, AUX Jack » Front Speakers with
DTS HD Premium Sound » Android 6.0 Marshmallow

(ASZ380MA2GR)

&I 326B Galaxy Tab S3

9.7” Wi-Fi Tablet

» 9.7" Super AMOLED HDR Display

» (XGA (2048 x 1536) Native Resolution

» 2.15 GHz &1.6 GHz Dual-Core Processors

» 4GB of RAM & 32GB of Onboard Storage

» microSD Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.1
» 5MP Front Camera + 13MP Rear Camera

» Fingerprint Scanner, USB-C Port

» Includes S Pen » Android 7.0 Nougat

(SAGTS397BLK)

129.00

Call or Log-On

599.00

[SAGTS3975LV)

599.99

Galaxy Tab 52 9.7"

» 9.7" Super AMOLED Multi-Touch Display

» OXGA (2048 x 1536) Native Resolution

» (uad-Core 1.8 GHz and 1.2 GHz Processors

» 3G6B of RAM & 32GB of Onboard Storage

» microSD Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.1

» 2.1MP Front Camera + 8MP Rear Camera » Fingerprint Scanner
» 5870mAh Battery Capacity » Andraid 6.0 Marshmallow

(SAGTS297BLK)

499.00

7 Tab 3 Essential

8GB Tablet (Wi-Fi Only)

The midnight blue TAB 2 A10 can store up to 166B of data, and has

a microSD slot that supports microSDXC cards up to 64GB.

» 1.3 GHz ARM Cortex-Ab3 Quad-Core » 1GB of 1600 MHz DDR3 RAM
» 7" IPS Multi-Touch Display » 1024 x 600 Screen Resolution

» §GB of Internal Storage » Micro-USB 2.0 Port, microSD Slot

» 2MP Rear Camera + 0.3MP Front Camera

» 802.11b/g/n Wi-Fi, Bluetooth 4.0 » Android 5.0 Lollipop

(LEZADRO029US)

69.99

TABLETS [elely| -0k p=3¢]

¥~ 10.2” Pixel C 64GB Tablet

c (Wi-Fi Only, Silver)

» 1.9 GHz NVIDIA Tegra X1 Quad-Core

» 36B of RAM » 10.2" LTPS LCD Display

» 2560 x 1800 Screen Resolution

» 646B of Built-In Storage

» 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.1

» USB-C3.0 » 8MP Rear Camera + ZMP Front Camera
» Android 6.0 Marshmallow

64GB (GOPXLC64GB) 599.00
326B (60PXLC326B) 499.00

/iS50’ 326B 7580C-B1ZenPad S

8.0” Wi-Fi Tablet (Black)

» 8" 10-Point Multi-Touch IPS LCD Display

» 2K 2048 x 1536 Native Resolution

» Intel Atom 23530 Quad-Core Processor

» 268 of RAM & 3268 of Onboard Storage

» microSDXC Expansion up to 12868 » 802.11b/g/n Wi-Fi + Bluetooth 4.0
» b MP PixelMaster Rear Camera » ASUS TrueVivid Technology

» Up to 8 Hours of Battery Life » Android Lollipop 5.0”

(ASZP8S7560C) 194.00

Galaxy Tab A 7"

The black 7.0" Tab A 8GB Tablet from Samsung delivers powerful
performance and wireless content sharing in a sleek, modern design.

» 1.3 GHz Snapdragon 410 CPU » 1.56B of RAM

» 7.0" IPS Multi-Touch Display » 1280 x 800 Screen Resolution

» Adreno 306 GPU » 8GB of Internal Storage

» Micro-USB 2.0 Port, microSDXC Slot

» 5MP Rear Camera + 2MP Front Camera » 802.11b/g/n Wi-Fi, Bluetooth 4.0
» Android 5.1.1 Lollipop » Available in Black and White Black

[SAGTATBLK) 139.99

Galaxy Tab 52 8~

» 8" Super AMOLED Multi-Touch Display

» QXGA (2048 x 1536) Native Resolution

» Quad-Core 1.8 GHz and 1.2 GHz Processors

» 368 of RAM & 32GB of Onboard Storage

» microSD Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.1

» 2.1MP Front Camera + 8MP Rear Camera

» Fingerprint Scanner » 4000mAh Battery Capacity

» Android 6.0 Marshmallow > Available in Black, Gold and White

[SAGTS280BLK) 397.99

(®nabi 2 Android 7" Tablet

» 7" Capacitive Multi-Touch Display

» 1024 x 600 Native Resolution

» 1.3 GHz NVIDIA Tegra 3 Mobile Quad-Core

» Android 4.0 Ice Cream Sandwich 0S

» 168 of RAM, 8GB of Storage, 26B Cloud

» 802.11b/g/n Wi-Fi, Bluetooth 3.0+HS

» Expandable up to 326B via MicroSD Slot

» Mini-HOMI Port, Micro-USB 2.0 Port

» 2-Megapixel Front Camera » Red Drop-Safe Bumper

(NANABI2) 99.00

www.BandH.com BsH
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/iS5US 9.7" TenPad 35 10

64GB Tablet (Wi-Fi, Glacier Silver)

» 2.1 GHz MediaTek 8176 Turbo Six-Core
» 1468 of LPDDR3 RAM » 9.7" IPS Multi-Touch Display
» 12048 x 1536 Screen Resolution » IMG PowerVR
6X6250 Graphics » 164GB of eMMC Storage
» 802.11ac Wi-Fi & Bluetooth 4.2
» 1USB Type-C / microSD / 2-in-1 Audio Jack
» GPS / G-Sensor / Fingerprint Scanner » 1Android 6.0 Marshmallow

[ASZ500MC1GR)

(ASZ500MC1SL)

10.1" Galaxy Tab AT580

» 1.6 GHz Exynos 7870 Octa-Core Processor » 2GB of RAM

» 10.1” WUXGA Display » 1920 x 1220 Screen Resolution

» 166B of Memory » microSDXC Card Reader » 802.11 a/b/g/n/ac Wi-Fi
» 8MP Rear Camera + ZMP Front Camera » Android 6.0 Marshmallow

» Stream Content to Samsung Smart TV

» Available in Black and White

(SAGTAT0116A) 299.00 |

10.1” Galaxy Tab A P580
16GB Tablet with S Pen (Wi-Fi Only, Black)
» 1.6 GHz Exynos 7870 Octa-Core Processor » 3GB of RAM
» 10.1" WUXGA Display » 1920 x 1200 Screen Resolution
» 166B of Memory » microSD Card Reader
» 802.11 a/bfg/nfac Wi-Fi » 8MP Rear Camera + 2MP Front Camera
» Stream Content to Samsung Smart TV » Android 6.0 Marshmallow

(SASMP5BONZKA) 349.99

10.1” Galaxy Tab A T580
16GB Tablet (Wi-Fi Only, White)

» 11.6 GHz Exynos 7870 Octa-Core Processor » 26B of RAM \

» 10.1" WUXGA Display » 1920 x 1220 Screen Resolution

» 166B of Memory » microSDXC Card Reader

» 80211 afb/g/nfac Wi-Fi » 8MP Rear Camera + 2MP Front Camera
» Stream Content to Samsung Smart TV » Android 6.0 Marshmallow

(SAGTAT0116AW) 299.00

< CEr 1017 Iconia One 10
16GB Tablet (Wi-Fi, Black)

» 1.3 GHz MediaTek Cortex Ab3 Quad-Core » 1GB of DDR3L RAM

» 10.17 IPS TFT 10-Point Touch Display

» WXGA 1280 x 800 Screen Resolution » 16GB of Flash Storage

» 802.11a/b/g/n Wi-Fi & Bluetooth 4.0 » 2 x Micro-USB 2.0 Ports,
microSDXC Slot » Gyroscope Sensor & GPS Support

» Includes 1668 microSD Card » Android 6.0 (Marshmallow)

[ACB3A30KSP))

SONY DPTS1 Digital Paper System
» 13.3" Flexible Electronic Paper Display

» 1600 x 1200 Native Resolution » Multi-Touch Support

» 4GB Storage Capacity » microSD Media Card Slot

» Micro-USB Connector » 802.11b/g/n Wi-Fi

» Stylus Pen Included

(SoopTS1) 799.95

299.00
299.00

149.99

Microsoft Surface Pro 4

Microsoft combines the portability of a tablet and

the performance of a laptop with the 12.3" Surface Pro
4 Multi-Touch Tablet. Weighing just 1.73 pounds and
measuring just 0.33" thin, the Surface Pro 4 packs an
Intel 6th gen dual-core processor into a magnesium
casing with a silver finish. Use the multi-position \
Kickstand and the Surface Pro 4 Type Cover (sold separately)

to turn the Surface Pro 4 into a laptop. The included Surface

Pen provides up to 1024 levels of pressure sensitivity.

» Intel Core i7 6th Gen (Skylake) » 12.3" PixelSense 10-Point Touch Display

» 2736 x 1824 Screen Resolution (267 ppi) » 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.0, Mini DisplayPort, microSD Slot » Surface Pen Included » Windows 10 Pro

RAM Storage Graphics SKUS Price
1668 178 SSD Intel Iris Graphics MISP4I7161TB 2,599.00
1668 51268 SSD Intel Iris Graphics MISP4IT16512 2,099.00
1668 25668 SSD Intel Iris Graphics MISP4I716256 Call or Log-On
86B 25668 SSD Intel Iris Graphics MISP4178256 Call or Log-On
86B 25668 SSD Intel HD Graphics 520 MISP4I58256 1,199.00
4GB 12868 SSD Intel HD Graphics 520 MISP4I54128 849.00

Microsoft 13.5” Surface Book

The Surface Book Multi-Touch 2-in-1 Notebook is a
high-performance laptop/tablet hybrid with power and versatility.

It packs an Intel 6th gen (Skylake) dual-core processor into

a magnesium casing with a silver finish. Use the tactile keyboard and
touchpad to stay productive or detach the screen from
the dock and use the Surface Book as a tablet. The
included Surface Pen provides added precision

thanks to its 1024 levels of pressure sensitivity.

» 13.5” PixelSense Detachable Display
» 3000 x 2000 Screen Resolution (267 ppi) » USB 3.0, Mini DisplayPort, SD Card Slot
» 802.11ac Wi-Fi, Bluetooth 4.0 » Surface Pen Included » Windows 10 Pro

Processor RAM Storage Graphics SKU Price
2.4 GHz Intel Core i5-6300U 868 25668 SSD NVIDIA GPU MIMSBI58256N 1,899.00
2.4 GHz Intel Core 5-6300U 868 12868 53D Intel HD Graphics 520 MIMSBI58128 1,499.00
2.6 GHz Intel Core i7-6600 166B |  5126BSSD | NVIDIA GeForce GTX 965M MISB2I716512 2,799.00

Micresoft Surface Pen

for Surface Pro 4
» Bluetooth 4.0 LE Connectivity
» Aluminum Casing
» Palm Block Technology
|

Micresoft Surface Pro 4
Type Cover

» QWERTY Keyboard
for Surface Pro 4

» Compatible with
Surface Pro 3

» Improved Keyboard Design

» Improved Ultra-Thin Touchpad

» Full Row of Function Keys F1to F12

» Windows Shortcut Keys & Media Controls

» Backlit Keyboard for Low-Light Usage

(MIQCTO0001) e Call or Log-On

» 1,024 Levels of Pressure
Sensitivity » Instant Editing
and Formatting Tools

» 1-Click Access to OneNote and Cortana »
Works with Surface Pro 4 & Surface Book »
Works with Surface 3 & Surface Pro 3

(MI3XY00001) 45.99

Surface Dock
(MIPD900003) ............. 199.99

Power Supply for Surface ./
Pro3 /

(MI04000007)........... 60.00

Mini DisplayPort HOMI AV Adapter '/
(MIF5UD0020) 29 @~

Mini DisplayPort to VGA Adapter ‘
(MIF7UD0025) 29.95 '

USB 3.0 Ethernet Adapter '/
(MIFBUODD21)......o 29.00 J/

800-947-3308 - 212-444-6691




2-IN-1 NOTEBOOKS [e{e] 4210y 523

/1SS’ Aspire Switch Alpha 12

» 868 of LPDDR3 RAM » 12" IPS Multi-Touch Display
» (HD 2160 x 1440 Screen Resolution

» Integrated Intel HD Graphics 520 » microSDXC Slot
» Detachable Backlit Keyboard Included
» 802.11ac Wi-Fi & Bluetooth 4.0

» USB 3.0/ USB 3.1 Type-C

/i=>uU=" 10.1” Transformer Mini T102HA
Multi-Touch 2-in-1 Notebook

» 1.44 GHz Intel Atom xb-Z8350 Quad-Core

» 4GB DDR3 RAM | 12868 eMMC Flash Storage
» 10.17 1280 x 800 IPS Touchscreen Display

» Integrated Intel HD Graphics 400

» SD Media Card Reader

» Windows 10 Home (44-bit) » 802.11ac Wi-Fi | Bluetooth 4.0
2.5 GHz Intel Core i7-6500U Dual-Core, 51268 SSD (ACSAS27171NX) 929.00 » USB 2.0/ Micro-USB / Micro-HDMI
2.3 GHz Intel Core i5-6200U Dual-Core, 25668 SSD (ACIS6200U256) 70999 (ASTIOHADAGR). oo

12.5” ThinkPad Yoga 260

» 2.3 GHz Intel Core i5-6200U Dual-Core

» 868 of DDR4 RAM | 1926B SSD

» 12571366 x 768 HD IPS Touchscreen

» Integrated Intel HD Graphics 520

» Micro SD Card Reader » 802.11ac Wi-Fi & Bluetooth 4.1
» USB 3.0/ Mini-DisplayPort / HDMI

» 360° Hinge » ThinkPad Pen Pro Included

14" ThinkPad X1 Yoga

Rotate the screen up to 360° to vary between
laptop, tent, stand, and tablet mode, allowing you to
maximize your productivity.

» Intel HD Graphics 520

» §02.11ac Wi-Fi & Bluetooth 4.1

» 360° Hinge, Fingerprint Reader » Windows 10 Pro (64-bit)

» Windows 10 Pro (64-bit) 2.5 GHz Intel Core i7-6500U Dual-Core, 512GB SSD, 2560 x 1440 (LEXTY20FQ00Q) .........cc.cc.... 1,949.00
(EVBOFOOD) o 109900 23 B Intel Core T5-6200U Dual-Core, 25658 SSD, 1920 x 108D LEXIOFO0OR) ... 1,399.00
@ 11.6” Inspiron 11 3000 Series 14” Flex 4 Series
Multi-Touch 2-in-1 Notebook Multi-Touch 2-in-1 Notebook
» 1.6 GHz Intel Pentium N3710 Quad-Core Designed to adapt to your uses, the 15.6” Flex 4 can
» 4GB of 1600 MHz DDR3L RAM be adjusted to our different modes to better fit your needs.
» 11.6” LED Backlit Touch Display In'its standard laptop mode, it's ideal for typing, editing,
» 1366 x 768 HD Resolution and general work-related tasks.
» Integrated Intel HD Graphics 405 » 147 FHD 1920 x 1080 IPS Display
» 5006B 5400 rpm Hard Drive » Intel HD Graphics 620 » 4-in-1 Media Card Reader
» microSD Card Reader » 802.11b/g/n Wi-Fi & Bluetooth 4.0 » 802.11ac Wi-Fi & Bluetooth 4.0
» USB 3.0/ USB 2.0/ HOMI » Windows 10 Home (64-Bit) » USB3.0/USB2.0/HOMI » Gigabit Ethernet
» 360° Hinge, Fingerprint Reader » Windows 10

DEI316832726).....oooooooooocc e 369,
}DES]ZS?ZHS: 329 gg 2.5 GHz Intel Core i5-7200U Dual-Core, 8GB of DDR4 RAM + 256GB SSD (LEBOVDOOO7US).............. 709.00

S B 2.7 GHz Intel Core i7-7500U Dual-Core, 868 of DDR4 RAM + 1TB HDD (LEBOVD00OCUS) 799.99

@ 13.3" Inspiron 11 3000 Series
Multi-Touch 2-in-1 Notebook
» 1.6 GHz Intel Celeron N3060 Dual-Core

14” Flex 5 1470 Series
14.0” Multimode Notebook

» 26B of 1600 MHz DDR3L RAM » 2.5 GHz Intel Core i5-7200U Dual-Core

» 11.6” LED Backlit Touch Display » 86B of DDR4 RAM + 256 SSD

» 1366 x 768 HD Resolution » 14" FHD 1920 x 1080 IPS Display

» 3268 of eMMC Storage » microSD Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0

» Integrated Intel HD Graphics 405 » Windows 10 Home (64-Bit) » USB 3.0/ USB 2.0/ HOMI

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » USB 3.0/ USB 2.0/ HOMI » 4-in-1 Card Reader » Windows 10

(DEI31680027R).....ooo oo . 269.99 (LEBOXADDOD) ...
@ 15.6” Inspiron 15 5000 Series SONY 13.3"Iflip

Multi-Touch 2-in-1 Notebook
» 2.5 GHz Intel Core i7-6500U Dual-Core
» 1668 of DDR4 RAM
» 15.6” TrueLife Multi-Touch Display
» Full HD 1920 x 1080 Screen Resolution » 2560 x 1400 Screen Resolution
» Integrated Intel HD Graphics 520 e — » Integrated Intel Iris Graphics 550
» 2566B SATA 2.5" SSD » 51268 PCle Solid-State Drive » SD Media Card Slot » 802.11ac Wi-Fi, Bluetooth 4.1

Multi-Touch 2-in-1 Notebook
» 3.3 GHz Intel Core i7-6567U Dual-Core

» 166B of 1866 MHz LPDDR3 RAM

» 13.3" WQHD Multi-Touch Display

» SD/SDHC/SDXC & MS/MS PRO Card Reader » 802.11ac Wi-Fi & Bluetooth 4.2 » Digitizer Stylus Included » Windows 10 Pro (64-bit)e
» 360° Hinge » Windows 10 Home (64-Bit) (VAZIZBXOTT B . 2,379.00
(DEIBIBBOBTAT) oo OBTL99) (VAZT3BXO2VTB) o 1,979.00

www.BandH.com BSH
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15.6” Ideapad 310 Series Notebook % 14" ProBook 640 G2
» 1.1 GHz Intel Core mb-6Y57 Dual-Core » 2.3 GHz Intel Core i5-6200U Dual-Core

» 4GB of 2133 MHz DDR4 RAM

» 14" SVA Anti-Glare Flat Display

» HD 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics 520

» 5006B 7200 rpm SATA Hard Drive

» SuperMulti DVD Burner & SD Card Reader
» 802.11a/b/g/n Wi-Fi & Bluetooth 4.2

» USB 3.0 Type-A & Type-C » Windows 7 Pra + Windows 10 Pro License

» 8B of 1866 MHz LPDDR3 RAM

» 12.5” Anti-Glare LED Backlit Display

» 1920 x 1080 Full HD Resolution

» Integrated Intel HD Graphics 515

» 25668 M.2 SATA MLC SSD

» 802.17ac Wi-Fi / Bluetooth 4.2

» 2 x USB Type-C / Audio In-Out Combo Port
» Windows 10 Pro (64-bit)

(LEIDEAPADIO) 499.99  ESOGIVIPT) 761.29
/ISUS 13.3” ZenBook UX310UA SCEr 15.6” Aspire E5-575-521W
Notebook (Rose Gold)

The 15.6” Aspire Eb-575-521W Notebook from Acer is
ideal for your everyday home and office tasks.

» 2.3 GHz Intel Core i5-6200U Dual-Core

» 868 of DDR4 RAM » 15.6” ComfyView Display

» FHD 1920 x 1080 Screen Resolution

» Integrated Intel HD Graphics 520

» 2.5 GHz Intel Core i7-6500U Dual-Core
» 86B of DDR4 RAM » 256GB M.2 SSD
» 13.37(1920 x 1080) Anti-Glare Display
» Integrated Intel HD 520 Graphics
» Multi-Format Media Card Reader

» 802.11ac Dual-Band Wi-Fi + Bluetooth 4.1 » 25668 SSD » SD Card Reader & Backlit Keyboard
» USB Type-C /USB 3.0/ USB 2.0/ HOMI » Windows 10 » 802.11ac Wi-Fi & Bluetooth 4.1

[ASUXSTOUAWBT....... 809.93 » USB 3.1 Type-C/ USB 3.0/ USB 2.0/ HDMI » Windows 10 Home
(ACEBBTEE2IW).. 529.00

/IS0 15.6” Inspiron 15 7000 Series

» 1.6 GHz Intel Pentium N3700 Quad-Core
» 4GB of DDR3 RAM

» 14" Full HD Display

» 1920 x 1080 Screen Resolution

» Integrated Intel HD Graphics

» 1286B eMMC Solid State Drive

» SD Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.0

» HOMI, USB 3.0 Type-C, USB 3.0 Type-A
» Windows 10 Home

[ASEA035AUS?1) 399.00

15.6” ThinkPad E560 Notebook
» 2.3 GHz Intel Core ib-6200U Dual-Core

» 468 of DDR3L RAM | 50068 7200 rpm HDD

» 15.6" 1366 x 768 Display

» Integrated Intel HD Graphics 520

» SuperMulti DVD Drive | Media Card Reader

» 802.11ac Wi-Fi | Bluetooth 4.0

» USB 3.0 VGA | HDMI

» Windows 7 Pro + Windows 10 License

[LEEBBO20EVZF) ..o J—1 LA ]

/=SS 15.6” ZenBook Pro
Multi-Touch Notebook

» 2.6 GHz Intel Core i7-6700HQ Skylake
» 166B of DDR4 RAM

14" ThinkPad E460 Notebook

» 2.3 GHz Intel Core i5-6200U Dual-Core
» 4GB of DDR3L RAM | 500GB HDD

» 1471366 x 768 Display

» 16.6” IPS Multi-Touch Display » Integrated Intel HD Graphics 520

» UHD 4K 3840 x 2160 Native Resolution 5 3 » 4-in-1 Card Reader

» NVIDIA GeForce GTX 960M (26B) » 5126B PCl-Based SSD ) » 802.11ac Wi-Fi | Bluetooth 4.2

» SDXC Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0 . » USB 3.0 [ HOMI ‘ .
» Thunderbolt 3, USB 3.0, and HDMI Ports » Windows 10 (64-bit) » Windows 7 Pro + Windows 10 Pro License
(ASUXBOTVDST) ... . 1,372.99 (LEE46020ETO0) 619.99
17.3” Inspiron 17 5000 Series 7) 15.6” ProBook 450 G3 Notebook
» 1.6 GHz Intel Celeron N3060 Dual-Core

Notebook

» 2.5 GHz Intel Core i5-7200U Dual Core
» §6B DDR4 RAM | 178 5400 rpm HDD
» 17.37 1600 x 900 Anti-Glare Display

» Integrated Intel HD Graphics 620

» SuperMulti DVD Drive | Media Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0
» 802.11ac Wi-Fi | Bluetooth 4.2 - : » USB 3.0/ USB 2.0/ HOMI

» USB 3.0 | USB 2.0 | HDMI » Windows 10 Home (64-Bit) » Windows 10 Home (64-bit)

[DEIBTB700TBB)......ceee oo 549.00 [HETAAXDTONR) ..o . 219.99

n B:H 800-947-3308 * 212-444-6691

» 4GB of 1600 MHz DDR3L RAM » 14” SVA Display
» 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics 400

» 326B eMMC Storage

» Multi-Format SD Media Card Reader
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/ISUS' 1257 C302CA-DHM4 646B Chromebook Flip 11.6” N22 Series 166B Chromebook

» 900 MHz Intel Core m3-6Y30 Dual-Core 7 » 1.6 GHz Intel Celeron N3060 Dual-Core
» 4GB of LPDDR3 RAM | 64GB eMMC Storage » 4GB of DOR3 RAM | 166B eMMC Storage
» 12571920 x 1080 Glossy Display » 11.6" 1366 x 768 LCD Display

» Integrated Intel HD Graphics 515 » Integrated Intel HD Graphics

» microSD Media Card Reader » Media Card Reader

» 802.11ac Dual-Band Wi-Fi | Bluetooth 4.2 » 802.11ac Wi-Fi | Bluetooth 4.1

» USB 3.0 Type-C | Webcam » USB 3.0 USB 2.0 | HOMI

» Chrome 0S » Chrome 0S
(ASC302CADHM4) 499.00 (LE2280SFO01F) 170.00
/iSUS 101" Chromebook Fp <P 11.3" 326B Mutti-Touch 2-in-1 Chromebook Plus

Designed for a Web-optimized experience, the ASUS
Chromebook Flip 10.1" Multi-Touch Convertible Chromebook
provides a user-friendly interface enhanced by the Internet.

» Rockchip 3288-C SoC

» 1.8 GHz ARM Cortex-A17 Quad-Core

» 4GB of Onboard LPDDR3 RAM

» 166B eMMC Storage » Integrated ARM
Mali-T764 Graphics » 10.1" Multi-Touch Display

» 1280 x 800 Native Resolution =y : =

» §02.11ac Wi-Fi, Blustooth 4.0 =4 N

» 360° Hinge » Chrome 0S

(ASC100PADBO?) 25900 Gr¥® Chromebook 3

» 1.6 GHz Intel Celeron N3060 Dual-Core
» 4GB of LPDDR3 RAM

» 11.6" Anti-Glare Display

» HD 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics

» 166B eMMC Flash Storage

» Micro SD Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.0

» USB3.0/USB 2.0/ HOMI » Chrome 0S

» 2.0 GHz OP1 Hexa-Core Processor

» 4GB of LPDDR3 RAM | 326B eMMC Storage
» 12.3" 2400 x 1600 Touchscreen

» Integrated Graphics

» 802.11ac Wi-Fi | Bluetooth 4.1

» MicroSD Media Card Reader

» USB Type-C

» Chrome 0S

(SAXES13C24K1) 444.99

< CEr 14" 326B Chromebook 14

» 1.6 GHz Intel Celeron N3160 Quad-Core
» 4GB LPDDR3 RAM + 32GB eMMC Storage
» 1471920 x 1080 Anti-Glare IPS Display
» Integrated Intel HD Graphics 400

» 802.11a/b/g/n/ac Wi-Fi & Bluetooth 4.2
» 2% USB 3.0 Type-A/ 1 x HOMI

» Chrome 0S

(SAXES00CT3K4) 179.00
(ACCB3431C5XK) 299.00
FSUS’ 11.6” C2025A Series aCEr B3R

64GB Multi-Touch Chromebook

» 2.1 GHz MediaTek M8173C Quad-Core
» 4GB of LPDDR3 RAM

16GB Chromebook (Dark Blue/Silver)
» 1.6 GHz Intel Celeron N3060 Dual-Core

» 46B of 1066 MHz DDR3L RAM
P . » 3.3" IPS TFT Multi-Touch Display
» 11.6" Anti-Glare Display )
; » Full HD 1920 x 1080 Screen Resolution

» 1366 x 768 HD Resolution )

) » Integrated PowerVR GX6250 Graphics
» Integrated Intel HD Graphics 400 > 64B of Flash Storace
» 1468 of eMMC Storage ¢

» MicroSD Card Reader

» S0 Media Card Reader » 802.11ac Wi-Fi & Bluetooth 4.2 802,112 Wi-Fi & Bluetooth » 360° Hinge

» USB 3.0/ HDMI / Combo Audio Jack » Chrome 0S

(ASC202Y5020B) 199.00 (ACCB5312TK4D) 449.00
% 11.6” 166B Chromebook 11 G5 <Cer 11.6” CB3-131-C3sz
» 1.6 GHz Intel Celeron N3050 Dual-Core : 16GB Chromebook
» 166B eMMC SSD » 2.16 GHz Intel Celeron N2840 Dual-Core

» 11.6” SVA Anti-Glare Display

» 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics » microSD Card Reader
» 802.11ac Dual-Band Wi-Fi & Bluetooth 4.2 » 166B SSD » SD Card Reader

» USB 3.0/ HDMI / Audio In/Out » Chrome 0S » 802.11ac Wi-Fi & Bluetooth 4.0

26B RAM (HECB1165X902) 183.49 » USB3.0/USB 2.0/HDMI » Chrome 0S

4GB RAM (HECB1165X901) 172.00 (ACCB3131C352) 179.00

www.BandH.com BSH

» 26B of DOR3LRAM » 11.6” IPS Display
» 1366 x 768 Screen Resolution
» Integrated Intel HD Graphics




COMPUTERS

GAMING

inside”

ISi 17.3" GT73VR Titan Pro

Packed with high-end hardware, designed for gamers and enthusiasts
seeking to experience computing with virtual reality games & applications.
» 2.9 GHz Intel Core i7-7820HK Quad-Core

» 1668 of DDR4 RAM | 25668 SSD + 178 HDD

» 17.371920 x 1080 120Hz Display

» NVIDIA GeForce GTX 1070 (86B GDDR5)

» SDXC Media Card Reader » 802.11ac Wi-Fi | Bluetooth 4.1
» USB 3.0 | HDMI | Mini DP | Thunderbolt 3 » Windows 10 Home (64-Bit)

(MSGT737426)

2,199.00

I72S7 15.6” GL62 Notehook
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 8GB of DOR4 RAM » 1TB 7200 rpm HDD

» 15.6"1920 x 1080 eDP Display

» NVIDIA GeForce GTX 960M (268 GDDRS)

» SDXC Media Card Reader » 802.11ac Wi-Fi » Bluetooth 4.0
» USB 3.0 » USB Type-C » HDMI » MiniDP » Windows 10 Home (64-Bit)

(MSGL62M056)

929.00

15.6” Gaming Notebook Y520

» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 86B DDR4 RAM, 12868 SSD + 1TB HDD

» 15671920 x 1080 IPS Display

» NVIDIA GeForce GTX 1050Ti 4GB GDDRD

» Multi-Format Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.0/USB 2.0/ HDMI » Windows 10 (64-bit)

(LEBOWKOOFC),

1,099.99

/1i=U=" Republic of Gamers 6G20CB

A compact Windows 10 system that sports full-tower performance.
For visuals, the dedicated graphics card sports 86B of GBDRbX
video memory and Pascal architecture so you can enable additional
graphical settings and experience VR environments.

» 3.4 GHz Intel Core i7-6700 Quad-Core

» 166B of DDR4 RAM » SuperMulti DVD Burner

» 10/100/1000 Mbps Gigabit Ethernet

» 802.11ac Wi-Fi, Bluetooth 4.0Windows 10 Home (64-bit)

Storage Graphics SKU Price
118 NVIDIA GeForce 6TX 1070 GPU (868) ASG20CBDB70 1,399.00
178 HHD + 51268 SSD \ NVIDIA GeForce 6TX 1080 GPU (86B) \ ASG20CBDHT3 \ 1,899.00

(@) CYBERPOWERPC Gamer Ultra Desktop Computer

» 3.8 GHz AMD FX-4300 Quad-Core » 8GB of DDR3 RAM

» 178 7200 rpm SATA I HDD » AMD Radeon R7 240 (268)

» VIGA | DVI | HOMI » SuperMulti DVD Drive

» 10/100/1000 Mbps Gigabit Ethernet

» CyberPowerPC 2605 Mid-Tower Case (White)

» USB Gaming Keyboard & Mouse Included » Windows 10 Home (64-Bit)

(CYGUA4600BH)

499.00

/iSUS 15.6” Republic of Gamers Strix GL502VM

With the advancements in mobile graphics, the 15.6” Republic
of Gamers Strix GLb02VM Notebook demonstrates a combination
of performance & portability.

» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 1668 DDR4 RAM | 1286B SSD + 178 HDD

» 15.6” 1920 x 1080 G-Sync Display

» NVIDIA GeForce GTX 1060 (6GB GDDR5)

» SD Media Card Reader » Windows 10 Home (64-Bit)
» 802.11ac Wi-Fi | Bluetooth 4.0 » USB 3.0 | HDMI | Mini DP | Thunderbolt 3

[ASGL502VDS74)

1,499.00

/iSUS 17.3” Republic of Gamers 6753VD Series

» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 1668 DOR4 RAM » 17.3"1920 x 1080 Anti-Glare Display

» NVIDIA GeForce GTX 1050 (4GB GDDRS)

» SuperMulti DVD Drive » Media Card Reader

» 802.11ac Dual-Band Wi-Fi | Bluetooth 4.1

» USB 3.0 | USB Type-C | HOMI | Mini DP » Windows 10 Home (64-Bit)

1TB 7200 rpm HDD (ASGL753VDDS7) ..
25668 SSD + 1TB HDD (ASBL7E3VEDST) ... 1,272.99

@ 15.6” Alienware 15 R3 Notebook

» 2.6 GHz Intel Core i7-6700HQ Quad-Core
» 166B DDR4 RAM | 128GB M.2 SSD + 1TB HDD
» 15.6"1920 x 1080 IPS Display
» NVIDIA GeForce GTX 1060 (66B GDDRS)
» 802.11ac Wi-Fi | Bluetooth 4.1
» Gigabit Ethernet Port » 2 x USB 3.0 Type-A | 1 x USB 3.0 Type-C
» Thunderbolt 3 | HDMI 2.0 | Mini DP 1.2 » Windows 10 Home (64-bit)

(DEAWSR338315)

1,499.00

(@)CYBERPOWERPC Gamer Supreme
Liquid Cool Desktop Computer

» 3268 of DDR4 RAM » NVIDIA GeForce GTX 1080 (8GB GDDR5X)
» DVI| HOMI | DisplayPort » Gigabit Ethernet | 802.11ac Wi-Fi
» NZXT $340 Mid-Tower Case (White)

» USB Gaming Keyboard & Mouse Included
» Windows 10 Home (64-Bit)

Processor
4.2 6Hz Intel Core i7-7700K Quad-Core

Storage SKU
51268 SSD + 378 HOD CYSLCB480BH

I72S7  Aegis X3 Gaming Desktop Computer
» 4.2 GHz Intel Core i7-7700K Quad-Core

» 3268 of 2400 MHz DDR4 RAM

» 25668 SSD + 2TB 7200 rpm HOD

» MSI GeForce GTX 1080 Gaming X 86B GPU

» SuperMulti DVD Burner » 802.11ac Wi-Fi | Bluetooth 4.1

» HDMI| USB 3.1 Type-C » VR Link with One Click to VR

» Water Cooling Thermal Kit » Windows 10 Home

Processor Memory Storage
4.2 GHz Intel Core i7-7700K Quad-Core 3268 12518

Graphics SKU Price
MSI GeForce GTX 1080 Gaming X 868 GPU_| MSAVRO02 | 1,999.99

800-947-3308 - 212-444-6691




MOBILE WORKSTATIONS

COMPUTERS

( lntel inside”

Dell XPS 13 9360
Multi-Touch Notebook

S

The XPS 13 9360 Multi-Touch Notebook is a thin, light, and durable notebook designed for users looking
for a portable system that's capable of keeping up with them. Powered by a 2.7 GHz Intel Core i7-7500U
Dual-Core processor, 16GB of 2133 MHz LPDDR3 RAM, and integrated Intel HD graphics, the XPS 13 can
efficiently multitask and quickly access frequently used files and programs.

» SD Media Card Reader » 802.11ac Wi-Fi | Bluetooth 4.1
» USB 3.0 | Thunderbolt 3 » Windows 10 Home (64-Bit)

CPU RAM Storage SKU PRICE
2.7 GHz Intel Core i7-7500U 1668 LPDDR3 51268 SSD DEX93607336 | 1,799.00
2.7 GHz Intel Core i7-7500U 8GB LPDDR3 2566B SSD DEX93604841 1,599.00
2.5 GHz Intel Core i5-7200U 8GB LPDDR3 25668 SSD DEX93603691 1,399.00

(K=1aTeVR 15.6” ThinkPad P50
» 166B of 2133 MHz DDR4 RAM » 15.6” IPS Display with X-Rite Color
» UHD 4K 3840 x 2160 Screen Resolution » 256GB SATA SSD Opal 2
» SDXC & MMC Reader, ExpressCard 34 Slot » 802.11ac Wi-Fi & Bluetoath 4.1

CPU Storage Graphics SKU PRICE
2.7 GHz Intel Core i7-Quad-Core | 25668 SSD |  NVIDIA Quadro M2000M (4GB) - 3840 x 2160 | LEPS020ENTEU | 2,112.08
2.8 GHz Intel Xeon E3-Quad-Core | 25668 SSD | NVIDIA Quadro M1000M (26B) M2000M (4GB) | LEP5020ENTSU | 1,949.00
2.6 GHz Intel Core i7-v5 Quad-Core| 50068 NVIDIA Quadro M1000M (26B) - 1920 x 1080 | LEP5020EN00T | 1,379.00

15.6” ThinkPad P50s

Constructed from glass-fiber reinforced plastic, blends the form factor of
an Ultrabook with the processing power of a mobile workstation.

» 2.5 GHz Intel Core i7-6500U Dual-Core

» NVIDIA Quadro M500M Graphics Card (26B)

» 15.6" IPS Display » USB 3.0 / mini-DisplayPort / VGA

Storage Memory SKU PRICE
51268 5D 1668 LEP50S20FLOM 1,565.00
50068 7.2k | 868 | LEPSOS2OFLOK | 1,149.00

17.3" ThinkPad P70

» 2.6 GHz Intel Core i7-6700HQ Quad-Core » 16GB of DDR4 RAM
» 17.3" Full HD IPS Display » 1920 x 1080 Screen Resolution

» NVIDIA Quadro M60OM GPU (26B) » 500B Hard Drive

» SuperMulti DVD Burner

(LEP7020ER002)

1,599.00

www.BandH.com

@ Dell XPS 159550
Multi-Touch Notebook

The XPS 15 9550 Multi-Touch Notebook from Dell features a 15.6” InfinityEdge display with a 3840 x
2160 4K resolution and 5.7 mm thin bezels for your viewing pleasure. It's also a touchscreen so you'll be
able to utilize touch gestures and commands in Windows 10 to further improve its accessibility and your
productivity. Driven by a dedicated NVIDIA GeForce GTX 960M graphics card with 26B GDDR5 VRAM, the
XPS 15 is capable of handling multimedia playback and even games. Connect external displays using its
HDMI and Thunderbolt 3 port for additional multitasking capabilities.

» SD Media Card Reader » 802.11ac Dual-Band Wi-Fi | Bluetooth 4.1
» USB 3.0 | HDMI | Thunderbolt 3 » Windows 10 Home (64-Bit)

CPU RAM Storage SKU PRICE
2.6 GHz Intel Core i7-6700HQ 3268 DDR4 1TB PCle SSD DEXPS9550133 | 2,299.99
2.6 GHz Intel Core i7-6700HQ 166B DDR4 17B PCle SSD DEXPS9550100 | 2,199.00
2.3 GHz Intel Core ib-6300HQ 8GB DDR4 25668 PCle SSD DEXPS16I5266 | 1,699.00

7 17.3” 1Book 17 63
Mobile Workstation
» Designed for the Creative Professional » 2.6 GHz Intel
Core i7-6700HQ Quad-Core » 16GB of 2133 MHz DDR4 RAM
» 17.3" UWVA IPS Anti-Glare Display
» FullHD 1920 x 1080 Screen Resolution

(HEZB1763X1X6)

) 15.6” ZBook 15u G4
Mobile Workstation

» Designed for the Creative Professional

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 1668 of DDR4 RAM | 51268 PCle SSD

» 15.6" 1920 x 1080 UWVA IPS Display

» AMD FirePro W4190M Graphics Card (26B)
» SDXC UHS-II Card Reader » USB 3.0 | DisplayPort 1.2 | VGA

(HEZB15G41B34)

1,689.00

I72S7 15.6" IBook 15u G4

Mobile Workstation

» 2.8 GHz Intel Core i7-7700HQ Quad-Core » 326B of DDR4 RAM +
51268 PCle SSD » 15.6” 1920 x 1080 eDP IPS Display

» NVIDIA Quadro P3000 Graphics Card (6GB)

» SDXC Card Reader » Thunderbolt 3 + DP1.2 via USB 3.1 Type-C

(MSWS637RK290)

2,599.00




COMPUTERS

TABLET & LAPTOP CASES

TABLET COVERS

fmde B

B

Brand Griffin Technology Gumdrop Incipio Kensington LifeProof Otter Box Otter Box Pelican UAG Urban Armor
Case Survivor All-Terrain| Hideaway Case Ca;:!t::;; éldltra BlackBelt niiiid Case Defender Defender Voyager Case Composite Case Rugged Case
Material Pols)(icl?c%)r?g?tgnjgetl Silicone Rubber Polycarbonate Polycarbonate Suwhan:eer[gzgfg;”lﬁ% SKﬂEhbeJ:C S{r&thhbeetic Silicone Polycarbonate Hard Shell
Screen Protector Yes Yes No No Yes Yes Yes No No No
. Black,Blue Black, Orange, Glacier, Crushed Glacier, Black,
Colors Available Pink Vellow Blue, White, Red Black Black Black, Avalanche Damson. Black Black Pink Ice Black Grey
SKU GRGBA41870 GUHASGTS297B INMRSF080BLK KEK97462WW LINCIPAZBK 0TDSCIPA26LC OTDCGTABNSBK PECT1030BKGY UASFBKICE UASBPBLIC
Price 57.47 69.95 Call or Log-On 59.99 116.99 80.95 62.96 74.12 79.95 79.95
’ iPad, iPad Air 2, |iPad Air 2, Galaxy Note| . Microsoft Do D iPad, iPad Air |iPad Pro, iPad, iPad Air iPad Air 2, Microsoft Microsoft
Available for iPad Pro Pro, Galaxy Tab Pro Microsoft Surface 3 Surface Pro iPad, iPad AirZ &iPad mini's & iPad mini's iPad mini Surface Book Surface Book

TABLET PORTFOLIOS

mmmmmmmmm“
: VersaVu Bluetooth . . p

Case TriCover Tablet K1 Cover Premium 360° Hardback Case ProGear Vault Galaxy Tab S2 Keyboard Cover StyleFolio Folio Case iPad Pro Case

Material Polyurethane Polyurethane Polycarbonate Stainless Steel W vﬁgtserptt?]ﬁt‘cseal Polyurethane Polyurethane Faux Leather Synthetic Leather Pt%lr])/ﬁarrl?gg;te

Closure Folding Folding Elastic band Snap Latches Latch Folding Folding Locking Clasp Magnetic Folding

. Black, Blue, Red, | Black, Blue, Brown, Red,
. Black, Gold, White, "no oo’ | Green, Magenta, Orange, Black,
Colors Available Black Black Black, Brown Black Black, Grey Black Green, Grey, Pink, 3
Blue, Red Floral Pink, Rattleskin Pmk.Fuélka:glu; Black Blue, Red

SKU ASTCZPS8BLK NVSTK1C TAWRCIPBLK PE1065C PEPVIPA26 SABCGTS297B SAKBCGTS2B SPSCIM123BS6 RORGTSB4DVNV UAIPP97BK

Price 17.99 39.99 69.99 38.22 92.66 49.00 104.45 21.50 39.95 49.95
Mvailablefor | AsusZenPad$8.0 | NVIDIA Shield iPad Pro 710" Teblets ol GalaTab97 | GalaxyTab 9.7 d;’gﬂ(ﬁai aumin - ipag pr 2 iPad Pro 9.7"

SLEEVES

. Sling Sleeve ICON Sleeve Herringbone Uttra Thin Waterpoof Textured Neoprene
s plSSeries Deluxe with Tensaerlite Spiz Sleeve Sleeve Aramon NXT Gauntet Pouch Sleeve
Material Neoprene Weathmﬁsistant Tt%earesrl?tfe Neoprene Wﬁgﬂﬁgz'nsntgm Neoprene Neoprene Polyurethane Waterproof Neoprene
Interior Neoprene Plush, faux fur Faux-Fur Padded Padded Double Seamed Neoprene Foam Waterproof Padded
Closure Tipper Zipper Magnetic Snap Zipper Tipper Zipper Tipper Zipper Double Enclosure Tipper
Colors Available Black Black Heaté‘leafcﬁffﬁg{a?e‘“k' Black Brown Black Black Black Transparent Black Pink
SKU CAPLS15B INCL60264 INCL60847 KESP12 RUHLTS13 RULPS13B SAG33211041 TH3203096 XUIPMWPC XUSN112B
Price 16.56 38.62 49.95 14.99 19.99 12.99 16.94 39.95 6.49 4.95
. 16-17" " 13" MacBook " 8-15" 10-15" " - iPad & .
Available for Tablets & Laptops 13" MacBooks Pro Retina 12" Tablets Tablets & Laptops | Tablets & Laptops 15.6" Laptops 10" Tablets iPad mini 10" Tablets

B:H 800-947-3308 * 212-444-6691



COMPUTE

TABLET & LAPTOP CASES

BACKPACKS

Laptop Red Series Ruby
Case Backpack Jaunt Backpack City Backpack ICON Pack Urban Ellte 33 Tech Backpack Xenon 2 ibex TXL617 XL
Material Nylon Polyester Blended Nylon Denier Kodra 900D Polyester Ballistic Polyester Nylon Nylon
y y Weave Polyester y Nylon 4 y y y
Interior Nylon Padded Fleece Padded Plush Lined Hard shell case 150D Polyester Padded Airflow Padding Padded
Closure Zipper Zipper Zipper Zipper Zipper Zipper Zipper Zipper Zipper
Colors Available Black Black, Blue Black, White, Grey Black, White, Red Black Black with Red Black Blue Black
SKU CAVNB217 CAWMBP115AN INCL55452 INCL55532 PEU100BPB RUCBB3B SAX2BP SWA731606F00 TATXL617
Price 22.99 39.95 66.49 199.95 172.95 109.95 69.99 89.99 56.87

MESSENGER / SLING BAGS

Epacslilasliew

Case Saturn M esslgr':;';g Bag Messenger Case | (Quick Sling Bag M eszgz:::'n ag gﬂ:&";gg Xenon 2 Messenger Messenger M esgé:sgs;f Bag
Material Polyester Nylon Polyester Canvas Canvas Nylon Ballistic Nylon Polyester Fabric w/Polyurethane Nylon
Interior Padded Brushed Poly lining Padded Padded Padded Padded Cotton Brushed Poly Lining Padded Nylon Polyurethane
Closure W zsi;ggrghosgéiets Neoprene Tipper Zipper Snap Clips Zipper Tipper Buckle and strap Tipper Zipper

Colors Available Black Black Black, Grey Black, Grey Navy, Olive Black Black Black Black, Blue, Green Black

SKuU SWAT748814F00 CAVNM217 HEH1D25AA INCL60487 MOMECME9 RUSB11B SAX2MB TATCMO04US THM2B13MGR TIECCMBMBLK

Price 73.41 34.99 29.00 61.13 31.32 15.99 59.99 17.95 45.00 179.00

BRIEFCASE & SHOULDER BAGS

T Y11 Y AS X ¥V

; Laptop Checkpoint _ Classic Topload Columbian ;

Case My 2nd Brain Attache Friendly Case SP30 DL-MBPR 1070cc Case Xenon 2 Leather Case Mainframe
Material Nylon Nylon Nylon Polyester Hard Shell Vt\]laarlg r;t;gsZt Polyester Ballistic nylon Leather Polyester
Interior Paed Patied Foam Paing Patied Molded EVA olded n Patided Patided Patide Padded Tricot
Closure Tipper Zipper Zipper Tipper Tipper Easy Open Latch Tipper Zipper Buckles Tipper

Colors Available | Black, Blue, Green Black Black Black Black Black Black Black Brown Black

SKU THM2BBC13HBL CAVNAZ16 GAGAVLTOF KESP30 0YDLMBPC13 PE1070CC TATLCNB16 SAX2SB156 SA45798 SWM156CBG

Price 39.95 21.99 109.99 24.59 20.99 59.90 29.99 22.99 104.54 69.99

; up to 10-18" upto 17" up to e " up to 15-17" up to 15.6” 16"

Available for 13" Notebooks Notebooks Notebooks 15.6" Notebooks 1315 MacBooks 133 16" Notebooks Notebooks Notebooks Notebooks

www.BandH.com BSH



COMPUTERS

23" Ideacentre 5105 Multi-Touch
All-in-One Desktop Computer

The 23" Ideacentre 510-23 Multi-Touch All-in-One Desktop Computer is a

compact all-in-one computing solution for all of your everyday tasks and

more. Powered by a 2.9 GHz AM A9-9410 Dual-Core processor and 4GB of

2133 MHz DDR4 RAM, the AI0 510 can efficiently multitask and quickly

access frequently used files and programs. For storage, it's equipped

with a 1TB 7200 rpm hard drive.

» 2.2 GHz Intel Core i5-6400T Quad-Core

» 86B DDR4 RAM | 1TB HDD » 23" 1920 x 1080
Touchscreen Display

» Integrated Intel HD Graphics 530

» SuperMulti DVD Drive | Media Card Reader

» 802.11ac Wi-Fi | Bluetooth 4.0 » USB 3.0/ USB 2.0/ HOMI/ VGA

s‘

ALL-IN-ONE COMPUTERS

23" EliteOne 800 G2

Multi-Touch All-in-One Desktop
The 23" EliteOne 800 62 Multi-Touch All-in-One Desktop Computer from
HP is a slim and sleek all-in-one PC that is suitable for bath home and
office use. Its 23" display features 10-point multi-touch functionality,
allowing you to utilize the touch gestures and functions in Windows 10

» §6B of 2133 MHz DDR4 RAM ﬁuf
» 17TB 7200 rpm SATA 2.5" Hard Drive

to further improve accessibility and productivity.
» 23" IPS Anti-Glare Mutti-Touch Display
» Slim SATA SuperMulti DVD Writer » 802.11ac Wi-Fi & Bluetooth 4.2

» 3.4 GHz Intel Core i7-6700 Quad-Core -
» FullHD 1920 x 1080 Screen Resolution
» USB 3.0 Type-A & Type-C / DisplayPort » Windows 7 Pro + Windows 10 Pro License

CPU Storage Graphics Memory SKU Price
CPU Storage Graphics Memory SKU Price i7-6700 1TB HDD AMD Radeon R9 A360 8GB HEBOOGZP5V06 | 1,376.66
A6-9210 2TB HOD AMD Radeon Ré Graphics | 8GB LEFOCEQO0BUS | 627.99 ib-6500 5006B HDD Intel HD Graphics 530 4GB HEE0B0062P5V | 1,119.00
Core i3-6100T 1TB HDD Intel HD Graphics 530 86B LEFOCD002XUS 595.00 i5-6500 5006B HDD Intel HD Graphics 530 46B HEB00G2Y2P28 941.24
i5-6500 5006B HOD Intel HD Graphics 530 4GB HEB00GZP5V03 | 925.00
23" Ideacentre 5105 Multi-Touch Pro0ne 400 62

All-in-One Desktop Computer

» 2.5 GHz Intel Core i7-6500U Dual-Core » 8GB of 2133 MHz DDR4 RAM
» 23" Multi-Touch Display » 1920 x 1080 Full HD Resolution

» Integrated Intel HD Graphics 520 o —
» 178 5400rpm HOD + 8GB SSD Cache » External DVD RW Driv@ o~
» 802.17ac Wi-Fi + Bluetooth 4.0 » USB 3.0 / Audio In/ut / HOMI » Windows 10

(LE10S231SU)

849.00

215" ThinkCentre M800z
All-in-One Desktop Computer

» 2.7 GHz Intel Core ib-6400 Quad-Core

» 4GB of 2133 MHz DDR4 RAM » 21.5" TFT Display
» 1920 x 1080 Full HD Resolution

» Integrated Intel HD Graphics 530

» 500GB 7200 rpm SATA Hard Drive

» SuperMulti DVD+RW Drive

» 802.11ac Wi-Fi & Bluetooth 4.1 » USB 2.0/ USB 3.0/ DisplayPort

(LEMBOOZ10ETT) 844.99

27" IdeaCentre AI0 Y910

All-in-One Desktop Computer
» 3.4 GHz Intel Core i7-6700 Quad-Core

» 1668 of DDR4 RAM | 25668 SSD + 278 HDD
» 27" 7560 x 1440 Anti-Glare IPS Display

» NVIDIA GeForce GTX 1080 (86B GDDR5X)

» SuperMulti DVD Drive | Media Card Reader

» 802.11ac Wi-Fi | Bluetooth 4.0 » USB 3.0 | USB 2.0 | HDMI » Windows 10 Home (64-Bit)
(LEFOCJ000B) Call or Log-on

SUS 23.8" 12401 Multi-Touch
All-in-One Desktop Computer

» 2.9 GHz Intel Core i7-7700T Quad-Core

» 166B DDR4 RAM | 1286B SSD + 178 HDD

» 23.8" 3840 x 2160 Multi-Touch Display

» NVIDIA GeForce GTX 1050 (4GB GDDR)

» 2-in-1 Media Card Reader » 80.211ac Wi-Fi | Bluetooth 4.1

(ASZ2401EDST1) 1,799.00

20" All-in-One Desktop Computer

» 3.7 GHz Intel Core i3-6100 Dual-Core

» 468 of DDR4 RAM | 50068 7200rpm HDD

» 20" 1600 x 900 Display » Integrated Intel HD Graphics 530
» SuperMulti DVD Drive | Media Card Reader

» 802.11ac Wi-Fi | Bluetooth 4.0 » 1x Gigabit Ethernet

» USB 3.0 USB 2.0 | DisplayPort

(HEA0DG2W5Y44)
@ Inspiron 24 3000 Series
All-in-One Desktop Computer

» 1.8 GHz AMD E-Series E2-7110 Quad-Core

» 4GB of 1600 MHz DDR3L RAM » 23.8" IPS Display
» 1920 x 1080 Screen Resolution

» Integrated AMD Radeon R2 Graphics

» 5006B 5400 rpm SATA 2.5" Hard Drive

» SuperMulti DVD | 4-in-1 Card Reader

(DEI345512418)
@ OptiPlex 7440
23" All-in-One Desktop Computer
» 3.2 GHz Intel Core i5-6500 Quad-Core » 8GB of 2133 MHz DDR4 RAM
» 23" WLED Display » FHD 1920 x 1080 Screen Resolution
» Integrated Intel HD Graphics 530 » 5006B 7200rpm Hard Drive
» Bx SuperMulti DVD Drive » 802.11ac Wi-Fi and Bluetooth
» USB 2.0, USB 3.0, HDMI 1.4, DisplayPort
» Windows 7 Pro + Windows 10 License

(DE07440GDHFD)
@ 23.8" Inspiron 5000 Series
» 2.8 GHz Intel Core i7-6700T Quad-Core
» 126B of 1600 MHz DDR3L RAM
» 23.8" Truelife IPS Multi-Touch Display
» Full HD 1920 x 1080 Screen Resolution
» Integrated Intel HD Graphics 530
» 17B 5400 rpm Hard Drive » SuperMulti DVD Burner
» 802.17ac Wi-Fi, Bluetooth 4.0 » Dell Wireless Keyboard & Mouse Included

(DEI545970208)

714.00

469.00

945.00

999.99

800-947-3308 - 212-444-6691




12 Mini 63 Desktop Workstation

Made by and for design professionals, such as CAD users, the
12 Mini G3 Desktop Workstation from HP delivers power, performance,
versatility, and reliability in a small and elegant design. At 2.3" high,
itis 90% smaller than a traditional business-class tower. The Z2 Mini
has been tested for 368,000 hours and certified for over 20 professional
software applications, such as AutoCAD, Vectorwarks, MicroStation,
Inventor, SOLIDWORKS, Solid Edge, and Revit.
» Designed for the Creative Professional
» 3.4 GHz Intel Core i7-6700 Quad-Core
» 166B of 2400 MHz DDR4 RAM > NVIDIA Quadro M620 Graphics Card (2GB)
» 5126B Z Turba Drive 62 PCle SSD » 1 x Gigabit Ethernet Port
» 802.11ac Wi-Fi & Bluetooth 4.2 » 2 x USB 3.0 Type-C & 4 x USB 3.0 Type-A
» 4 x DisplayPort 1.2 » Windows 7 Pro + Windows 10 Pro License

WORKSTATION COMPUTERS

Processor Memory  Storage GPU SKU Price

Core i7-6700 1668 51268 SSD Quadro M620 HEZZME17UT 1,669.99

Xeon £3-1245 1468 51268 5D Quadro M620 HEZZMDBIUT 1,559.00

Core i7-6700 868 75668 SSD Quadro M620 HEZ2MD6OUT 1,235.00

Core i7-6700 868 1TB HOD Quadro M620 HEZZMET6UT 1,165.00

Core i7-6700 868 25668 SSD Intel HD 530 HEZZME15UT 1,074.99
™ 1640

The Z440 Minitower Workstation from HP delivers powerful
performance in a minitower form factor and is designed for professionals who
require high reliability. The Z440 is well suited for tasks such as intensive
graphics, 30 rendering, multimedia, and gaming, as well as science and
engineering applications.

» Slim SuperMulti DVD Writer
» Gigabit Ethernet » Windows 7 Pro + Windows 10 Pro License

Processor Memory  Storage Display SKU Price
3.5 GHz Intel Xeon Quad-Core 1668 5126BSSD | NVIDIA Quadro M2000 HEZ440X2084U 2,389.00
3.6 GHz Intel Xeon Six-Core 1668 118 7.2k NVIDIA Quadro M2000 HEZ440W9208U 2,589.00
3.5 GHz Intel Xeon Quad-Core 868 1187.2 NVIDIA Quadro M2000 HEZ440X2066U 1,949.00
3.1 GHz Intel Xeon Quad-Core 868 118 7.2k NVIDIA Quadro K620 HEZ440X2064U 1,579.00

n 1840

Within the Z Series, the 2840 Rackable Minitower
Workstation from HP delivers extreme performance in a
rackable minitower form factor.
» 118 7200rpm Hard Drive » SuperMulti DVD Burner
» Dual Gigabit Ethernet Ports » 8 x USB 3.0, 2 x USB 2.0 Parts
» USB Keyboard & Mouse Included
» Windows 7 Pro + Windows 10 Pro License

Processor RAM Graphics SKU Price
2x 2.2 GHz Intel Xeon Eight-Core 1668 No Graphic Card Installed HEZ840TAP12 3,199.00
1.2 GHz Intel Xeon Ten-Core 868 No Graphic Card Installed HEZ840T4P06 2,799.00
2.1 GHz Intel Xeon Ten-Core 86B No Graphic Card Installed HEZB40TA4P05 2,649.00

ThinkStation P310

The ThinkStation P310 Series Tower Workstation from Lenovo
delivers strong performance within a tower form factor for
mission-critical work such as finance, engineering, architecture,
media, and science applications.

» DVD=RW Drive » 1x Gigabit Ethernet Port

» 9-in-1 Media Card Reader » 6 x USB 3.0, 2 x USB 2.0 Ports

» USB Wired Keyboard & Mouse Included

» Windows 7 Pro + Windows 10 Pro License

Processor RAM Storage Graphics SKU Price
3.5 GHz Intel Xeon Quad-Core| 8B 118 7.2 NVIDIA Quadro K620 LEP31030ATOH 899.99
3.5 GHz Intel Xeon Quad-Core|  8GB 15668 SSD Intel HD Graphics P530 |  LEP31030AT0G 909.00
3.5 GHz Intel Xeon Quad-Core|  8GB 11872k Intel HD Graphics P530 |  LEP31030ATOR 999.00

www.BandH.com

COMPUTERS

1240

The 2240 Series Tower Workstation from HP delivers
powerful performance in a tower form factor and is designed for
professionals who require high reliability. With the capabilities
to operate in immersive work environments and handle 24x7x365
workloads, the 2230 delivers processor and graphics technologies
ina compact yet expandable tower.
» Gigabit Ethernet » Windows 7 Pro + Windows 10 Pra License

Processor RAM Storage Graphics SKU Price
3.8 GHz Intel Xeon Quad-Core 1668 | 2.2TB7.2k&SSD | NVIDIA Quadro K2200 | HEZ240LK921U | 1,999.00
3.4 GHz Intel Xeon Quad-Core 1668 51268 SSD NVIDIA Quadro K2200 | HEZ240LK970U | 1,799.00
3.4 GHz Intel Xeon Quad-Core 146B 15668 SSD Intel HD Graphics 530 | HEZ240LK9200 | 1,100.12
3.4 GHz Intel Xeon Quad-Core 868 1B 7.2k Intel HD Graphics 530 | HEZ24009K19U | 1,079.00
3.2 GHz Intel Core i5-6500 Quad-Core | 4GB 118 7.2 Intel HD Graphics 530 | HEZ240L9K180 |  879.00
1640

The 2640 Rackable Minitower Workstation from HP delivers
powerful performance in a rackable minitower form factor and is
designed for professionals who require high reliability. The 2640 is well
suited for tasks such as intensive graphics, 30 rendering, multimedia,
and gaming, as well as science and engineering applications.

» Slim SuperMulti DVD Burner

» 8xUSB3.0/2xUSB2.0/1xRJ-45

» Tool-Less Expandable Design

» Windows 7 Pro + Windows 10 Pro License

Processor RAM  Storage Graphics SKU Price
2x 2.1 GHz Intel Xeon Eight-Core | 166B 565D | No Graphic Card Installed | HEZ640T4P02 2,899.00
2.2 GHz Intel Xeon Eight-Core | 166B 256550 NoGraphic Card Installed | HEZ640T4P01 2,339.99
2.1 GHz Intel Xeon Eight-Core | 8GB 1TB7.2k | No Graphic Card Installed|  HEZ640T4P00 2,029.00

2240 Small Form Factor

The 2240 Series Small Form Factor Workstation (ENERGY
STAR] from HP delivers powerful performance in a small form
factor design and is geared towards professionals who require
high reliability. With the capabilities to operate in immersive work
environments and handle 24x7x36 workloads, the 2240 delivers
processor and graphics technologies, as well as scalability to match
your business needs.
» Slim SuperMulti DVD Burner
» Gigabit Ethernet » 8 x USB 3.0, 2 x USB 2.0 Parts
» Windows 7 Pro + Windows 10 Pro License

Processor RAM Storage Graphics SKU Price
3.5 6Hz Intel Xeon Quad-Core | 166B | 1.2TB7.2k&SSD | NVIDIA Quadro K620 | HEZ240LK917U 1,529.00
3.4 GHz Intel Xeon Quad-Core | 86B 11B7.2 NVIDIA Quadro K620 | HEZ240L9K66U 1,118.53
3.2 6Hz Intel Xeon Quad-Core | 86B 11B7.2 Intel HD Graphics 530 | HEZ240L9K15U 909.00

P Series ThinkStation P410 Workstation
with Xeon E5-1620 v4 Processor

The P Series ThinkStation P410 Workstation from Lenovo

is powered by a Xeon E5-1620 v4 quad-core processor that
operates on 3.5 GHz frequency. If you need more power, the CPU
can deliver extra performance by increasing the clock speed

up to 3.8 GHz utilizing Intels Turbo Boost technology.

» 3.56Hz Intel Xeon E5-1607 v4 quad-core CPU

» 86B 400 MHz DDR4 ECC RAM » 1TB 7200rpm

» No Graphic Card installed » Rambo8 DVD Burner

» Windows 10 Pro 64 » 6 x USB 3.0 ports

» Onboard RAID 0, 1,5, 10 controller

(LEP41030B32H)

1,075.00




COMPUTERS

MACBOOKS

U
' Authorized Reseller MacBook Pro

The MacBook Pro Laptop Computer with Retina Display from
Apple is ac powerful notebook computer with an innovative,
ultrathin, ultraportable aluminum unibody design. It is loaded
with advanced power management features and an integrated
lithium polymer battery, which work together to provide up to
9 hours of wireless web browsing.

The widescreen, LED-backlit IPS screen has a glossy finish.

With 227 pixels per inch, this MacBook Pro has a pixel 3
SCEERACINRALTOERT" mp

count of over 5 million. You'll be able to output to 2 external » 360° Scrolling Ball
displays at up to 2560 x 1600 via Thunderbolt 2 (Mini '— l » Precision Optical Sensor
DisplayPort). Any Mini DisplayPort-compatible display will (APWM) 49.00

plug in without the need for an adapter. This MacBook Pro
also adds an HDMI port so HDMI-compliant devices,
particularly HDTVs, are now natively supported as well.
Graphics are handled by integrated Intel Iris Graphics.

15.4” MacBook Pro & World Travel
» 802.11ac Wi-Fi & Bluetooth 42 mac$ Sierra 13.3” MacBook Pro Adapter Kit .
» Thunderbolt 3 (USB Type-C) Ports ~ » Intel Core i7 Quad-Core » Intel Core i5 Dual-Core B v SUDPOFtSGVHTIEtY of
» 3.5mm Headphone Jack | » 166B 2133 MHz RAM » B86B of 2133 MHz RAM | 25668 PCle SSD o REQIDHS_

Stereo Speakers » 15.4” 2880 x 1800 Retina Display » 13.3" 2560 x 1600 Retina Display LY - » Seven Different AC Plugs
» Touch Bar | Touch ID Sensor » AMD Radeon Pro GPU » Integrated Intel Irs Graphics !ncludgd .

» iPod, iPhone & iPad

STARTING AT 2,599.00 STARTING AT 1,399.00 Compatible

—
<
om
=
=)
3
=4

’
. (APWTAK) 29.00

@ Authorized Reseller MacBook
» With a Retina display and a thin, lightweight

design, the gold Apple 12" MacBook 2 .

(Early 2016) provides both portability and @ Authorized Reseller

pe.rfnrmanct_z. Measuringjust 0.5"(13.1mm) 2-Year AppleCare

thin and weighing only 2 pounds, the P ion Plan E .

MacBook is compact yet still has a premium rotection Plan Extension

feel, thanks to its unibody design. » Get Peace Of Mind By

: St Extending Your Coverage

» DresEROAREATO

}gééLE/IDHZBLPElDRIig?{M‘ Disol \, § For Two Additional Years [

-Back(it P Retina Display 0f Both Telephone

» 2304 x 1440 Screen Resolution Support And Service
» Integrated Intel HD Graphics 515 » 256GB PCle-Based Flash Storage » USB 3.0 Type-C Port Coverage 7
» i-Fi » » » i i i re

802.11ac Wi-Fi, Bluetooth 4.0 » Force Touch Trackpad » Mac 0S » Available in Gold, Rose Gold, Silver, Space Gray » Computer Automatically mhﬁm
STARTING AT 1,199.00 Registered with

AppleCare
» Repairs Are Performed By Apple-Certified Technicians
Using Genuine Apple Parts

.’ Authorized Reseller MacBook Air

The 13.3” MacBook Air Laptop Computer (Early 2015) from Apple is an
ultraportable notebook computer with a thin and lightweight design.
Apple’s engineers have leveraged the lessons they learned in designing

ACCESSORIES

i
. Authorized Reseller

Wired Mouse
Elegant, Ergonomic

» Touch-Sensitive Buttons
» Force-Sensitive Side Buttons

s
' Authorized Reseller

» MagSafe & MagSafe 2 Compatible
» Includes A Set Of Seven AC Plugs With Prongs That Fit
Different Electrical Outlets Around The World

» Receive Web-Based Support For Your Computer, Allowing
You To Quickly Diagnose And Solve Problems

» Global Repair for Portable Computers

» Includes TechTool Deluxe from Micromat

For MacBook, MacBook Air, 13" Pro, & 13" Retina Pro

the miniaturized iPad and applied them to the design of this 2.96-pound (APACPPAEMBAZ) 229.00
computer. To say that the Air is svelte is all at once stating the obvious For 15.4” MacBook Pro

and understating the truth. The system is defined by its unibody aluminum (APACPPAEMBPZ) 299.00
enclosure. At its thickest point the computer is anly 0.68” — it tapers — . For 15.4” MacBook Pro with Retina Display

down to 0.11" at its thinnest. (APACPPMBP) 299.00
» 868 of 1600 MHz LPDDR3 RAM » 13.3" LED-Backlit Glossy Display » USB 3.0, Thunderbolt 2 MacBook, MacBook Air, 13" MacBook Pro &

» PCle-Based Flash Storage » 1440 x 900 Native Resolution » 720p FaceTime HD Camera, SDXC Card Slot 13.3" MacBook Pro with Retina Display

» Integrated Intel HD Graphics 6000 » 802.11ac Wi-Fi, Bluetooth 4.0 » Mac 0S X EL Capitan or mac0S Sierra (APACPPMBA) 249.00

STARTING AT 899.00

n B:H 800-947-3308 + 212-444-6691




ALL-IN-ONE & DESKTOP COMPUTERS

.’ Authorized Reseller " |Mac 5K

The Apple 21.5" iMac measures at just 5 mm at its edges, which is 40% less volume than the 2011 iMac.
The widescreen display features LED backlighting for vibrant, accurate color. With in-plane switching (IPS)
technology, the iMac has a wide 178° viewing angle. The iMac houses a bth-Gen Broadwell Intel Core ib
Dual-Core processor with 1867 MHz LPDDR3 onboard RAM.

Apple weds high-res 5K visuals into its sleek bmm thin 27" iMac with Retina 5K Display. With a 5120 x
2880 native resolution, this iMac provides 14.7 million pixels, which is 7 times more than the standard HD
display. The Retina 5K display also features a wider color gamut. Using a P3-based color gamut, the Retina
bK display provides a 26% larger color space than standard sRGB displays. And with more available colors,
the images will appear more vivid and reveal greater detail.

» 802.1ac Wi-Fi, Bluetooth 4.0 » Thunderbolt 2 + USB 3.0
» Magic Keyboard & Magic Mouse 2 Included » Mac 0S X

21.5” iMac

» 21.5" Retina 4K IPS Display
» 4096 x 2304 Screen Resolution
» Intel Core i5 Quad-Core

27” iMac
» 27" Retina 5K IPS Display

» 5120 x 2880 Screen Resolution
» Intel Core i5 (Skylake)

» 86B of 1867 MHz LPPDR3 Onboard RAM » 1867 MHz DDR3 RAM
» Integrated Intel Iris Pro Graphics 6200 » AMD Radeon R9
STARTINGAT .. 999.99 STARTING AT oo 1,679.99

i s
. Authorized Reseller . Authorized Reseller

ACCESSORIES

COMPUTERS

s’
. Authorized Reseller

’
. Authorized Reseller

USB SuperDrive Magic Mouse 2 Magic Trackpad 2

External Slot-Loading » Wireless Buetooth > » Force Touch

Optical Drive Connectivity Support

» USB Powered » Built-in Rechargeable Batter » Wireless i

» Slim & Portable \/ » Optimized Foot%esign : » Anodized Aluminum Enclosure Bluetooth Connectivity

» For Mac with a USB Port ] » Lightning to USB Cable Included » Extended Layout > Low Profile Keys » Built-In Rechargeable Battery

» Easily Slips Into a Travel Bag » Mac Compatible » One-Touch Access » Two USB 2.0 Ports » Mac Compatible

(APMMDB64LLA) - 1900 [APMLADZLLA) ceverensesensesensesensesessasensenas 76.50 [APMBITOLLB) ceusearesesenrnessssnseresensasananes 49.00 (APMJZR2LLA) 121.00

STARTING AT e £,799.00

www.BandH.com

.’ Authorized Reseller " MaC Pro

Apple revisited the architecture of the Mac Pro’s internal components in order to maximize performance and minimize
heat. With a unified thermal core, Apple opted for a leaner, lighter, and quieter structure that was more streamlined.
The unique cylinder design stands just 9.9 inches tall with a diameter of just 6.6 inches, which allows it to be a
professional workstation that can actually sit on your desk.

The Mac Pro has six Thunderbolt 2 ports, a high-speed
interface that can move data at up to 20 Gb/s. That's four
times the speed of the USB 3.0 standard. Speaking of USB
3.0, Apple added four USB 3.0 ports to ensure you have
full native connectivity options with your USB-compatible
peripherals, such as external hard drives.

iLife has a complete suite of digital creativity applications.
Easy enaugh for anyane to use, iLife will help you edit your
home movies, organize digital photos and compose original
music. iLife includes iPhoto, iMovie and GarageBand.

iWork provides three apps to keep you productive. Pages allow you to make creative word documents. Numbers helps you make spreadsheets more visually
insightful. Keynote allows you to create a powerful presentation, complete with animated charts, interactive tables with cinematic effects and transitions.

» Intel Xeon > 1866 MHz DDR3 ECC RAM
» PCle-based Flash Storage
» Dual AMD FirePro GPUs

» Six Thunderbolt 2 Ports
» Four USB 3.0 Ports, One HDMI 1.4 Port
» Supports up to Three 4K Displays

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.0
» Unique Compact Cylinder Design
» Mac 0S X



COMPUTERS

) 280 G1 Microtower
» 3.2 GHz Intel Core ib-6500 Quad-Core
» 46B of 2133 MHz DDR4 RAM » Integrated Intel HD Graphics 530
» 500GB 7200 rpm SATA 3.5" Hard Drive
» Slim SATA SuperMulti DVD-RW » 1 x Gigabit Ethernet Port
» 2% USB 3.0 Type-A &6 x USB 2.0 Type-A » DVI-D/VGA

(HE28062T6W22)

ThinkCentre M600
Tiny Desktop Computer (Black)

DESKTOPS
» 1.6 GHz Intel Pentium J3710 Quad-Core » 4GB of 1600 MHz DDR3L RAM

» Integrated Intel HD Graphics 405 » 500GB 7200 rpm 2.5" HDD

» 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.0

» USB 3.0/ USB 2.0/ DisplayPort » Lenovo Keyboard & Mouse Included

539.00 .
» Windows 7 Professional (64-bit) » Windows 10 Pro (64-bit) License

(LEM60010GUUS) 380.11

Monitor
not
included

ThinkCentre M900

» 8GB of DDR4 RAM > Integrated Intel HD Graphics 530
» One Ethernet Port » 802.11ac Wi-Fi, Bluetooth 4.0
» DisplayPort, USB 3.0 » USB Keyboard & Mouse Included

» Windows 10 License » Windows 7 Professional (64-bit) ————
CPU Storage SKU Price
2.5 GHz Intel Core i5-6500T Quad-Core 25668 SSD LEM90010FMTU 739.00
2.8 GHz Intel Core i7-6700T Quad-Core 1286B SSD LEM90010FMO0 899.00

@ Inspiron 3250

Small Form Factor Desktop Computer

» 3.7 GHz Intel Core i3-6100 Dual-Core » 4GB of DDR3L RAM

» Integrated Intel HD Graphics 530 » 1TB Hard Drive

» SuperMulti DVD Burner » Ethernet, Bluetooth

» USB 3.0, HDMI, VGA » Small Form Factor » Windows 10 Home (64-bit)

(DEI325030BLK) 368.23

@ XPS 8910

Desktop Computer

» 3.4 GHz Intel Core i7-6700 Quad-Core

» 86B of DDR4 RAM | 17B 7200rpm HDD

» NVIDIA GeForce GT 730 GPU » SuperMulti DVD Burner

» 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi | Bluetooth 4.2

» USB 3.1 Type-C | HOMI | DisplayPort » SDXC Card Reader

» Dell USB Keyboard & Mouse Included » Windows 10 Home (64-bit)

(DEX891030208) 849.00

(i/ntel') Compute Stick

Transform your display into a fully functional computer
with the Compute Stick from Intel. This over-sized thumb drive PC offers
the performance similar to your other computer and allows you to stream
online videos, play games, work on projects, & more.
» Intel HD Graphics » HDMI/USB 2.0/USB 3.0 » 802.11ac Wi-Fi,

Bluetooth 4.0 » Micro-SDXC Card Slot » Multi-channel Audio

» Space-saving Design » Windows 10

Processor RAM Storage SKU Price
1.44 GHz Intel Atom x5-28300 Quad-Core 268 3268 INBOXSTKTAW3 126.19
900 MHz Intel Core m3-6Y30 Dual-Core 4GB 6468 INBOXSTKZM3W 339.99

7 EliteDesk 800 G2 Desktop Computer
» 3.4 GHz Intel Core i7-6700 Quad-Core

» 868 of 2133 MHz DDR4 RAM
» Integrated Intel HD Graphics 530 » 1TB 7200rpm HOD
» Slim SuperMulti DVD Burner » Gigabit Ethernet
» DisplayPort, VGA, USB 3.0, USB 2.0
» Windows 7 Professional (64-bit) » Windows 10 Pro License
1TB 7.2k (HEB00G2P4K19)
2566B SSD (HEB00G2TALES)...........

) HP ProDesk 600 G2 Mini Desktop Computer
» 2.5 GHz Intel Core ib-6500T Quad-Core
» 4GB of 2133 MHz DDR4 RAM
» Intel HD Graphics 530 » 500GB 7200 rpm
SATA Hard Drive » 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.0 LE
» 6 xUSB 3.0 Ports &1 x USB Type-C Port » 2 x DisplayPort & 1 x VGA
» USB Keyboard & Mouse Included » Windows 7 Pro + Windows 10 Pro License
500GB 7.2k (HEP5V95UT)
128GB SSD (HEP5V98UT)

soi

Small Form Factor Desktop Computer

» 2.7 GHz Intel Core i5-6400 Quad-Core » 4GB of 2133 MHz DDR4 RAM
» Integrated Intel HD Graphics 530 » 500GB 7200 rpm Hard Drive

» SuperMulti DVD Burner » 1 x Gigabit Ethernet Port

» 4xUSB3.0,2xUSB 2.0 Ports » DisplayPort & VGA

» UUSB Wired Keyboard & Mouse Included » Windows 10 Pro (64-bit)

(LES51010KY2B)

OptiPlex 3040
Small Form Factor Desktop Computer

» 3.2 GHz Intel Core i5-6500 Quad-Core

» 86B of 1600 MHz DDR3L RAM » 5006B 7200rpm Hard Drive
» Integrated Intel HD Graphics 530 » SuperMulti DVD Burner
» Ethernet Port » HDMI, DisplayPort, USB 3.0, USB 2.0

» Dell Wired Keyboard & Mouse Included

» Windows 7 Professional (64-bit) » Windows 10 License

(DE03040Y6FG)

(intel) Mini PCNUC Kit
The Mini PC NUC Kit from Intel is a compact system that
fits in the palm of your hand and packs the performance of a Broadwell
dual-core Intel Core processor with integrated Intel HD Graphics.
» 1xM.2Slot, 1 x SATA » 1x Gigabit Ethernet Port
» 1 x Mini-HDMI, 1 x Mini DisplayPort » 802.11ac Wi-Fi, Bluetooth 4.0
» 4xUSB 3.0 Ports » Front Panel IR Sensor » Windows & Linux Compatible
CPU Graphics SKU Price
3.1 GHz Intel Core i7-5557U Intel HD Graphics 6100 INBOXNUCSI7R 469.00
1.9 GHz Intel Core i5-6260U Dual-Core | Integrated Intel HD Graphics 540 INBOXNUC6I5H 374.48

Call or Log-on

/iSU=" Chromebox M004U

Google Chrome 0S is a Linux-based operating system
designed by Google to work exclusively with web applications.
The Chromebook combines the aspects of a cloud client

with the hardware of a portable computer.

» 1.4 GHz Intel Celeron 2955U Dual-Core » 2-in-1Media Card Reader » DisplayPort, HDMI, USB 3.0
» 268 of 1600 MHz DDR3 RAM > Integrated Intel HD Graphics » 10/100/1000 Mbps Gigabit Ethernet
» 1668 SSD » Free 1006B on Google Drive for 2 Years » 802.11a/b/g/n Wi-Fi, Bluetooth 4.0

[ASCBMO04U) 163.50

800-947-3308 - 212-444-6691




Microsoft Windows 10 Pro

» Expanded Start Menu
» Microsoft Edge Web

Browser » Cortana Digital
Personal Assistant » Snap
Window Enhancements

» Multipte Virtual Desktops

» Action Center Icon

» Bitlocker » Enterprise Data Protection

64 Bit/OEM DVD (MIFC08930)................ 139.00
32 Bit/OEM DVD (MIFQC08970)........... 129.00
32/64 Bit USB Flash Drive (MIWP10FD) .. 181.50
32/64 Bit Download (MIFQC009131).......... 199.99

Microsoft Windows 7 Pro
» Improved Desktop Navigation

» Windows Search

» Internet Explorer 8

» Windows Media Center
» HomeGroup Networking
» Windows XP Mode

» Domain Join

» Netwark Backup

» OEM Version

64 Bit/OEM DVD (MIW7SP64)

135.99

I\ Adobe Acrobat

» Edit & Share PDFs
Across Devices

» Document Cloud
Services

» Adobe Acrobat DC
Mobile App Compatible

» Windows Compatible

Pro (ADAPDCZOTOW) .ooooooooo 429.99
Standard (ADASDC2015) ... 289.00

Microsoft lifeCam Studio

for Business

» CMOS Sensor Technology
» 1920 x 1080 Sensor
Resolution » Up to 30 Frames
Per Second » 5 Megapixel
Still Images » 75° Diagonal
Field of View » 720p HD Video Chat
» Auto Focus from 0.3 to 32.8" » 360° Rotation

[MILCSTOBOWCG) ... 59.81

(- Logitech' C930e Webcam

» Full HD 1080p Video Calling

» H.264/SVC Video
Compression » 90°
Field of View » 4X Zoom
in1080p » RightLight 2
Technology » Carl Zeiss
Certified Lens > Integrated Autofocus

» External Privacy Shutter

(LOCIZOE) o _Callor Log-on

www.BandH.com

SOFTWARE & WEBCAMS

Micresoft Windows 10 Home

» Expanded Start Menu
» Microsoft Edge Web

Browser » Cortana Personal
Digital Assistant » Snap
Window Enhancements

» Multiple Virtual Desktops

» Action Center Icon

» Touch, Keyboard, & Mouse Support

64 Bit/OEM DVD (MIKW900140)..................92.99
32 Bit/OEM DVD (MIKW900186)..................99.95
32/64 Bit USB Flash Drive (MIWH10FD)....109.98
32/64 Bit Download (MIKW900265)............ 119.99

McAfee Internet Security 2015

» Protects Against Viruses

» Real-Time Protection
from Latest Threats

» Privacy and PC
Optimization Tools

» SiteAdvisor

» Parental Controls

» Anti-Spam Email Filter » Windows Compatible

[MCMIS15EBF3R) 14.95

COREL WordPerfect Office X8
Home & Student Edition

» WordPerfect Word Processor

» Quattro Pro Spreadsheet
Program » Presentations
Slideshow Creator

» WordPerfect Lightning
Digital Notebook

» WordPerfect Address Book

» WordPerfect XML Project Designer

(COWPOXBHSB) 79.99

Micresoft LifeCam Studio

» CMOS Sensor Technology

» 1920 x 1080 Sensor
Resolution » Up to 30 Frames
Per Second » 5 Megapixel Still
Images » 75° Diagonal Field of
View » 720p HD Video Chat

» Auto Focus from 0.3 to 32.8'

» 360° Rotation » Wide-Band Microphone

[MILCSPL2) 79.95

(=- Logitech Webcam C170
» Supports VGA 640 x 480 Video Calling
» XVGA Video Capture
Up to 1024 x 768
» Take bBMP Phatos
(Software Enhanced)
» Logitech Fluid

Crystal Technology
» Built-In Microphone with Noise Reduction
(Loc170) 19.95

Microsoft 0ffice Home 2016
» Microsoft Word s —
» Microsoft Excel Office
» Microsoft PowerPoint :
» Microsoft OneNote

» OneDrive Cloud Storage

et

J

o vs=ss]
STUDENT EDITIONS
Mac 1-user License (MIGZA008SD)............ 149.99
Windows 1-user License (MI79604589)..... 149.95

BUSINESS EDITIONS
Windows 1-user License (MIT5002776).....229.00

KASPERSKY2 Internet Security 2016
» Internet Protection Against
All Viruses » Protection

Against Online Threats
» Secure Online Banking
and Shopping » Detects
New and Emerging Threats
» Safeguards Your Digital
Identity » Secure Keyboard Against Keyloggers
» Parental Controls » Webcam Protection

(KAIS20161Y3U) 36.99

|| Parallels Desktop 12 for Mac
» Travel Mode
» One-Click Performance
Tuning » Use Cortana for
Both Windows & Mac Apps
» Supports Windows 10
» Ready for
Mac0S Sierra
» Supports Linux &
Google Chrome 0S

(PADTIZMBOXNA). ..o 79.95

Microsoft LifeCam Cinema
» CMOS Sensor Technology
» 1280 x 720 Resolution
» Up to 30 Frames per
Second » 73° Diagonal
Field of View
» 720p HD Video Chat
» Auto Focus » 360-degree Rotation
» Wideband Microphone

[MILCXC) 46.24

CREATIVE Livel Cam Chat HD

Webcam

» 720p Online Video
Chatting @ 30 fps

» b.7MP Still Images

» Noise-Canceling Mic

» One-Click Upload to Facebook and YouTube

» Supports Password Protection Controls

[CRLCCHDWC) 24.95

COMPUTERS

Micresoft (ffice 365
» Word » Excel =
» PowerPoint » OneNote
» OneDrive Cloud Storage
» Access (PC Only) 1] Office 365
» Publisher (PC Only) S
» Use on Mobile Devices -
» OneDrive + 20 GB
of Storage
» 60 Minutes of Skype
Calls Per Month

Premium (MI66GQ0009T)......cc.ccovc 99.00

- Norton Security Premium
2017 3.0 (10-Device, 1-Year)

» Virus and Spyware i —
Protection

» Safeguards Identity
& Transactions

» Secures PCs, Macs,
and Mabile Devices

» Safely Explore Websites

» Family Safety Features

(SYNSP2017101) 79.99

wz: Dragon NaturallySpeaking 13 Home
Voice Recognition Software
» Standard Headset =
& USB Adapter Included - —
» Increased Productivity ———
» Software Adapts to
Learn and Proofreads (5
» Free Dragon Remote
Mic App » Use with -
Microsoft Office and the Web
(NUK409AG0013) 79.99

Micresoft LifeCam HD-3000

» 720p HD Video, 30 fps

» 16:9 Widescreen

» Integrated Omnidirectional
Microphone

» TrueColor Technology,
24-bit Color Depth

» Movie Maker & Photo Gallery
Software » Skype Certified

(MIHD3000) 24.95

W WebStar usB-Powered
&Y LEDRinglight -
for Webcams @)
» Ringlight for Webcams ;
USB Powered LED Ringlight

» 21 Energy-Efficient LEDs
» Two Levels of llumination

» Spring-Loaded Clamps

(STOV120L8) 79.00




COMPUTERS

@ P27150 27> 4k Monitor

» In-Plane Switching (IPS) Technology
» DisplayPort Input + DisplayPort Output
» Mini DisplayPort + HDMI (MHL) Inputs
» 3840 x 2160 Resolution
» 2,000,000:1 Contrast Ratio
» 350 cd/m? Brightness
» 178°/178° Viewing Angles
» 9 ms Response Time
» 1.07 Billion Colors » Built-In USB 3.0 Hub

(DEP27150Q)

602.69

/iSUS PB2870

28” Widescreen 4K UHD Monitor

» 3840 x 2160 4K Resolution

» 1 ms Response Time

» 300 cd/m? Brightness

» 1.073 Billion Color Support

» 170°/160° Viewing Angles

» 8 x SPLENDID Video Preset Modes
» 3 x Skin Tone Selection Modes

» & x Color Temperature Selection Mades
(ASPB2670)

399.00

BeéNQ BL3201PH 32” widescreen LED

Backlit LCD IPS 4K Monitor

» In-Plane Switching (IPS) Technology

» DVI-DL/DP1.2/ mDP1.2 / Dual HOMI

» 3840 x 2160 Resolution

» 1,000:1 Contrast Ratio

» 350 cd/m? Brightness » 178°/178°
Viewing Angles » 4 ms Response Time

» 1.07 Billion Color Support » 100% sRGB
Color Gamut » Integrated USB 3.0 Hub

(BEBL3201PH)

799.00

@ LG 38UC99-W 38" 21:9 4k WQHD+

Curved IPS Monitor

» 38" IPS (In-Plane
Switching) Panel

» HDMI & DisplayPort
Inputs » 3840 x 1600
Resolution » Mega
Dynamic Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles » 5 ms Response Time (6tG)

(LG3BUCIIW) 1,499.00

zex-rite i1Display Pro

» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems

» Works On All Modern Display
Technologies » Field-Upgradeable
for Future Technology

» Rotating Diffuser Arm / Tripod Mount

» Basic and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy

(XREODIS3)

239.00

4K MONITORS & CALIBRATION SOLUTIONS

@ P24150 24” ultra HD 4K Monitor
» In-Plane Switching (IPS) Technology

» DisplayPort Input + DisplayPort Output

» Mini DisplayPort + HDMI (MHL) Inputs

» 3840 x 2160 Resolution

» 2,000,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles

» 8 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub ~—ur_~

(DEP24150) 389.00

iSUS PA90

32" 16:9 4K/UHD IPS Monitor

» In-Plane Switching (IPS) Technology
» HDMI 2.0 & DisplayPort 1.2 Inputs

» 3840 x 2160 Resolution

» ASUS Smart Contrast Ratio

» 350 ¢d/m? Brightness

» 178°/178° Viewing Angles

» b ms Response Time

» 1.074 Billion Color Support

(ASPA3290) 1,205.13

@ LG Digital Cinema 31MU97-B
31” Widescreen LED Backlit IPS 4K Monitor

» In-Plane Switching (IPS) T
Technology » HOMI /
DisplayPort / Mini DisplayPort

» 4096 x 2160 Resolution

» 1,000,000:1 Contrast Ratio

» 320 cd/m? Brightness

» 178°/178° Viewing Angles

» 17:9 Aspect Ratio

(L631MU97B)

Call or Log-On

@ LG 27UD68-P 27" 16:9 4K UHD IPS Monitor

» In-Plane Switching (IPS) Technology

» HDMI 2.0/DisplayPort 1.2/D-Sub N
Inputs > 3840 x 2160 Resolution ©

» 5,000,000:1 Dynamic Contrast  §
Ratio » 350 cd/m? Brightness

» 178°/178° Viewing Angles

» b ms GtG Response Time

» 10-bit Color Depth

499.00

(L627UD48P)

datacolor s Spyder5PRO
Display Calibration System

» Calibrate Laptops, Desktop Manitors
» Includes Color Probe

» 16 Calibration Choices

» 3 Ambient Light Settings

» Before and After Evaluation

» Basic Display Analysis

» Comes in a Reusable Box / Case

(DAS5P100) 149.00

@ UP3216Q
» 31.5"IPS Panel
» HDMI/DisplayPort/mini-DisplayPort Inputs
» 3840 x 2160 Resolution
» 1,000:1 Contrast Ratio
» 300 cd/m? Brightness
» 178°/178° Viewing Angles
» 6 ms Response Time (GtG)
» 1.07 Billion Color Support
» Tilt/Swivel/Pivot/Height Adjustab

(DEUP32160)

1,424.99

NEC MultiSync EA275UHD-BK
27” Monitor

» In-Plane Switching (IPS) Technology

» DVI-D + DisplayPort + HDMI .
Inputs » 3840 x 2160
Resolution » 1000:1 Contrast
Ratio » 350 cd/m? Brightness

» 178°/178° Viewing Angles

» 6 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub

(NEEA275UHDBK)

W U28E590D 28” Widescreen
LED Backlit UHD Monitor
» Twisted Nematic Display Technology

» HOMI / DisplayPort Inputs -
» 3840 x 2160 Resolution

» 1,000:1 Static Contrast Ratio
» 370 cd/m? Brightness

» 170°/160° Viewing Angles

» 1 ms Response Time

» AMD FreeSync Technology » 1 Billion Color Support

(SAU2BE590D)

654.99

Call or Log-On

P 127s 27" 16:9 4K UHD IPS Monitor
» In-Plane Switching
(IPS) Technology
» HDMI 1.4/DisplayPort/Mini-
DisplayPart
» 3840 x 2160 Native Resolution
» 1,000:1 Static Contrast Ratio
» 300 cd/m? Brightness
» 178°/178° Viewing Angles
» 6 ms Response Time » 1.07 Billion Colors
(HEZ275)

523.00

yZa x-rite ColorMunki Display

» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems

» For Virtually All Modern Displays

» Field-Upgradeable for Future Technology
» Rotating Diffuser Arm / Tripod Mount

» Easy and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy
» Automatic Hardware Adjustment

(XRCMUNDIS)

149.00

800-947-3308 - 212-444-6691




UltraSharp

This UltraSharp Widescreen LED
Backlit IPS Monitor from Dell
utilizes in-plane switching technology
to produce 178° horizontal and vertical
viewing angles. The widescreen display
features a 16:10 aspect ratio with
a1,000:1 contrast ratio and a 6 ms
response time for crisp, clear picture
quality. The Dell monitors comes
ENERGY STAR Qualified, EPEAT Gold
Rated, and TCO Certified
» In-Plane Switching (IPS) Technology
» 1,000:1 Contrast Ratio
» 16.7 miilion colors
» 178°/178° Viewing Angles
» Tilt / Swivel / Pivot /

Height Adjustability

f—' na—

Wide Viewing Monitors

ASUS has included a blue light filter
and nearly eliminated all flicker from
within the display. By lowering blue
light emissions and eliminating display
flicker users benefit from increased

viewing comfort and reduced eye strain.

Additionally, ASUS has included their
own GamePlus functionality providing
gamers with both 0SD crosshair and
timer features.

» 16.7 miilion colors

» 1920 x 1080 Resolution

» 250 cd/m? Brightness

@ P2417H
23.8"16:9 IPS Monitor

» In-Plane Switching (IPS) Technology
» DisplayPort + HDMI + VGA Inputs

» 1920 x 1080 Resolution

» 1,000:1 Static Contrast Ratio

» 250 cd/m? Brightness

» 178°/178° Viewing Angles

» 6 ms Response Time

» 16.7 Million Colorss

(DEP2417H)

U7

U2612M

MONITORS

2415

COMPUTERS

02413

Model Resolution Screen Size Brightness Ports SKU
U770 2560x1440 i 350 cd/m? HDMI, DisplayPort, mini DisplayPort, USB 3.0 DEU2717D 469.94
U2612M 1920x1200 W 300 cd/m? DVI-D, DisplayPort, VGA, USB 2.0 DEU2412M 239.00
U2415 1920x1200 %" 300 cd/m? HOMI, DisplayPort, mini DisplayPort, USB 3.0 DEU2415 249.00
U2413 1920x1200 %" 350cd/m? HDMI, DisplayPort, mini DisplayPort, DVI-D, USB 3.0 DEU2413 427.99
UP2516D 2560x1440 25 300 cd/m? HDMI, DisplayPort, mini DisplayPort, USB 3.0 DEUP2516D 479.00
UP2716D 2560x1440 2 300 cd/m2 HDMI, DisplayPort, mini DisplayPort, USB 3.0 DEUP2716D 639.99

VP239H-P VP24TH-P VP2790-P VP228H
Model Screen Size Ports SKU
VP239H-P 3 HOMI D-Sub DVI-D ASVP239HP 149.99
VP24TH-P 236" HDMI D-Sub DVI-D ASVP24THP 139.99
VP2790-P i HDMI D-Sub DisplayPort ASVP2790P 227.00
VP228H 15" HDMI D-Sub DVI-D ASVP228H 109.99
VP278H-P 7" HDMI D-Sub ASVP278HP 209.99

W 350 Series S22F350
22" 16:9 FreeSync LCD Monitor

» Twisted Nematic (TN) Display
» HDMI + VGA Inputs

» 1920 x 1080 Resolution

» 1000:1 Static Contrast Ratio
» 200 cd/m? Brightness

» 170°/160° Viewing Angles

» b ms Response Time

» 16.7 Million Colors

(SAS22F350)

www.BandH.com

Call or Log-On

181.98

@ LG 34UM59-P
34" 21:9 FreeSync IPS Monitor

» In-Plane Switching
(IPS) Technology

» HOMI Inputs

» 2560 x 1080 Resolution

» Mega Dynamic Contrast
Ratio » 250 cd/m? Brightness

» 178°/178° Viewing Angles » 5 ms GtG Response Time

» 16.7 Million Colors

(L634UM59P)

339.99

") Predator X34 34" 21:9 Curved G-SYNC
IPS Gaming Monitor

» 34" In-Plane Switching

(IPS) Technology
» DisplayPort + HDMI Inputs
» 3440 x 1440 Resolution
»100,000,000:1 Dynamic

Contrast Ratio » 300 cd/m2
» 178°/178° Viewing Angles » 4 ms Response Time
» 1.07 Billion Colors » Integrated Speakers » G-Sync Technology

(ACX34BMIPHZ) 1,249.00

NEC PA272W-BK 27 LED
HDMI + (Mini) DisplayPort + DVI-D
» 2560 x 1440 Resolution

» 1,000:1 Contrast Ratio

» 340 cd/m? Brightness

» 178°/178° Viewing Angles
» 6 ms Response Time

» 1.07 Billion Color Support
» 14-bit Lookup Table

» 16:9 Aspect Ratio » Enhanced Color Gamut
(NEPA272WBK)

Call or Log-On

BenqQ, SW2700PT
27" Widescreen LED Backlit QHD Monitor

» In-Plane Switching (IPS) Technology
» DVI-DL/ HDMI 1.4/ DP 1.2 Inputs

» 2560 x 1440 Resolution

» 1000:1 Contrast Ratio

» 350 cd/m?2 Brightness

» 178°/178° Viewing Angles

» b ms (Gt6) Response Time

» 1.07 Billion Color Support

(BESW2700PT)




COMPUTERS

dropo. 5C
5-Bay USB 3.0 Type-C Enclosure
» 5x3.5" SATA NI/l Drive Bays
» 1x USB 3.0 Type-C Port
» BeyondRAID Technology
» Built-in SSD Helps During
a Power Loss » Rechargeable
Battery Helps Protect Data
» 120mm Variable-Speed Cooling Fan
» Adjustable LEDs » Drobo Dashboard
324.00

(DRDDR4A21)

Drive Dock
Dual Drive Bay Solution

» Two 2.5°/3.5" Drive Bays l

» Dual Thunderbolt 2 Ports

» Single USB 3.0 Type-B Port

» Independent Power Switches
» Simultaneous Operation

» Hot-Swappable Drives

» Windows and Mac Compatible

(OWTB2U3DKR?2) 267.50
‘HGST Deskstar
SATA Internal Hard Drive
» SATAIII 6 Gb/s Interface » 7200rpm » 3.5”
SKU Cache Capacity Price
HG0S04007 128MB 61B 244.99
HG0S04005 64MB 4TB 199.99

Seagate@ SATAlll
3.5” Internal HDD

» SATAIII 6 Gb/s Interface » 64MB Cache » 3.5" Form Factor

SKU Capacity Price
SEST6000DMO00 6TB 214.99
SEST4000DMO05 4TB 124.99

Seagate@ NAS SATA "I
3.5” Internal HDD (OEM)

» SATA I 6 Gb/s Interface » 7200rpm » 3.5”

SKU Cache Capacity Price
SESTB00ONEQD 256MB 8T8 369.99
SESTH000VNO1 128MB 5TB 251.90
SESTAT10VNT! 128MB 4TB 285.99
SEST1000VNOO 64MB 1TB 64.99

seagate(C" IronWolf NAS SATAIII

3.5” Internal HDD (OEM)

» SATAIIl 6 Gb/s Interface » 3.5” Internal

SKU Capacity Price

SEST10000V04 101B 399.99
SESTB000VN22 81B 269.99
SEST6000VN4T 6TB 209.959
SEST3000VNO7 31B 109.95

B:H 800-947-3308 + 212-444-6691

STORAGE ENCLOSURES & INTERNAL NAS DRIVES

dl'ObO, 5N2 5-Bay NAS Enclosure

» 5 x3.5" SATA I1I/Il Drive Bays

» 1xmSATA SSD Drive Bay

» 7 x Gigabit Ethernet Parts

» Adaptive Link Bonding

» BeyondRAID Technology

» Rechargeable Battery Helps
Protect Data

» Drobo Disaster Recovery

» myDrobo Platform

Enclosure Only (DRDS5A21)

499.00

n) newertechnology: Voyager S3
USB 3.0 Dock for 2.5”/3.5”
SATA I/1lI/1l HDD

» .57/ 3.5" SATA Drives up to 4TB

» Also Supports SSD Drives

» USB 3.0 Connector, Cable Included

» For Mac, PC, and Linux

» Windows XP 64-bit Required for 2TB+

(NENWTU3S3HD) 29.00

CZ3 Red
3.5” Internal NAS H

DESKSTAR'NAS

DD

» SATA Il 6 Gb/s Interface » 64MB Cache » 3.5”

dropo. 5Dt Thunderbolt 2 Enclosure

» 5x3.5" SATAHlI/II Drive Bays
» 7 Thunderbolt 2 Ports
» 1xUSB 3.0 Port
» Drobo Accelerator Bay
» BeyondRAID Technology
» Rechargeable Battery
Helps Protect Data » Variable-Speed Cooling Fan
» Adjustable LEDs » Includes Thunderbolt 2 & USB 3.0 Cables
» Windows & Mac Compatible
Enclosure Only (DRDR5A21T)

872.00

AKGTi2 SK-3501U3

External Hard Drive Enclosure

» Supports 3.5” SATA Hard Drives

» USB 3.0 Port

» USB 3.0 Cable Included

» Aluminum Casing

» Windows and Mac
Compatible

[AKSM3U3JSAKT) 34.99

SKU Capacity Price
WEWDSOEFRX 818 319.99
WEWD6OEFRX 618 223.99
WEWDAOEFRX 1B 139.99
WEWD20EFRX 18 89.00
WEWD10JFCX 178 72.99

CZ3 RedPro

» 7200rpm » 3.6”

7200 rpm SATA 1l 3.5” Internal NAS HDD
» SATA Il 6 Gb/s Interface » 128MB Cache (64MB w/ 1TB)

l

SKU Capacity Price
WEWDB001FFWX 818 399.00
WEWD6002FFWX 61B 274.90
WED4002FFWX 4TB 214.99
WEWD2002FFSX 218 139.99
i
CZ2 Blue
» SATAIII 6 Gb/s Interface » 64MB Cache » 7200rpm » 3.5
SKU Capacity Price
WEIDDM4 4TB 129.99
WEWDIOEZRZ | 118 | 50.49 _
[z Black
e 7 » SATAIII 6 Gb/s Interface » 64MB Cache » 7200rpm » 3.5
= = SKU Capacity Price
WEIDDP4 4TB Call or Log-On
el WEIDDP2 218 Callor Log-On
WEIDDP1 118 Call or Log-On




I

» SATAIIl 6 Gb/s Interface
» 3D V-NAND flash memory
» 257 (Tmm)

SanJisk

» SATAIII 6 Gb/s Interface
» 15006 Shock Resistance
» Low Latency
» 25" (Tmm)

crucial

ngston

NOLOGY

KTECH

» SATAIII 6 Gb/s Interface
» 25" (Tmm)

PNY
» SATAIII 6 Gb/s Interface
» 25" (Tmm)

@ m
i ADATA

%

& Transcend’

SISV COMPUTERS )
Speed 218 178 51268 25668
850 Pro Read 550 MB/s SAMZTKE2TOBW SAMZTKETTOBW SAMZTKES12BW SAMITKEZ56BW
Write 520 MB/s - 864.00 448.99 238.99 137.99
Speed 4TB AL} 118 50068 25068
850 EVO Read 540 MBs SAMZ75EATOBA SAMIT5EZT0BA SAMZ75ETTOBA SAMZ75E500BA SAMZT5E250BA
Write 520 MBs 1,409.00 650.38 324.99 171.92 99.99
Speed 3.84TB 1.92TB 4806B 2406B
SM863a Read 540 MBs SAMZ7LM3TBE SAMZTLMITIHC SAMZTKMABONE
Write 480 MB/s 1,999.95 849.95 - 351.95 -
960GB 480GB
Wite 515 MB/s 399.00 219.00
9606B 480GB 2406B
SSD Plus Read 530 MB/s _ _ SASSDP240626 SASSDP120626
Write 540 MB/s 79.00 49.00
Speed 960GB 480GB 2406B 1286B
Ultra ll Read 550 MB/s SADSSDHII980 SADSSDHII480 SADSSDHIZ40
Wite 500 MB/s 289.00 169.99 89.84 B
MX300 Read 530 MB/s CR2060MX300S CR1050MX300S CRH25MX300S1 CR275MX300SS
Write 510 MB/s 549.99 279.99 149.99 94.99
V300 Read 450 MB/s KISV30037A48 KISV30037A24 KISV30037A12
Write 450 MB/s 159.00 90.99 59.00
HyperX Salvage Read 560 MB/s KISHSS37A960 KISHSS37A480 KISHSS37A240
Write 530 MB/s 324.99 174.99 109.99
Speed 960GB 4806B 2406B 12068
UV400 Read 550 MB/s KISUV400S3B7 KISUV400480 KISUVA00240 KISUV400120
Write 500 MB/s 310.75 154.99 81.99 52.00
Speed 178 51268 256GB
KC400 Read 550 MB/s KIS400538512 KIS40053B256
Wiite 530 MB/s - 21295 134.95 -
Speed 9606B 4806B 2406B 12068
Cs1311 Read 550 MB/s PNSSD7CS1396 PNSSD7CS1348 PNSSD7CS1324 _
Wite 520 MB/s 299.99 189.00 89.99
cs2am Read 560 MB/s PNSSD7CS2296 _ PNSSD7CS2224 _
Write 470 MB/s 289.99 99.99
Speed 178 50068 2506B
Blue Read 545 MBs WEWDS100T1B0 WEWDS50061B0 WEWDS25061B0 _
Write 525 MB/s 299.00 142.99 89.99
Speed 178 51268 25668 1286B
SUs00 Read 550 MB/s ADASUB001TB ADASUB00512C ADASUS00256C ADASUS00128C
Wite 520 MB/s 349.00 189.99 99.99 59.00
Speed 178 51268 25668 1286B
SSD370 Read 560 MB/s TRTSTTSSD370 TRTS51258370 TRTS26655370 TRTS12855370
Write 460 MB/s 514.95 236.50 133.95 64.67
o Speed 118 4806B 2406B 12068
BilEnE D Re?d 559 MBs OWCSD7P66960 OWMEP7480 OWMEP7240 OWMEPT120
Write 527 MB/s 398.75 258.75 157.50 87.50
o
crucial

960 Evo NVMeM.2 960 PROM.2 850 Evo M.2 850 Evo mSATA MX300
118 SAMZVGETTOBW  479.99 AL SAMZV6PZTOBW  1,297.99 118 SAMINSETTOBW  329.99 178 SAMZMSETTOBW ~ 333.99 118 CR1050MX300M 279.99
500GB  SAMIVOESOOBW  249.99 118 SAMIVGPTTOBW  629.95 500GB  SAMZNGESOOBW  167.99 500GB  SAMIMBES00BW  167.99 52568 CRH25MX300M2 149.99
2506B  SAMZV6EZ60BW 129.99 5126B  SAMIV6PHIZBW  329.99 2506B  SAMZNGEZ50BW 97.99 2506B  SAMZM5EZ50BW 97.99 27568 CR275MX300M2 90.21

www.BandH.com BSH



COMPUTERS

CZ MyBook Duo
External RAID Storage

» External RAID Storage

» Two USB 3.0 Ports

» Formatted in NTFS for Windows

» Max. Data Transfer Rate: 290 MB/s
» 256-Bit AES Encryption

» RAID 0, 1, and JBOD Configurations
» Includes WD Drive Utilities » User Serviceable Enclosure

4TB (WEWDBLWE0D40) ... 249.00  8TB (WEWDBLWEQ080) ... 319.00
6TB (WEWDBLWED060) .......279.00  12TB (WEWDBLWED120) ....399.00

G-RAID

crmeeee THUNderbolt 2 RAID Array
» Two 3.5" Drive Bays =
» 2 x Thunderbolt 2, 1 x USB

3.0 Ports » RAIDO, 1, and JBOD
» Preconfigured in RAID 0
» Hardware RAID Controller i
» Data Transfer Speeds up to 480 MB/s

8TB (6T0604085) S 599.95
12TB (670604093)
16TB (670604097)

FROMISE P2M4HDAUS 4TB Pegasus2
RAID Desktop Storage Enclosure
» 4TB Raw Storage Capacity

» Includes 4 x 1TB 2.5" Hard Drives
» RAIDO, 1,5, 6, and 10 Support

» 2 x Thunderbolt 2 Ports

» Hot-Swappable Drive Bays

» Built-In Promise Utility

4TB (PRP2MAHDAUS)

8TB (PRPZR4HDBLS)
12TB (PRPZRAHDTZUS) ...

Call or Log-On

1,174.00
c1,325.00

@D ?hig Thunderbolt 2
Series 2-Bay RAID

» Max. Data Transfer Rates of 360 MB/s
» Dual Thunderbolt 2 Ports

» Preconfigured HFS+ RAID 0

» RAID0/ 1/ JBOD Compatible

» Easy RAID Selection Button

61B (LAZBIGOTBT2)
8TB (LAZBIGTBTZ)

» 2x3.5" Drive Bays

» USB 3.0, FireWire 800,
and eSATA Ports

» RAID 0 and 1 Support

» Pre-Configured as RAID 0

» Hardware Controller

» Data Transfer Speeds up to 360 MB/s

61B (6LSR6000)................379.95
2TB (6LSR2000)................ 269.95 8TB (GLSRB000)...............479.95
4TB (GLSRA000)............... 329.95 10TB (GLSR10000)............629.95

RAID

EZ1 MyBook Pro Two-Bay
Thunderbolt 2 RAID Array
» Two Hot-Swappable Drive Bays
» Thunderbolt 2 & USB 3.0 Interfaces
» Supports RAID 0, 1, and JBOD
» Hardware Configured in RAID 0
» Max. Data Transfer Rate: 350 MB/s
» Formatted in HFS+
Journaled for Mac 0S X

16TB (WEWDBDTB16JS).....999.00  8TB (WEWDBDTBBJSL....... Log-On
12TB (WEWDBDTB12JS).....799.00  6TB (WEWDBDTB6JSL....... 549.00

G-RAID storage System

s With Removable Drives
» 1xUSB 3.0 Port » 1xeSATA Port
» 2 x FireWire 800 Ports
» T200RPM Drive Speed
» Configurable RAID 0/1 and JBOD
» Aluminum Enclosure with

Smart Fan » Mac and Windows Compatible
» USB, eSATA and FireWire Cables Included

4TB (6T0603240)..
1278 (6T0603411)

349.95
699.95

FROMISE P2R6HD12US 12TB Pegasus2 Ré
Thunderbolt 2 RAID Storage Array

» Includes 6 x 2TB SATA HDDs =
» 12TB Storage Capacity

» 2 x Thunderbolt 2 Parts

» 6 Hot-Swappable Drive Bays

» Pre-Configured in RAID 5 Mode

» Supports RAID 0, 1,5, 6, 10, 50

» Compatible with Time Machine in 0S X

12TB (PRPZRSHD12US)
18TB (PRPZREHD18US)

1,880.00
2,349.00

@ 6hig Thunderbolt 3
6-Bay RAID Array

» 6 x 4TB Enterprise-Class 3.5" HDDs
» Six Hot-Swappable Drive Bays

» 2 x Thunderbolt 3, 1 x USB 3.1

» 0/1/5/6/10/50 RAID Support

» Up to 1400 MB/s Reads and Writes

24TB (LAGBIG24TBT3) 2,999.00

36TB (LAGBIG36TBT3) 3,999.00

L8TB (LAGBIGABTBT3) 4,999.00

60TB (LAGBIGAOTBT3) 6,999.00
== ThunderBay 4

Hard Drive Array

» SATA I (6 Gb/s) Interface » 7200 rpm,
32MB Cache » 2 x Thunderbolt 2 Ports

» Supports RAID via SoftRAID 5 Software

» Read Speed: up to 914 MB/s

» Write Speed: up to 680 MB/s

» Preformatted in RAID 5 16TB (OWTB4TB216)......1,197.50

4TB (OWTBATB4)............ 729.50 20TB (OWTB418220)..... 1,347.50
8TB (OWTB4TBZS).............877.50  24TB (OWT424) 1,647.50
12TB (OWTB4TB212)......... 977.50 32TB (OWT437)........... 2,297.50

@ 6TB G-RAID Studio Thunderbolt 2
e EXternal Storage System

» 6TB Total Storage Capacity |
» Contains Two 3TB Drives

» 330 MB/s Transfer Rate

» 7200 rpm Drive Speed

» Supports RAID 0, 1, and JBOD
» 2 x Thunderbolt 2 Ports

» Supports 2K and Compressed 4K Video G
» Preformatted for Windows

61B (6T604418)

Call or Log-on

] G-RAID 61 Removable Dual-Drive Array
cremee + Thunderbolt
» 8T8 Capacity » 2x4TB 3.5"
SATA Il Hard Drives
» 7200 rpm > USB 3.0 Interface/

USB 2.0 Compatible
» Data Transfer Speeds up

to 400 MB/s » RAIDO, 1, and JBOD
8TB (6T0604069) 529.95
1278 (6T0604077) i 129.95
16TB (6T0604081) . 949.95

@ G-SPEED Shuttle XL s-Bay
e THUNderbolt 2 RAID Array
» 6 x 4TB 3.5" Enterprise-Class HDDs

» Six 3.5" SATA Drive Bays

» Two Evolution (ev) Series Drive Bays

» 2 x Thunderbolt 2 Ports

» Supports RAID 0, 1,5, 6, and 10

» Hardware RAID Controller

24TB (GTGSSKLTZ241) ...2,899.95
36TB (6T6SSKLTZ36T) ...3,599.95
4BTB (6TGSSKLT248T) .4,799.95

@D 6big Thunderbolt 3
6-Bay RAID Array

» 12 x 4TB 3.5" 7200 rpm Hard Drives

» 12 % 3.5" SATA Drive Bays

» Thunderbolt 3 & USB 3.1 Interfaces

» RAIDO0,1,5,6,10,50 » Hardware Controller
» Reads up to 2600 MB/s via Thunderbolt 3

1278 (LA812BIGT3) 5,999.00
T2TB (LAT21ZBIGT) e 1,999.00
96TB (LAIB1ZBIGT) .. 9,9 98,95
120TB (LA12B16120) 13,999.00

SONY PSZ-RATHUNDERBOLT 2
Portable RAID Array

» 7 3TB 3.5 Hard Drives

» Two Drive Bays » Thunderbolt 2
and USB 3.0 Interfaces

» Preconfigured in RAID 0

» RAID 0, 1, and JBOD

» Hardware Controller » Transfer Speeds of up to 440 MB/s

» Shock-Resistance Design » Built-In Handle

4TB (SOPSZRA4TBO)

6TB (SOPSZRA6TBA) ..o

469.00
. 946,83

800-947-3308 - 212-444-6691




CZ My _Cloud

» Gigabit Ethernet and USB 3.0

» Dual-Core Processor

» DLNA 1.5 and UPnP Certified

» Free Desktop and Mobile Apps

» Auto Network Discovery

» Windows and Mac Compatible -

2TB (WEWDBCTLO0Z0) ...
4TB (WEWDBCTLO040)
6TB (WEWDBCTLOOBD) ..

CZ My Cloud PR2100
» 1.6 GHz Intel Pentium N3710 (Quad-Core
» 4GB of Onboard DDR3L RAM
» 1 x Gigabit Ethernet Ports
» 2xUSB 3.0 Parts » RAIDO, 1,

and JBOD » Built-in Video Transcoding
» AES 256-Bit Volume Encryption

4TB (WEWDBBCLOOAD) ..
BTB (WEWDBBCLOOBO) ...
12TB (WEWDBBCL0120)

T6TB (WEWDBBCLOTO0) ...

logy" DiskStation DS216+lI
2-Bay NAS Enclosure
» 2% 3.5°/2.5" SATA NIl Drive Bays
» 1.6 GHz Intel Celeron N3060 Dual-Core
» 16B of DDR3RAM » RAID 0, 1, & JBOD
» 1 x Gigabit Ethernet Port
» USB 3.0, USB 2.0, and eSATA Ports
» Read & Write Speeds: over 111.78 MB/s
» Encrypted Data Speeds: over 113.01 MB/s
» AES-NI Hardware Encryption Engine
(SYDS216PI)

dI‘ObO, 5N 5-Bay Desktop HD
NAS Enclosure

» Holds 5x 3.5” SATA HDDs (not included)
» Holds 1x mSATA SSD (not included)

» Gigabit Ethernet Port, Cable Included

» Mixed Drive Size Utilization

» Thin Provisioning » Hot Swappable

» BeyondRAID Features

Enclosure Only (DRDRDS4A21)

QNRAP T5-451+ 4-Bay Home and
SOHO NAS Server

» 2.0 GHz Intel Celeron
Quad-Core

» 26B of DDR3L RAM
(also available w/ 8GB)

» 7 x Gigabit Ethernet Ports

» 2xUSB3.0&2xUSB 2.0 Ports

Enclosure Only (QNTS45126)

y

_..Callor Log-On
Call or Log-On
..Call or Log-On

.599.99
_..Callor Log-On

Call or Log-On
899.99

299.99

479.00

449.00

NAS DRIVES

CZ My Cloud Mirror (Gen 2)

» 1.3 GHz Dual-Core Processor

» 512MB of RAM » 1x Gigabit Ethernet Port
» 2% USB 3.0 Ports

» Preconfigured in RAID 1

» Centralized, Dual Drive Storage l ' y
» Remote Access from PC/Tablet/Smartphone - 7
» Windows/Mac/i0S/Android Compatible

LTB (WEWDBWVZ0040) ... 299,00
6TB (WEWDBWVZ0060) 349.00
8TB (WEWDBWVZ0080) ... 399.00
CZ My Cloud PR4100
» 1.6 GHz Intel Pentium

N3710 Quad-Core
» 4GB of Onboard DDR3L RAM
» 2 x Gigabit Ethernet Ports
» 3% USB 3.0 Ports
» RAIDO,1,5,10, and JBOD
8TB (WEPR410008) .o 799.00
16TB (WEPRA10016) ... Call oF Log-On
24TB (WEPRA10024) 1,399.00
32TB (WEPRA10032) ... Call or Log-On

logy" DiskStation DS916+
» 1.6 GHz Intel Pentium
N3710 Quad-Core
» Read Speeds: over 225 MB/s » Write Speeds: over 209 MB/s
» AES-NI Hardware Encryption Engine

4-Bay NAS Enclosure -
» 2 x Gigabit Ethernet Ports
Enclosure Only with 8GB (SYDS916868) 599.00

» 4x3.57/2.5" SATA Il Drive Bays
» 3% USB 3.0, 1x eSATA Ports » RAIDO, 1,5, 6,10, & JBOD
Enclosure Only with 2GB (SYDS916268) ............................. 549.00

dropo. B810i 8-Bay iSCSI SAN Enclosure

» 8x3.5" SATA Drive Bays

» iSCSI SAN Enclosure

» 3 x Gigabit Ethernet Ports

» BeyondRAID Technology

» Hybrid Storage & Data-Aware Tiering

» Drobo Dashboard

» Smart Volumes & Thin Provisioning » Microsoft Multipath 1/0
(MPI0) » No Tools Needed for 2.5" Drive Carriers

Enclosure Only (DRBB10I3AZT)......ococe.1,699.00

QNRAPTS-251+ 2-Bay Home and
SOHO NAS Enclosure

» 2.0 GHz Intel Celeron Quad-Core
» 26B of DDR3L RAM (also

available w/ 86B+) » 2 x Gigabit 3
Ethernet Ports » 2xUSB 3.0 & °
2x USB 2.0 Ports o
» RAID 0,1, and JBOD
Enclosure Only (ONTS25126) 329.99

COMPUTERS

CZ) My Cloud EX2 Ultra

» 1.3 GHz CPU

» |deal for Prosumers and Creative
professionals » DLNA 1.5 & UPnP
certified for media streaming

» SCSI, volume virtualization FTP, File,
Backup & P2P server

16TB (WEWDBVBZ160) ...

12TB (WEWDBVBZ120) ...

8TB (WEWDBVBZ80)

ATB (WEWDBVBZAD) ..o

. 807.99

.......Callor Log-On

_.....Callor Log-On
Call or Log-On
. 349.99

CZ My Cloud PR4100
» §TB Storage Capacity
» 4 x 2TB Hard Drives
» 1.6 GHz Intel Pentium
N3710 Quad-Core
» 4GB of Onboard DDR3L RAM
» 1 x Gigabit Ethernet Ports
» 3x USB 3.0 Ports
» RAIDO, 1,5,10, and JBOD
» Gold Plated RJ-45 Connectors

BTB (WEPRAT0008Q) ...

logy DiskStation DS216j

2-Bay NAS Enclosure
» 2% 3.5/2.5" SATA Il Drive Bays
» 1.0 GHz Marvell Armada

385 Dual-Core » 512MB DDR3 RAM
» 1 x Gigabit Ethernet Port » 2 x USB

3.0 Ports » RAIDO, 1, Basic, Hybrid, & JBOD
» Over 112.75 MB/s Read, 97.6 MB/s Write
» DLNA-Certified Media Server » Synology DiskStation

Manager (DSM) » Cross-Platform File Sharing
Enclosure Only (SYDS216J) ... 169,99

s)’na}ngv

@ G-Rack 12 12-Bay
e SAS NAS Expansion Chassis

» 12 x 4TB 3.5" Hard Drives » 12 x Drive Bays
» 1 x Mini-SAS Interface » Dual 740W Power Supplies

4BTB (6T060926).......oo. 11,599.95
72TB (6T0604925) 12,599.95
96TB (6T0604926) 14,599.95

QNRAP TVS-871T 8-Bay Thunderbolt 2
Turbo VNAS

» 8x3.5"/2.5" Hot-Swappable
Drive Bays » Thunderbolt 2/
USB 3.0/ USB 2.0

» RAID0,1,5,6,10

» 3.0 GHz Intel Core i5-4590S
Quad-Core » 1668 of DDR3 RAM

» 2% 10GbE & 4 x 1GbE Ports » iSCSI SAN Block-based Mode

Enclosure Only (QNTVS871T15) 2,684.69

L8TB (ONTVSB71586). oo o, TH3. T

www.BandH.com BSH



COMPUTERS

2 4TB My Passport Ultra
Metal Edition (Blue/Black)

» 4TB Storage Capacity

» USB 3.0 Interface

» Bus-Powered

» Up to 5 6b/s USB 3.0 Transfer Rate

» Windows / Mac Compatible

» Password Protection / 256-Bit Encryption
» Requires Reformat for Use with Mac

4TB (WEBEZW040BBA) 139.00

@ G-DRIVE mobile usB 3.0 Type-C

GTechnoloav

» 118 Storage Capacity

» USB 3.0 Type-C Interface » 7200 rpm

» Up to 136 MB/s Data Transfer Speed

» Bus Powered » Includes USB 3.0 Type-C Cable
» Includes USB 3.0 Type-C to Type-A Cable

» Time Machine Compatible

» Preformatted for Mac 0S 10.9

1TB (6T0604876)

USB 3.0 External Hard Drive

» J1B Storage Capacity .
» 802.11ac Wi-Fi, USB 3.0 Connectivity

» Up to 10 Hours of Battery Life

» Charge Mobile Devices » USB 2.0 Port » Formatted in ExFAT
2TB (WEMPPW2TB) Call or Log-On

External Hard Drive ]
99.95

» SD Media Card Slot » Simultaneously
3TB (WEWDBSMT0030) Call or Log-On

TOSHIBA My Passport Wireless Pro
Streams up to 8 HD Videos
4TB (WEWDBSMT0040) 229.99

@< Rugged Thunderbolt

Portable External HD

» SATA 6 Gb/s Interface

» 1xUSB 3.0 Port

» 1 Integrated
Thunderbolt Cable

» AES 256-bit Encryption '

» Bus Powered
» Shock, Dust, Water Resistant

At

1TB HDD (LASTEV100040) ..149.99
500TB SSD (LASTEZ50040) 349.90  2TB HDD (LASTEV200040)..199.99

Sandisk' Extreme 510
USB 3.0 External SSD

» 480GB Storage Capacity

» Sequential Read Speed up to 430 MB/’
» Sequential Write Speed up to 400 MB/s

» USB 3.0 Interface

» Bus Powered » 128-hit AES Encryption

» Rugged Rubber Bumper » Water, Dust, & Shack Resistant
» Vibration Resistant » Windows & Mac Compatible

(SASDSSDEXTWA) 249.99

PORTABLE HARD DRIVES

CZ= My Passport USB 3.0
Secure Portable Hard Drive
» USB 3.0 Interface; USB 2.0 Compatible
» Bus Powered » Data Protection

with Hardware Encryption
» USB 3.0 Cable Included
» Includes WD Backup Software
1TB (WEMP1WDBYNB)

Call or Log-On

2TB (WEMP2WDBYFB) 84.99
3TB (WEMP3WDBYFB) 109.00
4TB (WEMP4WDBYFB) 119.00

G-Drive
e MObIle Hard Drive with Thunderbolt
» 7200 rpm Speed
» Transfer Rates up to 136 MB/s
» Bus Powered via Thunderbolt/USB

» Time Machine Compatible 7
» USB 3.0.and Thunderbolt ~ ©
Cables Included 2
» Preformatted HFS+ for Mac
1TB (6T0603040) 189.95

seagate (C) Backup Plus Slim Portable

External USB 3.0 Hard Drive

» USB 3.0 Port

» Max. Sustained Read/Write
Speed: 100MB/s

» b400rpm Disk Speed

» Seagate Dashboard for Automatic
Backup » Pre-Loaded NTFS
Driver for Mac » Free Seagate Mabile Backup App Available

1TB (SESTDR1000B) 59.99
2TB (SESTDR200018) 79.99

@& Rugged Mini Mini Portable Hard Drive

» USB 3.0 Interface

» 5400 RPM Speed

» Transfer Rate Up to 5Gb/s

» 47.2" Maximum Drop Height
» LaCie Private-Public Seftware
» Automatic Backup

» 106B of Wuala Online Storage

1TB (LARMNU31) 99.99
2TB (LARMDZ) 139.99
4TB (LARMD4) 199.99

USB 3.1 Type-C External SSD

» 11B Storage Capacity

» USB 3.1 Type-C Connectivity

» Up to 480 MB/s Data Transfer
Speeds » Rugged Design

» Two Types of USB Cables Included

» Preformatted for Mac » Windows Compatible with Reformatting

2756B (6LA2506R) 159.95
5256B (6LAS00GR) 249.95
1TB (GLAT000GR) 439.95

@ G-DRIVE 61 Portable Hard Drive

o With Gobbler Software

» USB 3.0 Port » Data Transfer Rate up to 165 MB/s
» AC Powered » 7200 rpm
» Aluminum Enclosure

» Apple Time Machine

Compatible
» Preformatted HFS+ for Mac
4TB (6T0603594) Call or Log-On
8TB (6T0603906) 279.95
TOTB (6T0605016) .. 599.95

@ G-DRIVE evRaW Portable Hard Drive
e With Rugged Bumper

» USB 3.0 and SATA Interfaces

» 7200 rpm > Shock Resistant
upto 4.9 /1.5m » USB3.0
Transfer Speeds up to 5 Gb/s

» Rugged and Lightweight

» Includes a Removable Bumper

» Designed for On-the-Go Access

» Formatted for Mac

1TB (GTGDEVRAW1)

99.95

seagate (C" Expansion Portable
USB 3.0 External Hard Drive
» USB 3.0 Connectivity

» Bus Powered

» Plug-and-Play Compatible

» USB 3.0 Cable Included

» Preformatted for Windows

1TB (SESTEA100040)
2TB (SESTEA200040)
4TB (SESTEA400040)

@& Porsche Design Mobile Drive

» USB 3.1 Type C Interface

» 5 Gb/s Max. Theoretical
Bus Speed

» AU-Aluminum Enclosure

» Minimalist Parsche Design

1TB (LAP3.1CT1) 82.00
21B (LAP3.1CT2) 112.00
4TB (LAP3.1CT4) 169.99

USB 3.1 Type-C External Rugged Mobile HD

» USB-C Connectivity
» Up to 140 MB/s Transfer Rate

» Bus-Powered
» Fan-less Design

500GB (GLBBPLE0O) ... 99.95
1TB (GLBBPL1000) 119.95
2TB (6LBBPL2000) 169.00

800-947-3308 - 212-444-6691




uss FLASH DRIVES [N )
Sanisk
Cruzer Glide CZ43 Ultra Fit Ultra Ultra Dual Ultra Flair Extreme Go Connect USB 2.0 Wireless
S ) ‘D [ D v
USB 2.0 USB 3.0 USB 3.0 USB 3.0/ Micro-USB USB 3.0 USB 3.0 USB 2.0/ 802.11n Wireless
Retractable USB Connector Cap Design Capless USB Slider Design Capless USB Slider Design
868 (SACCZ608GB)........6.30 | 1668 (SACZ43160B).......8.95 | 1668 (SAUUD16GB)......10.95 | 3268 (SADD3326).....16.32 | 1668 (SAUFU3FD16GB)......9.00 - 3268 (SACWLMD32GB)...27.99
368 (SACCZ60326B).......12.95 | 326B (SACZ433268)....11.95 | 3268 (SAUUD32GB)...14.95 | 6468 (SADD3646)... 25.04 | 326B  (SAUFU3FD32GB)....13.95 - 6468 (SACWLMDE4GB)....39.95
0468 [SACCZ60646B).....19.95 | 6468 SACZ43646B)....18.95 | 646B (SAUUD64GB)......19.99 | 12668 (SADD31286)...43.55 | 646B  (SAUFU3FD64GB)....19.95 | 646B  (SACZB0064GB).....34.95| 12868 (SACWLFD1286B)...78.95
- 12868 (SACZ431286B)....32.95 | 12668 (SAUUD12868).... 32.95 - 12868 (SAUFU3FDI1266)...32.95| 12868 (SACZ8001266B).... 59.95 | 20068 (SACWLFD2006B)....99.99
- - 15668 (SAUUDZ566B).... 64.99 - - - -
Personal Drives Encrypted Drives
DataTraveler SE9 DataTraveler | G4 DataTraveler 100 63 DataTraveler SE9 62 DataTraveler microDuo DataTraveler Vault Privacy HyperX Savage
i - R N -
USB 2.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0/USB micro USB 3.0 USB 3.0
Capless Design Protection Cap Capless USB Slider Design Capless Design Rotating Cap 256-Bit Advanced Encryption Multi-Platform Compatibility
- - - Durable Metal Casing - Complex Password Protection -
- - - - 1668 (KIDTDUO316GB).....9.99 | 4B (KIDTVP304GB)....... 27.50 | 64GB (KIHXS364GB)......43.95
1668 (KIDTSE916).... 1668 (KIDTIG416GB)....... 6.60 | 1668 (KIDT10063166)........6.95 | 166B (KIDTSE962166).......8.95 | 3268 (KIDTDU03326B)....15.95 | 8GB (KIDTVP308GB).......39.95 | 12868 (KIHXS31286B)......79.95
3268 (KIDTSE93D) 3068 (KIDTIG326B)....... 1351|3268 (KIDT10063326).......12.95 | 326B (KIDTSE962326).....15.60 | 6468 (KIDTDUO3646B)....28.18 | 3268 (KIDTVP30326B)....89.95 | 25668 (KIHXS32566B)....132.25
- - 0468 (KIDT10063646).....24.95 | 64B (KIDTSE9G2646)..... 25.95 - 046B (KIDTVP30646B)... 175.95 | 5126B (KIHXS351268)....239.99
- - - 12866 (KIDTSE962128)....49.50 - - -
S PEhusuncd &) Transcend"
Blaze B30 FIT Drive JetFlash 820 JetFlash 810 JetFlash 790 JetFlash 700
o | i S = @D 2GRS
i v \ 1o y
USB 3.0 USB 2.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0
Fou';-gNt:gnl’goEiot‘ilgrr]ing Waterproof to 326° Removable Cap Removable Cap Capless Design / Slide-Out Port LED Indicator
- - Aluminum Body Shock/Splash/Moisture/Dust-Resistant Available in Black or White -

368 (SIUFDB303Z6B).....14.95

3168 [SAMUF32BBAM)...12.95

868 (TRJFB20GHGH)........9.94

868 (TRJF81086B)........9.52

868 (TRJF7908GB).......... 199

868 (TRJF7008GB)..... 6.50

8468 (SIUFDB3064GB).....26.95

8468 (SAMUFo4BBAM)....18.99

1668 (TRJFB20616GB)....11.99

1668 (TRJF810166B).....11.99

166B (TRJF790166BW).... 8.99

1668 (TRJF700166B).......10.99

12668 [SAMUF128BBAM).39.95

368 (TRJFB206326B)....18.99

3168 (TRJF8103268).....19.99

3268 (TRJF790326B).......Log-On

3268 (TRJF700326B).......15.00

6468 (TRJFB20684GB).... Log-On

0468 (TRJF810646B).....34.99

6468 (TRJF79064GBW)....29.99

6468 (TRIF70044GB)......28.68

12868 [TRUF79012668)..59.99

Lexar PNY Y Verbatim
JumpDrive S75 JumpDrive P20 Turbo Eilite 3.0 Pro Eilite 3.0 USB 2.0 Flash Drive Store ‘n’ Go V3
USB 3.0 USB 3.0 USB 3.0 USB 3.0 USB 2.0 USB 3.0
Retractable Connector Meta#ﬂt[lge/ f?ﬁfsiwnh Sliding Collar Capless Slider Design Relractable USB Connector

Available in Multipte Colors

1668 (LELJDS75166B)......7.95

3168 (LELJDP20326B)... 25.95

3268 (PNTEU3FD32GB)....11.99

12668 (PNPEU3PFD128)....49.28

268 (VEUDZGB).............. 5.99

868 (VE3SNGBGBB).........6.50

368 (LELIDS75326B).....13.50

6468 (LELJDP20646B).... 41.49

846 (PNTEU3FD44GB)....17.60

15668 (PNPEU3PFD256)...96.80

468 (VEUD4GB).............5.97

1668 [VE3SNG14GBBL).....8.15

6468 (LELJDST5646B).....23.50

12868 (LELJOP201286)..69.95

12868 (PNTEU3FD1286)..39.99

51268 (PNPEU3PFD512)..180.26

868 (VEUD8GB).... .95

368 (VE3SNG326BB)....12.13

12868 (LELIDST5126).....39.95

15668 (PNTEU3FDZ566)..57.99

1668 (VEUD14GB)............ 6.56

6468 (VE3SNG64GBB).....19.52

15668 (LELIDST525¢).....79.95

3168 (VEUD3ZGB)......... 9.44

12868 (VE3SNG1266BB)..53.23

8468 (VEUFD44GBBL.....21.91
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COMPUTERS

Motherboards
B&H carries Motherboards that support 4th and 5th generation Intel processors in the LGA1150 socket and AMD models that support 970 and
SB950 chipsets that deliver CPU power, integrated graphics, RAID support, built-in surround sound and a wide selection of PCle slots and 1/0

ports for the user looking to custom build their ideal gaming system.

MOTHERBOARDS, CPUS AND COOLING SYSTEMS

\ A A Al LA NN

Asus Asus Gigabyte Asus Gigabyte

Model Republic of Samers St - Republic ofamers 770w Mortar | Gaming Pro Carbon |~ 6A-2270-HO3P 07 1270 Gaming M5 HI1OM ECO GA-HON

Form Factor ATX Mini-ITX Micro-ATX ATX ATX ATX ATX Micro-ATX Mini-ITX

Chipset Intel 2270 Intel 2270 Intel 2270 Intel 2270 Intel 2270 Intel 2270 Intel 2270 Intel H110 Intel H97

CPU Socket LGA 1151 LGA 1151 LGA 1151 LGA 1151 LGA 1151 L6A 1151 LGA 1150 LGA 1150 LGA 1150
Memory Support DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR3
Maximum Memory 646B 646B 646B 646B 3268 646B 646B 3268 166B

RAID 0,1,5,10 0,1,5,10 0,1,5,10 0,1,5,10 None 0.1,5,10 0,1,510 None 0,1,510

CrossFire / SLI CrossFire and SLI CrossFire and SLI CrossFire and SLI CrossFire and SLI None CrossFire and SLI CrossFire and SLI None CrossFire

SKU ASRGSTRXZ27E ASNTELGA1151 MSZ270MMORTR MSZ2701GPCAR GIGAZ270HD3P ASPRIMEZ270A MSZ270GM5 MSHT10MECO GIGAH97NWIFI
Price 189.99 178.90 119.99 164.99 129.99 159.99 189.99 58.99 112.00
AMD Motherboards CPUs

m Ay

B&H carries over 225 different CPUs
including the latest Kaby Lake and AMD
Ryzen lines, supporting LGAT150, AM4 and

Asus Asus Asus
many other CPU socket types.
Model RoG Crosshair VI Hero B350M Tomahawk B350M Gammg Pro PRIME B350-PLUS PRIME B350M-A/CSM
Form Factor ATX ATX Micro-ATX ATX Micro-ATX
Chipset AMD X370 AMD B350 AMD B350 AMD B350 AMD B350
CPU Socket AM4 AM4 AM4 AM4 AM4
Memory Support DDRé4 DDR4 DDR4 DDRé4 DDRé4
Maximum Memory 646B 646B 3268 646B 646B
RAID 0.1,10 01,10 0.1,10 0,1,10 0.1,10
CrossFire / SLI CrossFire and SLI None None CrossFire None
SKU ASCHVTHERD MSB350TMHAWK MSB350MGMPRO ASPRIMEB350P ASPRIMEB350
Price 254.99 109.99 79.99 99.99 89.99
CPU Liquid Coolers CPU Air Coolers

Ba- - me= @3 )

B ReS

NIXT Corsair Corsair Deepcool Thermaltake Cooler Master  Cooler Master Intel Thermaltake Zalman USA
Model Kraken X62 Hq%%ZDEif:;fnse Hydio H100iv2 | Captain 120 EX  Water 3.0 Extreme Model Hyper 21260 | Hyper T3 1154 Gravity i2 CNPS9500AT
Fan Speed 2800rpm 2400rpm 2435rpm 120rpm 2000rpm Fan Speed 2000rpm 2800rpm 3850rpm 1800rpm 2650rpm
Airflow 66.7 CFM 70 CFM 70 CEM 76 CEM 99 CFM Airflow 82 CFM 54 CFM 40 CFM 31 CFM NA
Sound 38 dBA 37 dBA 37 dBA 31 dba 20dba Sound 36dba 3bdba 40dba 21dba 27.5dba
SKU NZRLKRX6201 COHSH1151 COCW9060025 | DECPT20EXWHT | THCLWO0224B SKU CORR212E20R2 | CORR910HTX3G INBXTS15A THGI292MMCF  ZACNPS9500AT
Price 159.99 129.99 129.99 69.99 94.85 Price 29.99 22.99 29.99 12.99 33.95

r-‘lnte' C  {}ereEnx

rhe Bower

LED Strip Lights ﬁw NZXT. @ 7nermaitake

LED Lighting Kit allows enthusiasts to set up lighting inside their computer cases. Using sleeved wires paired with multiple LEDs, an LED kit allows
users to hide lights between side panels and under components, creating a red glow effect and set the mood with different available colors.

n B:H 800-947-3308 + 212-444-6691



POWER SUPPLIES AND COMPUTER CASES

Mid-Tower Cases w/ Windowed Side Panel

Gaming Cases

COMPUTE

NZXT Corsair Thremalake Deepcool Corsair Cooler Master NZXT Zalman
Model S340 Crystal 460X Core P3 SE Tesseract Model Carbide Series SPEC-02|  CM Storm Trooper Phantom 530 D-Frame
Motherhoard ATX, Micro-ATX, ATX, Micro ATX, ATX, Micro-AT, ATX, Micro-ATX, Motherboard ATX, Micro-ATX, ATX, Micro-ATX, ATX, EATX, Mini-1TX, ATK. Micro-ATK
compatiblity Mini-ITX Mini ITX Mini-ITX Mini-ITX compatiblity Mini-ITX XL-ATX Micro-ATX '
Expansion Slots 7 7 9 7 Expansion Slots 7 9+1 8 7
Available Colors Black, White Black Black, Red, White Black, Red, Blue Available Colors Black Black Black w/ Blue LED Black
SKuU NZCAS340WW1 coccootTioTw TH1G400M3WN1 DETSRCTSW SKU C0CCo011051W COGCH000KWN1 NZCAPH530W1 TAZ11PLUSHF1
Price 77.43 135.99 109.99 40.99 Price 59.99 149.99 119.99 71.99
Cube Cases Mid-Tower Cases

CEm MAANT

Corsair Corsair Lian Li Thermaltake Cooler Master NZXT Antec BitFenix
Model Carbide Series Air 540 | Carbide Series Air 240 PC-08WX Core X9 Model Silencio 352 H230 Three Hundred Two Prodigy
Motherboard ATX, Micro-ATX, h . ATX, Micro-ATX, Motherboard I . ATX, Micro-ATX, ATX, Micro-ATX, L
compatiblity Mini-Tx E-AT | MCO-ATK MinkIDE - E-ATK ATK MATK v T compatiptity "o ATk Mink-1TK Mini-ITX Mini-1TX Min-ITX
Expansion Slots 8 4 8 8 Expansion Slots 4 7 8 2
. . . . . . Orange, Blue, Green,
Available Colors Black, Silver White Black Black, White Available Colors Black Black. White Black Red. Black. White
SKu COCS540ACCBK COCI011069WW LIPCOBWX THCATD80OFIW SKU COSL35ZMKKN1 NZCAH230IB1 AN30ZMDTWRCS BIBPRO3WWXKW
Price 129.79 89.99 334.89 159.89 Price 64.51 79.99 69.89 84.89

Power Supplies

For the user wanting to build thier PC from the ground up, or the advanced gamer who need to upgrade to more power, B&H carries a wide
assortmant of internal Power Supplies that are fully compatible with most computer cases. Whether you are looking for a unit with cables
hard-wired or a fully modular Power Supply without any permanently attached cables that simplifies installation and allows you to use only the

cables you need for a neat and clean build by improving performance by reducing airflow obstruction.

eoTeoewseme

EVGA Corsair Sea Sonic EVGA Thermaltake Sea Sonic Thermaltake Corsair Antec Logitech
Model 5008 HX1000i Snow Silent 750 | SuperNOVA 850 62 SP-550P RM850 SP-750P CX600 VP-450 PS50
Wattage 500 W 1000 W 750 W 650 W 550 W 850 W 750 W 600 W 0w 550 W
Modular Non-Modular Modular Modular Modular Non-Modular Modular Non-Modular Non-Modular Non-Modular Non-Modular
P uwAecrﬁFvaector No No Active Active Active Active Active Active No No
+12V Rails Single Multiple Single Single Single Single Single Single Dual Single
Certification 80 PLUS Bronze 80 PLUS Platinum | 80 PLUS Platinum 80 PLUS Gold 80 PLUS Bronze 80 PLUS Gold 80 PLUS Bronze 80 PLUS Bronze 80 PLUS Certified 80 PLUS
SKU EVBPSH00 £0C9020074NA SESS750 EVNS65062 THSP550P SEM121162062 THSP750P COP9020048US ANVP450 LOPSB50E12BK
Price Call or Log-On 204.99 139.98 92.44 54.99 74.89 67.99 69.99 39.04 26.99

www.BandH.com BSH
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NVIDIA GeForce GTX 1080 Ti

With a slightly overclocked core, dual TORX
fans, and based on NVIDIA's Pascal
architecture, the GeForce GTX 1080
Graphics Cards provide major improvements
in performance, memory bandwidth, and power
efficiency over its predecessor, the high-performance

Maxwell architecture. It also introduces innovative graphics features
and technologies that redefine the computer as the platform for
playing AAA games and taking full advantage of virtual reality via
NVIDIA VRWorks. VRWorks Graphics includes a simultaneous
multi-projection capability that renders natively to the unique
dimensions of VR displays instead of traditional 2D monitors.

» DVI-D DL
» 7680 x 4320 Max Digital Resolution
» GeForce GTX VR Ready

» 2560 CUDA Cores
» Pascal Architecture
» B6B of GDDRHX VRAM

» 10 Gbps Memory Speed
» 756-Bit Memory Interface
» DisplayPort 1.4 + HDMI 2.0b +

NVIDIA GeForce GTX 1070
With a slightly overclocked core and based on
NVIDIA's Pascal architecture, the GeForce
GTX 1070 Graphics Cards provide major
improvements in performance, memory

bandwidth, and power efficiency over its
predecessor, the high-performance Maxwell
architecture. It also introduces innovative graphics features and
technologies that redefine the computer as the platform for playing
AAA games and taking full advantage of virtual reality via NVIDIA
VRWorks. VRWorks Graphics includes a simultaneous multi-projection
capability that renders natively to the unique dimensions of VR
displays instead of traditional 2D monitors.

» 7680 x 4320 Max
Digital Resolution
» GeForce GTX VR Ready

» 1920 CUDA Cores
» Pascal Architecture
» B8GB of GDDR5 VRAM

» 8 Gbps Memory Speed
» 756-Bit Memory Interface
» DisplayPort 1.4 + HDMI 2.0b + DVI-D DL

Model GTX :II]BI] GTX 10?[] SC GTX 1080 GTX 1080 GTX 1080 ] Model GTX 1070 GTX _1070 Republic_of Gamers GTX 1_070 GTX 1070
Gaming X Gaming Founders Founders Rep. of Gamers Strix AMP Extreme Gaming X Strix 0C Gaming G1Gaming
Base Clock 1607 MHz 1708 MHz 1607 MHz 1607 MHz 1670 MHz Base Clock 1633 MHz 1506 MHz 1632 MHz 1594 MHz 1594 MHz
Boost Clock 1847 Mhz 1847 MHz 1733 MHz 1733 MHz 1835 MHz Boost Clock 1835 MHz 1797 MHz 1860 MHz 1784 MHz 1822 MHz
Cooling TW'NC[ESSZR Wl aexa0 coner Bl”‘éf;esrtyle BL“E’SJES:V[G DirectCU Il Cooler Cooling lEeSTgf[f Ezglmg T‘QI’:NCLESSER DirectCU 11 Cooler ACCU)E fer” mﬁgﬂggz
SKU MSG1080GMX86 EVGTX1080SC GIGTX108086B Z0P10800A10P ASRSGG10806C SKU Z0P10700B10P | MSG1070GMX8G | ASG10700CGGC EVG1070SCA38 61107086BG1C
Price 659.89 519.99 677.89 599.99 545.84 Price 449.89 409.30 429.99 407.99 401.02

NVIDIA GeForce GTX 1060

Featuring an overclocked core, slightly overclocked
memory, customizable LED lights, and based on
NVIDIA's Pascal architecture, the GeForce
GTX 1060 Graphics Cards provide

major improvements in performance,

memory bandwidth, and power efficiency
over its predecessor, the high-performance
Maxwell architecture. It also introduces innovative
graphics features and technologies.

» 7680 x 4320 Max
Digital Resolution
» GeForce GTX VR Ready

» 1280 CUDA Cores
» Pascal Architecture
» 668 of GDDR5 VRAM

o | e | ow o |

» 8.1 Gbps Memory Speed
» 192-Bit Memory Interface
» DisplayPort 1.4 + HDMI 2.0b + DVI-D DL

AMD Radeon RX 480 Graphics Card

Based on AMD’s Polaris architecture and AMD LiquidVR
ready, the Radeon RX 480 Graphics Cards allow you to
have the full virtual reality experience. Not only
for gaming, the Radeon RX 480 supports
APIs such as OpenCL and OpenGL.
These APIs can take advantage of

the GPU's 2304 Stream Processors to
accelerate parallel computing tasks, taking

some of the processing load off of the CPU.
Experience the immersive world of VR gaming and entertainment.

» Blower-Style Cooler
» AMD LiquidVR Ready

» 2304 Stream Processors
» Polaris Architecture
» 8GB of GDDR5 VRAM

» 8 Gbps Memory Speed
» 256-Bit Memory Interface
» DisplayPort 1.3 + HDMI 2.0b

Model | “oc GeForce 67X 1060 AMP GamingX Gaming  G1Windforce e Gigabyte
Base Clock 1620 MHz 1556 MHz 1594 MHz 1506 MHz 1556 MHz Model Radeon RX480 XXX | RadeonRX480 = RadeonRX480 = RadeonRX480 | Radeon RX 480
Boost Clock 1873 Mhz 1771 Mhz 1809 Mhz 1708 MHz 1797 MHz Max Boost Clock 1268 MHz 1316 MHz 1332 MHz 1288 MHz 1290MHz

Cooling DirectCU 11l Cooler Dual Fan leeStorm | TWIN FROZR VI Single Fan VWINDFORCE 2X Cooling Blower-Style Blower-Style Blower-Style Blower-Style Blower-Style
Cooling Cooler ACX 2.0 Cooler Cooling System
p el T SKU XFRXGBOMBBFA | MSRXABOGKSG | ASRNABOOBGGM | XFRXAGOMSBEN | GIRKCBOGIGMS
Price 29499 259.99 269.89 Call or Log-On 259.99 Price 264.95 246.00 259.95 24.95 229.99

800-947-3308 - 212-444-6691




OPTICAL DRIVES & BURNERS, DUPLICATORS

.’ Authorized Reseller USB supeanve

External Slot-Loading

Optical Drive

» USB Powered

» Slim & Portable

» For Mac with a
USB Port L

(APMMDB64LLA) 79.00

@ LG GPE5NG60
Portable USB DVD Burner and
Drive (Gold) -

» 1dmm Thick q
» USB 2.0 Interface
» Read/Write Speed 8x DVD, 24x CD

» Windows and Mac Compatible
(LGGP65NG60) 28.95

/iSUS" DRW-24B1ST
Internal SATA 16X DVD Disc
Rewriter

» 16X DVD Disc Writing Speed

» (TS for Enhanced Burning Quality

» Permanently Delete Data with E-Hammer
» E-Green Reduces Power Consumption

WY Verbatim. External Slimline
CD/DVD Writer

» 8X DVD Write Speed
» 24X CD Write Speed
» Bus Powered

» M-DISC Ready

» Windows & Mac Compatible

(VEESLCDDVDW) ... .....30.28

@ LG WH16NS40
» BD-R16x » DVD+/-R 16X
» Read & Write Blu-ray,
DVD and CD Discs
» 3D Blu-Ray Title
Playback

[2a]
o
~o
(2]

(LGWHT6NS40)

roneer BDR-209DBK
16x Blu-Ray/CD/DVD Writer
» Write Speed of
8x: DVD= Discs

» bx: DVD-RW Discs
» 24x: CD-R Discs
» USB 2.0 Interface
» Includes Downloadable CyberLink Software

OPTICAL DRIVES AND BURNERS

COMPUTERS

/iISUS" EBW-12D1S-U Lite
Ext. Blu-Ray Drive with USB 3.0
» 12x BD-R / 40x CD-R
» 16x DVD+R and
DVD-R Write Speed
» SuperSpeed USB 3.0 Interface
» Power Backup » Vertical/Horizontal
Mounting » Windows & Mac Compatible

(ASBW12D1SLBG) 99.95

@ LG GP6ONB50
» DVD=8X » CD 24X
» M-Disc Support
» USB 2.0
» Supports Double
Layer DVD=+ R Discs

(LGGP6ONBSD) 24.95

roneer BDR-XS06

» Slot Loading Mechanism » USB Bus-Powered
» 1286B Quad Layer Blu-ray Media » 100GB
Triple Layer Blu-ray Media
» (Optimal Storage
Capacity -
» 4MB Buffer Memary Size
» Auto-Quiet Made, PureRead, & PowerRead

/iSUS’ SDRW-08D2S-U/B

» DVD 8x / CD 24x
» Up to 160 ms DVD Access Time
» 140 ms CD Access Time
» USB 2.0
» Windows &
Mac Compatible

(ASDRW08D2S) 29.95

@ LG GP65NB6D
14mm Thick DVD Writer Drive

» USB 2.0 Interface
» DVD Bx

(LGGP65NBAD) 2499

roneer BDR-XD05S
Blu-Ray, DVD & CD Writer

» Reads & Writes BD-XL TL,
(L BD-R & BD-RE 7

» Reads BD-ROM

» 6 BD-R Read/Write
Speed » Connects and
Powered via USB 3.0

(PIBDRXD05S) 7699

(AS24B1STABK) 19.95 (PIBDR209DBK) 69.95 (PIBDRXS06) 119.98
DUPLICATORS
merosaares (1D 1:10 Aleratec 1:16 USB 3.0 Copy Cruiser

CD/DVD Duplicator

» 1:10 CD/DVD Duplication
» (D-G Support
» Standalone Operation
» LCD Display &

Control Panel

(MIQDDVD1210) 749.00

CD/DVD Duplicator

» 1:3 Duplication

» Standalone Operation

» LCD Display & Control Panel
» USB 2.0 Connection

(MIQDDVD123) 399.00

Mini Duplicator
» Duplicates up to
16 USB 3.0/2.0
Drives » SuperSpeed
USB 3.0 Technology
» USB Flash/Pen Drive Media Type
» Aleratec Software Suite

(AL330115) 433.98

FRIMERA. Bravo SE-3 Disc Publisher
» Create/Burn DVD and CD Media

» Prints On DVD and CD Media
» 4800 dpi Color Inkjet Printer
» Holds up to 20 Discs

» USB 3.0 Connectivity

» Includes USB 3.0 Cable

(PRBSE3DP)

1,359.00

CDS, DVDS & BLU-RAY DISCS

v 5Target

" 24X DVD/CD Duplicator
» Burns Approximately 50 DVDs / Hour

» SATA Internal Interface

» USB 2.0/3.0 Compatible

» Up to 24X Read Speed

» b x DVD Writers

» 1 x DVD-ROM Drive

» Intuitive LCD Display

(EZD5TDVDLGB) 435.91

EPSON' PP-1001I Discproducer

» USB 3.0 SuperSpeed Interface

» Leave Production Runs |
Unattended » High Accuracy

» User-Replaceable Drives

» Total Disc Maker Software
Included

(EPPP100I)

2,695.00

€ 3 Target
™ 24X DVD/CD Duplicator
» Burns Approximately 30 DVDs / Hour

» SATA Internal Interface
» Up to 24X Read Speed

» 3 x DVD Writers <
» 1xDVD-ROM Drive
» Intuitive LCD Display

(EZD3TDVDLGB) 298.18

Aleratec 1:10 USB 3.0 Copy Cruiser

Mini Thumb Drive Duplicator

» SuperSpeed USB 3.0
technology

» Easy-to-Use Aleratec
Software Suite

(ALCCM110) 292.21

B&H carries a wide assortment of optical recordable media, including CD, DVD, Blu-Ray and M-Disk.

maxeil.

BlurayDisc

www.BandH.com

€Y Y Verbatim

VD

EMOrex: _—

aTDK 22 JVC (58 sonvy

M

DISC




COMPUTERS

MINI & SLIM MICE

"IRY .

MICE & TRACKBALLS, KEYBOARDS

STANDARD MICE

Wireless Wired Wireless Wired
Apple Gyration Microsoft Apple \ Adesso Kensington Logitech Microsoft 3Dconnexion Logitech Macally
Magic Mouse 2 | Air Mouse Mobile Surface Wired Mouse iMouse W2 Suretrack Any Surface |  iMouse M510 | Mobile Mouse 4000 CAD Mouse M500 3-Button Mouse
Bluetooth 2.46Hz Wireless Bluetooth Touch-Sensitive Buttons USB Bluetooth 2.46Hz Wireless 2.46Hz Wireless Braided USB USB USB
APMLAD2LLA 6YGYM2200 MIWS300001 APWM ADIMOUSEW? KEK72437AM LOM510BL MIWLMMA40008 3DCADMSE LOM500 MAIM2
76.50 49.80 49.00 49.00 20.99 38.00 18.95 29.95 92.99 24.95 11.52
GAMING & ERGONOMIC MICE TRACKBALLS VERTICAL MICE TRACKPADS

oh —

Wi

Wireless d |_Kensington | Kensington ___Evoluent | 3M | _Apple | Lleap |
Razer Asus Razer SlimBall Trackball | Expert Trackball | VerticalMouse 4 EM500GPL Magic Trackpad 2 | Motion Controller
Mamba Gaming Republic of i Mamba Tournament|  Naga Chroma DiamondEye Optical | Avoids Forearm Vertical-Handle or: :
Mouse Gamers Spatha Wil Edition MMO Use Tracking Technology Twisting Design Bluetooth 190° Field of View
Wireless with Wired & Dual Wired/Wireless . . Built-In
Charging Dock | RF Wireless Connectivity U3B UsB MUERICUON | SerliRing | RightHond (EWMAW) USBPS2 Rechargeable | Motion Control
16,000 dpi 56 Darkfield Laser 8,200 dpi 46 16,000 dpi 56 16,000 dpi Precision Battery
Laser Sensor Works on Glass Laser Sensor Laser Sensor 56 Laser Sensor Media Mode Wrist Pad 105.95 Thumb Button bx45" Free Apps
RAMCERGM ASROGSPATHA RA0B200CMGM RAMTEEGMB RANCMCMMOGM KEK72327US KEMEPU LeftHand (EVWMA4L) | 3MEMS500GPL APMJZR2LLA LELMC01US
149.99 149.90 69.99 85.99 69.99 89.49 79.99 76.57 51.54 121.00 79.00
Stantard EEMBOARDS I T
Apple Keyboard Apple Magic Keyboard
Anodized Aluminum Enclosure B e SHnARE HE ij HH Bluetooth
Low Profile Keys tﬁ'l : 1! L {ree 1 Scissor Mechanism for Keys
Two USB 2.0 Ports [ | i nn &N Low Profile, Compact Design
[APMBITOLLB) oo 49.00 (APMLAZ2LLA) oo 99.00

Microsoft All-in-One Keyboard

Wireless Connectivity via USB
Customizable Media Hotkeys

Smk-link Wireless Ultra-Mini Touchpal

Wireless 2.4GHz Transmission
Ergonomic Handheld Design

Integrated Multi-Touch Trackpad QWERTY Keyboard

[MIN9ZOOOOT) e 39.95 (SMVPO364) ... 59.95

USB Wireless Distance of up to 30°

Tri-Color Backlight Supports Most Phones and Tablets

Membrane Switch Type Connect Three Devices Simultaneously

[AZKBBOBU) ..o 29.99 (L0920008362) ....cocoeee 43.49
Microsoft Natural Ergonomic 4000 AZ10 MGK1

UsB Braided USB

Zoom Slider Kailh Blue Mechanical Key Switches

Multimedia & Internet Hot Keys White LED Backlight

[MIKBNEAODD)....osee 34.99 (AZMGK1) 66.99

USB RF Receiver USB

Cushioned Palm Rest Slim Chiclet Keys

Thumb Scoop Chroma Backlighting

(MISEKBB) 85.99 (RADSCMCKB)......cr e 84.99

3xUSB 2.0 Ports Braided USB

Split Keyboard with 17" Bridge Cable
Anti-Ghosting Circuitry
(MAFKAO3Q) oo 199.95

10-Key Rollover
Programmable Backlit Keys
[T L) P——— 135.56

800-947-3308 - 212-444-6691




a’ Dancing Water
XCELLON® Stereo Speakers
» USB-Powered for
Convenience and Mobility
» Water and Lights
Dance to Your Music
» Four Streams of Water
Black (xCDWS1008) 19.95
White (xcDWS100W) 19.95

)) BassPULSE 2.1 Channel
Speaker System
» Full-Range Satellite
Speakers
» Side-Firing
Subwoofer
» 3.5mm
UBL Jembe
Powered Computer Speakers
» Stylish Compact Design
» |deal for Computers -
and MP3/CD Players
» Large Easy-access
Volume Control

Aux Input
(6066BPO00100)
» Stereo 3.5mm Headphane Jack
(JBJEMBE) 59.95

Razer KrakenPro2015

Gaming Headset

» In-Line Volume & Mute Controls

» Large 40mm Neodymium
Magnet Drivers

» Fully Retractable

Microphone Boom

Black (RAKP2015HSBK) 42.99

SUS STRIXT.1

USB Gaming Headset
» True 7.1 Surround Sound
» 10 Neodymium
Magnet Drivers
» Plug-and-Play USB

Audio Station » 130mm Leather Cushions
» Foldable Ear Cups » Windows & Mac Comp
(ASTRIX71) 199.99

plantronics
Backbeat Pro 2 SE

Wireless Headphones

» 40mm Dynamic Drivers

» On-Demand Active
Noise-Canceling (ANC)

» Bluetooth & NFC Technalogy

» Up to 330" Transmission Range

(PLBBP2SEGG) 249.99

www.BandH.com

Sy

SPEAKERS, GAMING HEADSETS

"=\ CA-2014

» Stereo Sound
» Front-Panel Power
and Volume Control

Cyber Acoustics Computer Speakers
» Integrated 3.5mm
Audio Cable

» Headphone Jack I I

(CYCA2014) 11.63

harman,/kardon SoundSticks Il
2.1-Channel Desktop Speakers

» Up to 40W of Total Power
» 8 Full-Range Transducers
» 6" Down-Firing Subwoofer
» 1x3.5mm Auxiliary Input -Q;%
» Touch Controls for
Volume and Mute
(HASS3AMA)

@ AX510
Stereo Soundbar

For Dell

UltraSharp

and Professional

Series Monitors

Low Profile Design » 10W of Total Power

(DEAX510) 34.99

71 seEnNNHEISER GAME ONE
Gaming Headset
» Plush Velvet Ear Pads
» Cushioned Headband
» Naise Cancelling Mic
» Volume Controls on
Right Ear Cup

(SE506080) Call or Log-On

71 SENNHEISER PC-131
Binaural Headset
» Qver-the-Head Binaural
Headset for Computer
Gaming and VoIP

(SEPC131)

Call or Log-On

SONY Uncharted 4
Limited Edition Gold
Wireless Headset

» B7.1Virtual Surround Sound

» Hidden Noise Canceling
Microphone

» Headset Companion App

» PC & Mac Compatible

(SOWLHSU4GLD) 89.99

AV Companion 20
Multimedia Speaker System

» Dual Speakers with
Full, Natural Sound

» Advanced Ported
Design for Low-Notes

» Control Pod with Volume
and Mute Control

(BOC20MS) 249.00

CA-3090

cyber Acoustics  High Quality Sound

» Pair of Impeccably
Clear Speakers

» Subwoofer w/ Bass
Volume Control

» For Gaming Computers, l -
MP3 / DVD Players
(CYCA3090) 28.95

SonaVERSE UBR
Soundbar

» W RMS Power
» Dual Drivers
» Fits Under

Computer Monitor
» USB-Powered
» Angled Upward for Desk Use
(GOSVUBRTBKEW) 29.95

Osteelseries Arctis 3

Gaming Headset
» SteelSeries 7.1 Surround Sound
» On-Ear Audio Controls
» Audio Share Jack
» Built-In Retractable
Microphone
Black (ST61433) 74.99

White (ST81434) 79.99

Micresoft Xbox One

Stereo Headset
» Unidirectional Microphone
» (ame/Chat Balance Buttons
» Volume Control, Mute Button
» Included Xbox One

Headset Adapter

» Stereo Headset, Over-the-Ear Design
(MIXBONESHSB) 55.99

RazeRr KrakenUSB
Over-Ear PC Headset

» Virtual 7.1 Surround Sound
» 1.3" Neodymium Drivers
» Unidirectional Analog Mic
» Closed Ear Cup Design

» Extended Gaming Comfort

(RAKUSBOEHSBK) 59.99

COMPUTERS

CREATIVEGigaWorks T40
Series |l Stereo = P
Speakers

» J2WRMS

» Headphone Jack
» BassXport

(CRT40) 154.95

CA-3602 3-piece

cyber Acoustics Flat Panel Subwoofer
and Satellite

»  Subwoofer Delivers
Thunderous Bass
» For Gaming,

Computers, MP3 / DVD Players
» Combo of Four Satellite Drivers

(CYCA3602) 44.99

CA-2880

cyber Acoustics USB Powered Speaker

» Dual 1.5
Neodymium
Full-Range Drivers

» Chrome 3.5mm Input » USB-Powered

» Attaches to Laptop via Clip

» Desktop Volume Control & On/0ff Switch

(CYCA2880) 15.91

Gamlng Headset

» Hi-Fi Capable 53mm
Dynamic Drivers

» Detachable Microphone

» Padded Leatherette Headband

» Aluminum Construction

Black (KIHXH3CLWR) 79.99

White (KIHXH3CLW) 79.99

TRITTON Swarm
Mobile Headset (Green)

» AM3D Virtual Surround Sound

» Works with Bluetooth-Enabled
Devices » Wireless Range Up
to 15" » Wired Connection via
3.5mm Adapter Cable

» Automatically Configures Audio Settings

(TRSMHSGN) 149.99

Razer Overwatch Man0'War

Tournament Edition Gamlng Headset

» Analog 3.5mm Connection

» 50mm Neodymium Magnet
Drivers » Retractable,
Unidirectional Microphone

» In-Line Volume and
Mic Controls

(RAMWTEAGHS)




eerO Wireless-AC 3pk

(ole) VUi - I3 WIRELESS NETWORKING

WHOLE HOME SMART WI-FI
AMPLIF| AFi AmpliFi NETGEAR
» Single Router Base Orbi Wireless Router .

Station » 802.11a/b/ Fl

g/nfac Wi-Fi Network : o :
Standards & = =
» Dual-Band 2.4 6Hz /5.0 & e

GHz Frequencies » 4 x Gigabit LAN Ports
(AMAFIROUTER) oo 199.00

802.11a/b/g/n/ac Wi-Fi

Standards » AC3000 Wi-Fi
Data Speeds » 4 x Gigabit
Ethernet Ports. USB 2.0 Port T

" Authorized Reseller AirPOft EXtreme
Base Station -
» Simultaneous Dual-Band 802.11ac

Wi-Fi. WPA / WPA2 Encryption
» NAT Firewall, USB Port

» 3x Gigabit Ethernet LAN Ports ~_

(APAPEQ) 184.25

/ISUS RT-AC68U wireless
Dual-Band Gigabit Router

» 802.11ac Protocol

» Upto 1734 Mbs at 5 GHz

» Dual-Band 2.4 GHz/5 GHz

» File, Printer & 36/46 Sharing

» 802.11a/b/g/n/ac
Wi-Fi Standards

» 2.4 GHz /5 GHz
Dual-Band Frequencies

» 2x2 MIMO Connectivity

> Google Wifi
\, » 802.11a/b/g/n/ac Wi-Fi Standards
» Dual-Band 2.4 GHz/
5 GHz Frequencies
» AC1200 2x2 Wave 2 Wi-Fi

» 2 x Gigabit Ethernet Ports -
(G0GOOGWIFI) 125.99
(60GOOGWIFI3) 297.85

-

» 6 x High-Performance Antennas » bxInternal Antennas :
(NERBKSOTOONA) o 399.99 (EEWLDBWFAPSP) ... . 398.40
WIRELESS ROUTERS

TP-LINK TP-LINK
Archer C9 AC1900 Archer C7 AC1750
» Dual-Band Gigabit Router Ty » |EEE 802.11 a/b/g/n/ac
» 802.11a/blg/nfac Wi-Fi Network = , Standards » Upto 1.75
» 1900 Mbps Total Bandwidth 4 Gbps Total Bandwidth
» Dual-Band 2.4GHz / 5.06Hz Frequencies » 2.4 GHz /5 GHz Frequencies
» 4x10/100/1000 Mbps LAN Ports
(TPARCHERCY) ..o 119,95 (TPARCHERCY) 99.99

/iSUS RT-AC3200 Tri-Band
Wireless Gigabit Router
» 802.1ac Protocol
» Up to 3200 Mbps Data
Transfer Rate
» Tri-Band Functionality

NETGEAR R7000
Nighthawk AC1900 Smart-Router
» Wireless 802.11ac

1900 Router
» 2.4GHz & H6Hz Dual Band
» by Gigabit Ethernet Ports

/iSUS RT-AC5300 Tri-Band
Wireless Gigabit Route

» 802.11ac WiFi Protocol

» Up to 5334 Mb/s at 5 GHz

» Dual-Band 2.4 GHz/5 GHz

» File, Printer & 36/46 Sharing

»

(ASRTACH300) 319.99

LINCSYS EA8500
MU-MIMO Smart Wi-Fi Router
» 802.11ac Networking

Standard » Upto 1733

Mbps Throughput
» Dual-Band 2.46Hz / 5.06Hz Frequencies

(ASRTAC68U) 149.61 (ASRTAC3200) 199.95 (NER7000100PA) 174.95 (LIAC2600) 169.99
WIRELESS ACCESS POINTS
J UAP-AC-PRO {J UAP-PRO «J UAP-AC-LITE «J UAP-AC-M-PRO-US
YBIOYTE UniFi Access Point YBIAUT UniFi Access Point YBIAUT UniFi Access Point UBIAUT UniFi Access Point
» 802.11 a/blg/n » 80211 afblg/n » 802.11 afb/g/n » 802.11 afb/g/nfac Wi-Fi Standards
Wi-Fi Standards Wi-Fi Standards Wi-Fi Standards » Range of up to 600"
» Range of up to 400 @ » Range of up to 400° » Range of up to 400° @ » 1x10/100/1000 Ethernet Port
» 2 x Ethernet Ports » 7 x Ethernet Ports » Ethernet Ports » UniFi Controller Software
» Integrated Omni Antennas » /4 dBi Omni Antennas —— » Integrated Omni Antennas
(UBUAPACPRO) .o 129,95 (UBUAPPRO) oo 198,90 (UBUAPACLITE). .o TT.99 (UBUAPACMPRUS)... ... 179.00

" Authorized Reseller AirPOI’t EXPTESS
Base Station -
» Simultaneous Dual Band
802.11n / Wi-Fi
» Fasy Setup from iPhone,
iPad, iPod » Extend Wi-Fi Range
»  Supports 2.46Hz and 5GHz Frequencies
» Plays iTunes on Any Speaker
(APAPEBSTUSA) 94.99

vfrer]re WAPS71-A-K9 Dual
CISCO Radio Access Point
» 802.11ac Wi-Fi Network Pratocol

» 2 x Gigabit LAN Ports

» Dual Band 2.4 GHz & b GHz

Frequencies
» 6 x Internal Antennas
» Upto 1.9 Gbps Wireless Data Rate

[CIWAPSTT). o 256,99

LINKSYS WAP300N
Wireless-N Dual-Band Access Point
> 802.11a/b/g/n Wi-Fi Compliant
» Up to 300 Mbps Data Throughput
» Dual Band 2.4 GHz &
5 GHz Frequencies
» 1x Fast Ethernet Port
» Dual Detachable Antennas
(LIWAP300N) 72.51

afrer]re WAP321 selectable-
CISCO Band Access Point

» Upto 300Mbps » Supports
802.11b/g/n Wi-Fi
» 2.4GHz or HGHz
Selectable-Band
» Power over Ethernet (PoE)
» WEP/WPA/WPA2/WPS Security

[CIWAP32IAK) ..o

179.95

° OpenMesh MR1 750

Wireless-AC Access Point

> |EEE 802.11 bg/n Stds.

» Dual Band 2.4 GHz / - ot /
5 GHz Frequencies

» 6 Internal Antennas » 1 x Gigabit Ethernet Port

» 802.3af Pok Compliant » 50 to 100 Users per
Access Paint » 4 x Public or Private SSIDs

(OPMR176ONA) oo 220,95
TP-LINK

TL-WAB01ND

» Up To 300 Mbps Data Rate

» |EEE 802.11n Wireless = siis

» 2.4 -2.4835 GHz
» 2x 4dBi Detach. Antennas » MIMO Technology
» WI-FI Setup Compatible (QSS)

» Power Over Ethernet: Up To 100°
(TPTLWABO1ND) 24.95

/sSUS N-300 3-in-1 Router/
Access Point/Range Extender
» 802.11n Speeds up to 300Mb/s
» 2 x Detachable b dBi Antennas
» 2.4 GHz Operating Frequency
» 1xRJ-45 Port for 10/100 Base
T for WAN
» 4 xRJ-45 Port for 10/100 Base T for LAN
(ASRTNIZD1) oo 27,99

LINKSYS LAPAC1200

Dual-Band Access Point

» |EEE 802.11a/b/g/n/ac e
Network Standards \ s

» Maximum Data Rate: 1,200 Mbps =

» 2.4 GHz /5 GHz Concurrent Frequencies

» Internal Antenna » 802.3at PoE Comaptible

» Gigabit Ethernet Port Speed

(LILAPAC1200) 114.99

“ B:H 800-947-3308 + 212-444-6691



WIRELESS NETWORKING

U NBE-5AC-19 NanoBeam ac

airMAX Technology » Atheros i
MIPS 74Kc, 720 MHz Processor -
128MB DDR2, 8MB Memory {
» 1x10/100/1000 Ethernet Port

(UBNBEBAC19US) 99.00

() NanoStation5 outdoor

» Atheros AR2313 S 180MHz Processor ¢
» 16MB SORAM, 4MB Flash Memory |~
» 10/100 BASE-TX Ethernet Interface l
» 2 x14dBi Dual Polarity Antennas
G

(UBNSMS) 79.00

U PBE'5AC'5UU PowerBeam

Atheros MIPS 74Kc, 720 MHz
Processor » 128 MB DDR2,

8 MB Flash Memory %
450+ Mb/s Transfer Speed

L ot —

P

278.86

EnGenius ENH500 High-Powered,
Long Range 5 GHz Outdoor Bridge
» 600mW High Power Long Range
» Upto 1 mile Coverage » Wireless

N300 Speed » 2 Fast Ethernet Ports ~~ deeds
» Internal 13 dBi Directional Antenna

(ENENH500) 89.99

Kit (ENNENH500KIT) 158.99

@ TReENDneT THA-101 Home
Smart Switch w/Wireless Extender

» Turn Appliances On/0ff via
the Internet » Extends the U-i
TRENDNeT

Range of Wireless N Networks
» Helps Eliminate Wireless Dead

Spots » MIMO Antenna Tech  [Fg2 &
(TRTHA101) 49.99

LINKSYS Max Stream AC1900
Dual-Band Range Extender

» 802.11b/g/a/n/ac ey
» Up to 1900 Mbps

» 2.4 GHz /5 GHz (Dual-Band)

» Gigabit Ethernet Port

» MU-MIMO, Spot Finder Techn.

[LIRE7000) . 99,99

TP-LINK TL-WA855RE

Wireless Range Extender

» 802.11b/g/n

» Up to 300 Mbps

» 2.4 GHz

» 7 x External Antennas

» 1x10/100 Mbps LAN Ports

(TPWABBBRE) ..o . 26,99

NETGEAR EX7000AC1900
Wi-Fi Range Extender

» 802.11ac Wi-Fi Technology

» 802.11a/b/g/nfac Wi-Fi Standards
» Dual Band 2.4GHz/56Hz Frequencies
» b xGigabit Ethernet Ports

» 1xUSB 3.0 Port

(NEEX7000100N) 129.00

TP-LINK TL-WN725N
Wireless N Nano USB Adapter

» |EEE 802.11b/g/n Compatible
» Up to 150Mbps Data Speeds

» USB 2.0 Connectivity

» 2.400-2.4835GHz Frequencies
» Internal Antenna

(TPTLWN725N)

LINKSYS WUSB6100M

Wireless-AC600 MU-MIMO

USB Wi-Fi Adapter

» Wi-Fi Speeds of up to 600 Mbps

» Dual-Band 2.4 GHz / 5 GHz
Connectivity

» Plug & Play Installation

» MU-MIMO Technology

(LIWUSB6100M) 59.97

TP-LINK TLWN722N
High Gain Wireless USB Adapter
» Wireless N Speeds

Up to 150 Mbps
» Compliant with [EEE 802.11n
» USB2.0 » 64/128-bit

WEP /WPA/2/PSK/2-PSK o

(TPTLWN722N) 13.52

/iSUS AC1900 pcle

Dual-Band Wireless Adapter

» 802.11ac Wi-Fi Standard

» Broadcom TurboQAM
Hardware » Flexible
Extended Antenna Placement

» bth Generation 8

02.11ac Chipset - "

[ASPCEACG8) 92.96

WIRELESS BRIDGES/OUTDOOR

WIRELESS RANGE EXTENDERS

WIRELESS ADAPTERS

COMPUTERS

NBE-M5-16 GHz 16dBi

T NanoBeam airMAX
» airMAX Technology

» Atheros MIPS 74Kc, 560 MHz \
Processor » 64MB DDR2, 3
8MB Flash Memory » Ethernet Port
(UBNBEMBT6) oo 62,64

EnGenius ENSH00 High-Powered,
Long-Range 5 GHz Outdoor Bridge
» 400mW Power Delivers Long-Range

Coverage » Up to 300 Mb/s Wireless

Speed » Backward Compatible to

802.11b/g » Dual Polarity 8 dBi

Directional Antenna - E

(ENENS500) 66.00

» airMAX Technology o
» Atheros MIPS 74Kc, 720 MHz
Processor » 128MB DDRZ,
8MB Flash Memory » Ethernet Port

(UBNBEBAC16) 99.00

v

EnGenius ENS202 High-Powered,
Long-Range 2.4 GHz Outdoor Bridge

P

400mW Power Delivers Long-Range

Coverage » Up to 300 Mb/s Wireless

Speed » Backward Compatible to

802.11b/g » Dual Polarity 8 dBi cale
Directional Antenna -

(ENENS202) 56.19

TP-LINK RE4501750

Wi-Fi Range Extender

» |EEE 802.11b/g/n Wi-Fi Network
Standards » Gigabit Ethernet Port

» 3 x External Antennas

» Dual Band 2.4 GHz &5 GHz

» Up to 1750 Mbps Data Throughput

(TPREABO) ..o

/
°

...99.95

WCB3000N 802.11n Wireless
Network Extender

» 7 x Gigabit Ethernet Ports

» 1 x MaCA Coaxial Jack

» 802.11a/b/g/n Wi-Fi Protocols
» 2.4 GHz /5 GHz Frequencies

» WPA/WPAZ/WEP/TKIP/AES Encryption

[ACWCB3000N) 79.99

TP-LINK TL-WA850RE
300 Mb/s Wi-Fi Range Extender
10/100M Ethernet Port (RJ-45)

Interface » 2.4 to 2.4835 GHz

Frequency » Flexible Deployment

» 7 x Internal Antennas

» b x Signal Indicator Lights

(TPTLWABBORE)......coooooo

P

|

19,99

LINKSYS LAPAC1750 AC1750

Dual Band Wireless Access Point

IEEE 802.11a/b/g/n/ac A
Network Standards & st 4
Maximum Data Rate:

1,750 Mbps » Internal Antenna

» 2.4 GHz /5 GHz Concurrent Frequencies
(LILAPACTTS0) oo 27499

& TRENDnet TEW-809UB
Dual-Band Wireless USB Adapter

» 802.11a/b/g/n/ac Connectivity
» 2.4 GHz &5 GHz Frequencies
» Up to 1300 Mbps via
5GHzBand » Upto
600 Mbps via 2.4 GHz Band

(TRTEWB09UB) 89.54

=

/1SS USB-AC68 AC1900

Dual-Band USB 3.0 Wi-Fi Adapter

» 802.11a/b/g/n/ac Wi-Fi
Standard » 2.4/5 GHz
Dual-Band Frequency

» x4 MIMO Design

» Beamforming Technology

» USB 3.0 Type-A Interface

[ASUSBAC68) 86.99

—

EDimAax EW-7811UN

Nano USB WiFi Adapter

» USB 2.0 » Compliant with ~
IEEE 802.11b/g/n Standard

» Data Rate Up to 150 Mb/s

» Increases Wireless Coverage by 3x

» Green Power Saving & Internal Antenn

(EDEW781TUN).cooo. 8099

LINCKSYS AE6000

Wireless-AC Dual-Band USB

> |EEE 802.11a/b/g/n/ac Standards

» Wireless AC Compatible

» Up to 430 Mbps Data o
Transfer Speeds

» Selectable 2.5 GHz / 5 GHz Frequencies

» 1xInternal Antenna

(LIAE6000) 27.95

www.BandH.com B&H
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) EdgeSwitch 24 port
UBIQUIT Managed Switch w/SFP
» 24 Giga-bit Ethernet Ports » 2x 1 Gbps SFP

Ports » 250 Watt Max. Power Consumption
» Auto-Sensing IEEE 802.3af/at PoE

(UBES24250W) 368.66

otfrer]ee S6200-26P
CISCO 26-Port Switcher
» 24x Gigabit Ethernet Ports
» Supports Up to

12 Pok Ports
» 7 x Combo mini-GBIC

Ethernet Ports » QoS Support

(CIS620026P) oo 363.95

D-Link DGS-1008
8-Port Gigabit Ethernet Switch
2000Mbps

» Total of Eight -

Gigabit Ethernet Ports » QoS Traffic
Prioritization » Power-Saving Features

(DLDGS108) 29.99

» Speed Up To

«J UniFi Managed poE+

O mmmmmmm
» Process All Ports at Line Rate / No Loss
» Up to 26 Gbps Non-Blocking Throughput
» 57 Gbps Switching Capacity

[UBUSZA250W) ... 368,99

afrer]rs S6300-10
CISCO 10-Port Switcher

mini-GBIC
Ports » 8x 10/100/1000 PoE+ Ports

» QoS Support » IPv4 [ IPvé Support
» Advanced Security Management

.’ Authorized Reseller  Thunderbolt to
Ethernet Adapter

» Supports 10/100/1000BASE-TNetworks
» Small & Compact

(APMD463LLA) 29.99

LINKSYS USB3GIG
USB 3.0 Ethernet Adapter
» Gigabit Ethernet
Speeds
» Upto328°
(100 m) Range
» Up to 30 W Power
» Fast, Easy Setup and Installation
(LIUSB3616) 22.99

(ONN©] TWIN10G-TB2
10GbE Dual-Port 10 Gigabit
Ethernet Thunderbolt 2 Adapte
» 7 x Thunderbolt 2
Connectors

» 2 x RJ-45 Connectors
» Adds 106bE Connectivity
» Supports Wake-on-LAN, Transparent Failover

[SOTWIN106) Call or Log-On

NETWORK SWITCHERS

! US-8-60W uniFi s-Port
YBIQUIT Gigabit Managed Switch
» B xRJ-45 Gigabit Ethernet Ports
» 4 x Auto-Sensing “

802.3af PoE Ports % &
» 8 Gbps Non-Block Throughput

(UBUSB6OW) 129.95

afrar]rs $6200-08
CISCO 8-Port Eathernet Switch

» 8x10/100/1000 =
Ports

» 2x Combo mini-GBIC Ports
» QoS Support » IPv4 / IPvé Support
» Advanced Security Management

¢! TS-5-POE TOUGHSwitch

UBIQUITl Pro 5-Port Controller
» 5x10/100/1000

Ethernet Data Ports _

» 1x10/100 Ethernet Management Port
» MIPS 24K, 400 MHz Processor

(UBTS5POE) 81.99

atfrer]es SG110D
CISCO 8-Port Network Switch

» 8 x Ethernet Ports

» Fanless Design

» 802.3/3u/3ab/32/3x
Network Standards » 16 Gbps Switching
Capacity » 11.9 Mpps Forwarding Capacity

(CISGT10D08) ..o 49,99

(& TRenDnet TEG-S506
5-Port GREENnet Switch

» |EEE 802.3x Full Duplex Flow Control
» Power Conserving Design

(TRTEGS506) 16.99

(CIS630010) oo 189.99 (CIS620008) oo 86.99
TP-LINK TL-561024 NETGEAR ProSafe
24-Port Rackmount Switch 5-Port Desktop Switch

S » 10/100/1000
» |EEE 802.3i, 802.3u, 802.3ab, 802.3x Mbps Gigabit
» 24:x10/100/1000 Mbps RJ-45 Ports Ethernet
» 48 Gbps Switching Capacity » Up to 2000 Mbps in Full-Duplex Mode
(TPSGT024) oo 9999 (NEGST05NA) 39.95

NETWORK ADAPTERS

" Authorized Reseller USB Ethernet
Adapter

» USB 2.0 to 10/100BASE-T

Fast Ethernet ‘ 3
» For MacBook Air
» Mac 0S Xv.10.4.8
or later
(APMCT04LLA) 29.00

" USB 3.0 Type-Cto
Xcewon® Gigabit Ethernet Adapter
> Supports 10/100/1000BASE-T Networks
» USB 3.0 Type-C Interface

» Integrated 7.3" .
/ 4

USB Cable

» LED Status Indicators &
» USB Bus-Powered
(XCUSBEC) 24.95

PROMISE " SANLink2

TECHNOLOGY, INC.
20 Gb/s Thunderbolt 2 to 10G
Base-T Ethernet Bridge Adapter

» Full Duplex @10 Gb/s

» Auto-Negotiate -
with 1 Gb/s

» Daisy-Chain Support » Dual Thunderbolt 2

Ports » Dual 10GBase-T Ethernet Ports
(PRSL2TB210E) o 499.00

a‘ TU3-ETG uss 3.0
XCELLON™ to Ethernet Adapter
» Supports 10/100/1000BASE-T Networks
» USB 3.0 Type-A

Interface » Integrated

7.1" USB Cable
» LED Status Indicators N

2>

(XCUSBEA) 19.95

kanex KU3CGBT
USB-C to Gigabit
Ethernet Adapter
Connect your MacBook/ %
Chromebaok or any other
USB-C ready computer
directly to Internet.

(KAKU3CBBT) oo 19,95

PROMISE " SANLink2

TECHNOLOGY, INC.
Thunderbolt 2 to 8 Gb/s FC

» Dual 8 Gb/s Fibre Channel Ports
» Dual 20 Gb/s

Thunderbolt 2 Ports -
» Daisy-Chain Support
» Includes Thunderbolt Cable
» Mac Compatible

[PRSL2TB2BGA) ..o 125,00

(& TRenDneT TU2-ET100
USB 2.0 to Ethernet Adapter

» USB 2.0

to 10/100Mbps
o .
»
(TRTUZET100) 12.96

TP-LINK T6-3468
Gigabit PCI Express
Network Adapter

» 1 xGigabit Port

» 10/100/1000Mbps Half-Duplex
»20/200/2000Mbps Full-Duplex
»  32-bit PCl Interface

» LED Status Indicators
(TPTG3468) oo

11199

) EOX95AA Ethernet 1210-T1
GbE Network Interface Card
» 1 xRJ-45 Connector
» PCle x1 Host Interface
» Intel 1210 GhE Controller P
» Audio Video Bridging (AVB) ' |
Support » ECC Memory Support § 3
» DMA Coalescing

(HEEOX95AA) 43.50

308 + 212-444-6691




TP-LINK TC-7610-E
DOCSIS 3.0 Cable Modem

» Compatible with Most Major ISPs

» Eliminate Monthly Fees

» DOCSIS 3.0, 2.0, 1.1, & 1.0 Compatible

» Channel Bonding 4 Upstream

(TPTC7610E) 49.99

NETGEAR CM1000DOCSIS
3.1 Ultra-High Speed Cable Modem
» 1 x Gigabit Ethernet Part

» 1 x Coaxial Connector

» DOCSIS 3.0 & 3.1 Compatible

» Up to 32 Downstream Channels

(NECM1000100N) . 178,99

AR R 1s 5B6183 SURFboard
Cable Modem

» Up to 686 Mbps Download Speed
» DOCSIS 3.0 Support

» 1x Gigabit Ethernet Port

» 1 x Coaxial Connector
(ARSBOTB3)...oo oo

. 99.00

NETGEAR CM600High
Speed DOCSIS 3.0 Cable Modem
» 1 x Gigabit Ethernet Part

» Supports DOCSIS 3.0 Standard

» [Pv6 Compatible

» Advanced Quality of Service Support

» 128MB RAM / 8MB NOR Memory

(NECMODOBLK)..... . 129.99

TP-LINK AV2000
2-Port Gigabit Passthrough
Powerline Starter Kit

.

» HomePlug AVZ Technology =~ %
»|EEE 1901, 802.3/3u/3ab

Standards » 2 x Gigabit - -
Ethernet Ports per Adapte
(TPTLPA9020PK) 96.99

LINKSYS Powerline AV
4-Port Network Adapter Kit
» High Speed of up to

200 Mbps
» 128-bit Encryption
» Connects to Any Device with Ethernet
» Pairs with Any Linksys E-Series Router

(LIPLSKAOONP) 54.99

TP-LINIK TL-PA7020KIT
HomePlug-AV1000 2-Port
Gigabit Powerline Kit

» HomePlug AV2 Compliant

» Up to 1000 Mbps -

» 802.3ufab » 2 x Gigabit "y
Ethernet ports » 984' (300 m) Range

(TPTLPA7020KT) 59.95

NETGEAR PLW1010
Wi-Fi Network Adapter
and Access Point

» Homeplug AVZ Compliant ¥
» 802.11ac Wi-Fi Protocol
» 1 Gigabit Ethernet Port =

» Upt0 5,382 sq ft/ 500 sq m Coveragee
(NEPLW1010) 99.99

J INS-8023AF-0

802.3af Outdoor Adapter
» Transforms PoE devices /
into 48V, 802.3af- .

compliant products
» Works with 802.3af switches

(UBINS8023AF0) 17.99

» 10/100/1000 Mbps Data Rate

» 15W or 30W Power Selector

» §02.3at Compliant

» Plug-and-Play Compatible)
: e

(AX5900334) 143.38

www.BandH.com

J POE-24-12W-G

» Provides grounding
» Protection against surge,
clamping, maximum surge
discharge, and peak pulse current
» Provides protection against ESD attacks

(UBPOE2412W6) 13.99

AXISa T8120

Power over Ethernet Midspan

» 15.4 W of
Maximum Power
» |EEE 802.3af Compliant \
———
B L
(AX5026204) 57.99

CABLE MODEMS

POWERLINE ADAPTERS

NETWORKING

COMPUTERS

MB7420-10 16x4 686 Mbps
DOCSIS 3.0 Cable Modem
» 1 x Coax Cable Connector

» 1 x Gigabit Ethernet Port

» Operating Status LED Indicators

(MOMB742010) 89.99

ARR1s SB6190 SURFboard
DOCSIS 3.0 Cable Modem
» Up to 1.4 Gbps Download Speed
» DOCSIS 3.0 Support » Gigabit
Ethernet Port » Coaxial Connector
» Power/Receive/Send/
Online LED Indicators
(ARSBOTI0)..oooo o

TP-LINK TC-7620
DOCSIS 3.0 Cable Modem

» Compatible with Most Major ISPs

» Eliminate Monthly Fees

» 16 Downstream / 4 Upstream Channels
» |Pvé & IPv6 Dual Stack

(TPTC7620) 69.99

LIN<KSYS (CM3008

DOCSIS 3.0 Cable Modem

(8x4 Bonded Channels)

» DOCSIS 1.1/ 2.0/ 3.0 Certified

» |EEE 802.3/3u/3ab Network
Standards » IPvé Support

» 1 x Gigabit Ethernet Port

(LICM3008) 45.00

TP-LINK TL-WPA4220
AV500 Wi-Fi .
Powerline Extender i

» HomePlug AV Standard

» |EEE 802.3 / 3u Standards

> |EEE 802.11b/g/n Standards
» 2 x Ethernet Ports Pair, Reset, Wi-FiButton

(TPTLWPA4220) 44.56

ZyXEL PLA5256KIT AV1000

Powerline Homeplug Kit
» Enhanced 1000 Mbps

Data Transfer Rates . / i ,

» 2xGigabit LAN Ports ‘mme
» AC Pass-Through Design -
» |EEE 1901 HomePlug AV Compatible

(ZYPLAS256KIT) 59.95

TP-LINK TL-PA010KIT
AV500 Nano Powerline
Adapter Starter Kit
» HomePlug AV standard

compliant
» High-speed data transfer

rate of up to 500 Mb/s » Miniature design

(TPTLPA4D10K) 34.99
ZyXEL PLA5206 KIT
Powerline Ethernet Adapter Kit
» Includes 2 x Powerline ‘0

Network Adapters . "
» HomePlug AV2 ' Lo

Compliant » Up to >

1800 Mbps Data Transfer Rates
(ZYPLABABOKIT) 89.99

J INS-8023AF-I

802.3af Indoor Adapter

Transforms PoE devices
into 48V, 802.3af-

compliant products === [
» Works with 802.3af switches
(UBINSB023AFI) 17.99

ﬂ intellinet T81 3ll 6“W Midspan

» Works with 802.3af/at Compliant Devices

» Provides 30W of Power » Uses Existing
Catbe/6 Cabling

» Power and Data
Transfe » LED
Indicator Lights

» Includes Power Cord

(IN560566) 37.95

J POE-24-24W-G
PEIUT PoE 1A Gigabit Adaptor
» 1 Gigabit LAN/T x PoE Port
» Remote Reset Capability
» 80+% Efficiency
» 65 kHz Switching Frequency
» |EC-320 Co AC Connector

(UBPOE2424W6) 14.95

TP-LINK TL-POE150S

Power Over Ethernet Injector

» |EEE 802.3, 3u, 3af Compliant

» 1x10/100/1000M
LAN Port

» 1 x Power Socket
(DCIN)

» 1x10/100/1000M PoE Port

(TPTLPOE150S) 16.80




COMPUTERS

UVP uniFi VoIP Phone
UBIAUT with Touchscreen
» 5" Full Color, Multi-Touch Display
» Powered by Android
» 1.2 GHz Dual-Core Cortex A9 Processor
» 4GB Storage / 1 6B RAM
» UniFi Phone App Communication Software
» Auto-Provisioning Management Feature

(UBUVP)

150.95

€3 coma’ HD2 Handset
Cordless Handset

» Color Display

» DECT 6.0 Support

» Picture Caller 1D

» Caller ID and Call Waiting

» Voicemail » Intercom » Baby Monitoring
» Signal/HD/Do Not Disturb Indicators

(00HD2HS)

45.83

Jabra’ Speak K10MS speakerphone

» Portable and Compact Design

» Jabra PC Suite Digital Signal Processing
»Omni Directional/Noise Filter Microphane
» Standard (E-STD) Microphone Sensitivity
» LED and Audio Indicators

» Certified by Microsoft

(JA4100CSPM) 89.95
% Duet Executive Desktop Speaker-
EN phone for VoIP and Telephone

» Compact and Discrete
» Integrated Mic and Speaker
» Echo Cancellation and

‘/.'_'

=

Noise Suppression i
» USB Connection » 3.5mm Speaker Output
» RJ-11 Jack for Phone and Bridging
(PHMT202EXE) 152.65

plantronics CT14DECT 6.0

Cordless Headset Phone

» DECT 6.0 for Interference
Free Wireless
» Upto 10 Hours of Talk Time

&

VOIP

vtech 1070 corded Speakerphone

»

»

»

»

»

»

»

(VT89402200)

; GRANDSTREAM GXP2140

Enterprise IP Telephone

»

»

»

»

»

»

(GRGXP2140)

Supports up to 4 Lines

32 x Speed Dial Locations

16 x Intercom Number Locations
Built-in Speakerphone

4 x Lighted Line Indicators

Auto Line Selection

Last 6 Number Redial

4.3" Color LCD Display
480 x 272 Pixel Density
Supports 4 SIP Accounts 2

RJ9 Headset Jack » EHS Headset Compatibility
Dual Switched Gigabit Ethernet Ports » PoE Compatible
Real-Time Web Applications » Automated Provisioning

96.70

Jabra’ Speak5h10+ Biuetooth & USB
Speakerphone (Microsoft Lync Compatible)

»

»

»

Unified Communications Compatible
Supports up to 8 Trusted Devices
Bluetooth Class 1 & 2 Compatible

@,

» Bluetooth AZDP Support
(JAST0BTUSPMS) 179.95
3 POLYCOM
FLXUC 500

revo

»

»

»

»

»

»

(RETOFLXUC500)

VCS754 ErisStation SIP Conference

Phone w/ Four Wireless Mics

» Includes 4 x DECT 6.0
Wireless Mics

» Integrated Base

USB Conference Phone

Built-In Tweeter and Mid-Woofer Speakers
Integrated Echo Cancellation

Full Duplex Technology

For Conference Rooms and Small Offices
For Meetings and Online Collaboration

Extended Response For Foreign Languages

328.59

» Flexible Boom Microphone
» Cuts 96% of Background
Noise » Bluetooth 4.0

~—— . BlueParrott B350-XT

Noise-Canceling Headset

vifvar]re SPAS0LG 4-Line IP Phone with
CISCO 2-Port Switch PoE & LCD Display
» 4-Line Business Class IP Phone with PoE
» Features 2-Port & LCD Display

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Great Voice Clarity by Wideband Audio

[CISPAB046)

103.27

;l’iIQAND&"TQEAN GXV3240
IP Multimedia Phone for Android
» 4.3" Capacitive Touchscreen Display
480 x 272 Pixel Resolution

Runs on Android 4.2 Operating System
Mega Pixel CMOS Camera
Integrated 802.11n Wi-Fi
Integrated QoS Functionality
RJ-9 Headset Jack / USB / SD / Mini-HDMI

(6RGXV3240)

»

215.00

plantronics Calisto P620
Bluetooth Wireless Speakerphone
» Bluetooth v2.1 + EDR

» Mini USB Adapter

» Works with Computers and

Smartphones

» PC Wideband: Up to 6800Hz
» 360° Room Coverage » Compatible with Windows and Mac 0S

(PLP820) 103.65

W poLycom Soundstation 2
Expandable Conference Phone

» Patented Polycom Acoustic Clarity

» Jx Cardioid Intelligent Microphones

» 360 Degrees of Pickup from 10" Away
» Conferences with up to 10 Participants
» Resists Interference From Mobile Phones

» Backlit Display » Connect to Mobile Phones and PCs

(POSS2€ED)

454.95

plantronics Calisto P240
USB Corded Handset
» Simple PC Call Management
» LCD Display
» Personal Speakerphone

4

» Hands-Free Convenience Spea.kerpho.ne _ with Multipoint Technology » Noise-Canceling Microphone

» Up to 300 ft. Range from » Dy Fixed Mlcrophongs in Base. _ » NFC One-Tap Pairing » USB Connection » SoundGuard Technology
Charge Base » Up to 8 Hours Talk Time per Wireless Mic » Wideband Audio and 128-Bit Encryption » Suitable for PC Telephony Users » Portable

(PLCT14RHS) 89.99 (VTVCST54) 335.33 (VX203475) Call or Log-On (PLCP24ONS) 58.99

plantronics ($540
Wireless Headset with HL10

plantronics ($530
Over-the-Ear Wireless Headset

» Lightweight 0.74 oz Headset » Wireless Range Up to 350° » Lightweight 2.5 0z Headset
» Hands-Free Operation to 350° » 4 Different Wearing Options » Hands-free Operation to 350 ft
» Sleek Contemporary Design » Premium Wideband Audio Quality » Sleek Contemporary Design

» Advanced Wideband Audio Tech
» Noise-Canceling Microphone
» T Hour Battery » Includes HL10 Handset Lifter »

[PLCS540HLK) 224.70

[PLCS530HS)

» One-Touch Call Answer/End »
» Conference in 3 Additional Headsets »
Headset Weighs Only 0.74 0z »

One-touch Control
Advanced Wideband Technology

179.99 (PLCS510)

plantronics ($510
Wireless Headset System

Auto-answer Feature » Noise-canceling Mic

plantronics SaviW740
Multi Device Wireless Headset
» Manages PC, Mobile & Desk Phone Calls
» Headset to Mobile Phone Audio Transfer
Hands-free Operation
t0 350 t (100 m)
» Three Customizable
Wearing Styles

171.99 (PLW740) 219.95

800-947-3308 - 212-444-6691




HUBS, KVM SWITCHES, POWER SUPPLY, MOBILE CHARGING STATIONS

a’ 7-Port Powered USB
Xcewwon® 3.0 Aluminum Hub

» 7xUSB 3.0 Ports
» AC Powered
» 1x LED Indicator per P ort
» Up to bGbps Transfer
Speed Per Port
(XCUSB7PHVZ) 49.95

a' USBC-4311W
XCELLON® 4-Port USB 3.1
Gen 1 Type-C Wedge Hub

» Transfer Rates of Up to 5 Gb/s
» Integrated 9.8" USB
Type-C Cable

(XCUSBC4311W) 24.95

a’ USB-4311B
XCELLON® 4-Port
Portable USB 3.1 Hub

» 4xUSB 3.1 (Gen 1) Ports

» Up to5 Gbps Transfer e
Speed per Port

» Hot-Swap & Plug-and-Play

(XCUSB4311B) 14.95

smerent<_ 4-Port USB 3.0 Hub

» 1xUSB 3.0 Type-A Connector i

» 4 x USB 3.0 Type-A Ports jf

» Aluminum Design

» Plug and Play,
Hot Swappable

(SAHBIMCU)........

Q@ rocears 1-PortUSB

KVM Switch ‘

» USB Keyboard
& Mouse
» VGA Display
» Integrated Cables

®rocears -Port USB Cable

KVM Switch

» USB Keyboard
& Mouse

» VGA Display

» Integrated Cables

(106CS220) 16.49 (I0KVMCS4P) 37.99

@ Trenpner 2-Port USB 6 2 Port HDMI USB

KVM Switch ~ SIG  KvM Switch

» Share a single e » Share an HDTV
monitor, keyboard, \ g with 4 USB/HDMI
mouse, microphone [ == Computers » Share a
& speakers USB Keyboard & Mouse » Share a Microphone

» Hot-Key and Push-Button Switching » Supports 3840 x 2160 [@ 30 Hz Resolutions

(TRTK207K) 17.82 (SICEKV061251) 136.53

@crirrin PowerDock Pro B ELKIN. Storeand

Charging Station charge Station \\ -

» Five-Bay USB Charging » Stores and Charges up ‘
Station » Charge 5 Phones to 10 Devices w
and Tablets at Same Time » Fits Most Cases up to 1.18" Thick

» Charge Most Other USB Devices » Holds Laptops or Chromebooks up to 13"

» Fits Phones & Tablets Even with Cases » Built-In Cable Management

(BRNAGTINT) oo 91.99 (BETSCSAC) ....... 170.98

HUBS

KVM SWITCHES

MOBILE CHARGING STATIONS

UNINTERRUPTIBLE POWER SUPPLY (UPS)

COMPUTERS

Q@ rozeEars 4-PortUSB 2.0 Hub
» Compact Size
» Hot Swappable

(104PUSB2H)

B E L K1 N. F4U058TT

SuperSpeed USB 3.0 4-Port Hub

» 4xUSB 3.0 Ports

» b Gbps Max. Data
Transfer Rate

» Easy Installation

(BEF4U0S8TT)

41.99

&) Transcend- 4-Port USB 3.0 Hub

» USB 3.0 Interface

» 4xUSB 3.0 Ports

» USBv1.2
Charging
Specification

(TRUSBPH)

KINGWIN KW-HUB-9U3
Multi-Port USB 3.0 Hub
with 1Q Charging Ports

» 9xUSB 3.0 Ports

» 2xUSB 3.0 10 Charging Ports

» 2.4A Output Current on each 1Q Port

(KIKWHUB9U3) 39.95

®@rocears 1-PortDVI-D
KVM Switch

» USB Keyboard/ &
Mouse Connectors =

» DVl Monitor Connectors

» Line-In (Mic) + Line-Out (Speakers)

(I0DDK2PCSAM) 84.64

<& EXT-DVI-241DL
2x1DVI DL Switcher

(2) dual-link
DVI computers & USB 2.0 keyboard and mouse

» Resolutions up to 3840x2400
» Controlled through IR remote control

(GEDDLS)

493.38

Qroceare §-Port USB PS/2
Combo KVMP Switch
» Connects Directly
to 8 Computers
» Supports 2-Level Cascade
(128 Computers) » USB and PS/2 Support

(I0VK8PSUC) 302.15

?i

StarTech-om §-Port 1U
Rackmount USB KVM Switch
» Supports

Resolutions up Q

t0 1920 x 1440 » USB PC Interface
» 0SD Security » Auto-Scan Function
» Cascade Configuration » Hotkey Functions

(STSV831DUSBK) 299.83

7-Port USB Charging Station
®ruma with Qualcomm Quick
Charge 2.0
» Charge up to Seven

Devices at Once

» Up to 2.4A per Port
» Up to 15.2A Total Power Qutput
(KUCSTQCD) . 74.95

LUXOR LLTP24-B 24 Laptop

Charging Station

» Charges and secures up to
24 laptops/tablets » Rubber-
coated dividers is 1.75" apart

» Two 4" stationary casters and
two full-swivel ball-bearing locking casters

(LULLTP24B.oo ...566.99

l i iSese

Brand CyberPower CyberPower
Model BX1 5l]llM LX13256 BR15006 BX1000M BEI.ZEM BE65061 BE600M1 SE4256
VA / Watts 1500VA / 900W 1000VA / 600W 1500VA / 865W 1000VA / 600W 425VA [ 255W 650VA / 390W 600VA / 330W 425VA [ 255W
Additional Protection RJGS RJT1/RJ45 and Coax RG6 RJ-45/USB RJ-45 & Coax None None UsB RJ-45
Outlets Quantity 10 9 10 8 6 8 7 7
SKU APBX1500M CYCP1000AVRL APBR15006 APBX1000M APBE426M APBE65061 APBE60OM1 CYSE4256
Price 169.99 109.95 167.32 129.99 4.7 75.55 59.99 39.95

www.BandH.com BsH



COMPUTERS

Computer Cables

CABLES

After countless hours of researching and comparing, you've finally purchased the computer you wanted. Whether it was a laptop or a desktop
computer, you'll want to use the full advantage of all the ports. It can be quite daunting to know which cables to use. For starters, most ports
on your computer will have female connectors. Female connectors are ports that you plug into. Cables will usually have male connectors,
which plug into the female connectors on your computer.

There are also different types of ports. Thunderbolt and USB are used to transfer data while DisplayPort, DVI, and VGA ports are used to output
video to an external display, such as a monitor or an HDTV.

7

Thunderbolt

Access high-speed peripherals and high-res displays via one simple port
that carries DisplayPort and PCle data. Thunderbolt™ gives you two chan-
nels on the same connector with 10 Gbps of throughput in both directions.
Thunderbolt 2 pushes that to 20 Gbps by bonding the two channels togeth-
er. While Thunderbolt and Thunderbolt 2 share the same connector as mini
DisplayPort, Thunderbolt 3 utilizes the reversible USB Type-C connector.
Thunderbolt 3 also has a maximum throughput of 40 Gbps and has dual-
bandwidth DisplayPort 1.2 so you can connect to two 4K displays simulta-
neously. Thunderbolt and Thunderbolt 2 are usually found on Mac systems,
and Thunderbolt 3 has been seen on Mac and Windows computers.

DisplayPort / Mini DisplayPort

DisplayPort and mini DisplayPort are usually found on Mac com-
puters, but can be found on some PC computers as well. Display-
Port is a digital display interface that supports video, audio, and
other forms of data in a single cable. DisplayPort is the older,
bigger version while mini DisplayPort is the smaller version that
shares the same design as Thunderbolt.

\

PEARSTONE

Authorized
Reseller

UsB

USB stands for Universal Serial Bus and it lives up to its name since it can
be found on practically every modern computer. You'll notice that USB will
usually have a number next to it. This number is the release name, but can
also be associated with the data transfer speed they support. For example,
USB 2.0 supports up to 480 Mbps while USB 3.0 supports up to 5 Ghps.
USB 3.1 supports up to 10 Gbps. Most computers use the USB Type-A ports
while the USB Type-B port can be found on computer peripherals, such as
printers. The micro-USB port is usually found on mabile devices, such as
smartphones and tablets. USB Type-C is becoming more popular, thanks to
its reversible connector.

DVI

DVI stands for Digital Visual Interface. It transmits uncompressed
digital video. The DVI connector is given one of three names, de-
pending on which signal it uses. DVI-I means it integrates both
digital and analog signals into the same connector. DVI-D means
it only supports a digital signal, single or dual link. DVI-A means it
only supports an analog signal.

Comprehensive

A Division of Wl Vcom International Multimedia Corporation

<@ [A  BELKIN

Hosa Technology

o | orloos | Starffechcom

T

Ethernet

Most laptops have given up the Ethernet jack in favor of Wi-
Fi, but desktop computers and workstations still embrace the
wired Internet connection. Most computers utilize the RJ-45
LAN jack, which plugs into your computer and your router. The
Ethernet jack usually supports 10/100 Mbps Fast Ethernet or
10/100/1000 Mbps Gigabit Ethernet. If you have a 10/100 Mbps
Fast Ethernet jack, a Cath cable should be good enough. Catbe
is an enhanced version of Cat5 and supports 10/100/1000 Mbps.
Cat6 further improves upon Catbe and supports 10 Gigabit Eth-
ernet in certain cases.

VGA

Known as Video Graphics Array, VGA has been around since the 1980s.
While most computers now use more modern technologies, like HOMI
and DisplayPort, certain laptops still sport the analog interface as
an addition, which is useful for backwards compatible with older
projectors and monitors. VGA is usually seen as a 15-pin connector.
On laptops and smaller devices, a mini-VGA connector can be found.

To view a full listing
of all Computer Cables

or visit our website
BandH.com/w15105

800-947-3308 - 212-444-6691



EPSON' Perfection V600

Photo Scanner

» Optical Density: 3.4 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi
» Max Resolution: 12800 x 12800 dpi
» Scans Prints, 35mm & Medium Format Film
» Maximum Scan Area: 8.5 x 11.7

» DIGITAL ICE Scratch & Dust Removal

(EPPV600)

Call or Log-On

Canon CanoScan 9000F Mark Il

Film & Document Scanner

» Optical Resolution: 9600dpi (Film)

» Optical Resolution: 4800dpi (Docs)

» Color Depth: 48/24-Bit
Internal/External

» Scan 35mm Negatives & Slides

» Scan Film, Slides, Documents, Photos .

» Scan Medium Format Film » OCR & PDF Creation Software
Included » My Image Garden Software

(CACSIOOFM2S) ..o

168.98

Fujitsu fi-7160

Document Scanner

» Optical Resolution: 600 dpi

» Scan Speeds of 60 ppm & 120 ipm

» 80-Sheet Automatic Document
Feeder » Duplex Scanning

» Maximum Document Size: 8.5 x 220"

» Minimum Document Size: 2.0x 2.1”

» Output Color Depth of 24-bit

» Double Feed Detection Sensor

(FUFI7160DS)

. 879.99

brother ImageCenter ADS-2800W
Wireless Desktop Scanner -

» Optical Resolution: 600 x 600 dpi
» Interpolated Resolution: 1200 x 1200 dpi
» Scan Speed: 30 ppm Simplex

60 ipm Duplex » Scan Size:

Max 8.5 x 196", Minimum: 2 x 2.76”
» 50-Sheet Automatic Document Feeder
» 3.7 Color Touchscreen; USB Port
» Kofax VRS & TWAIN Compatible » USB 2.0, Ethernet, & Wi-Fi
(BRADS2800W)....... 439.99

Fujitsu ScanSnap S1300i

Document Scanner

» Compact Size

» Scan Speed: 12ppm

» Scan Resolution: 600dpi

» Automatic Duplex Scanning

» USB-Pawered For Increased Portability
» Scan Directly To The Cloud

» Scan To Commonly Used Programs

(FUS13001) v 246845

www.BandH.com

SCANNERS

EPSON Perfection V800

Photo Scanner

» Scans Prints, Film, and Slides

» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi

» Max Resolution: 12800 x 12800 dpi
» Maximum Scan Area: 8.5 x 11.7"

» Set of Four Film Holders

» DIGITAL ICE Scratch & Dust Removal

(EPVBOD) .

w...Callor Log-On

Canon CanoScan LiDE220
Color Image Scanner

» Optical Resolution: 4800 x 4800 dpi
» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Five EZ Buttons & Scan to Cloud

» Letter-Size Scan Speed, 300 dpi: 10 sec

» Color Depth: 48-bit Internal / External

» Advanced Z-Lid & Upright Scanning

» ENERGY STAR Certified and RoHS Compliant

(CAL220) .o

74.70

FujiTsu ScanSnap iX500
Wireless Desktop Scanner

» Color Scan Speed: 25 ppm

» Create Searchable PDFs

» Maximum Scan Area: 8.5 x 34"

» Optical Resolutio:
600 x 600 dpi

» b0-Sheet Automatic Document Feeder

» Scan to Mobile Devices & Cloud Services

» Double-Feed Detection

(FUIX500)......ccc

429.95

brother ImageCenter ADS-2000e
High-Speed Desktop Document Scanner

» Optical Resolution: 600 x 600 dpi

» Interpolated Resolution: 1200 x 1200 dpi
» Speed: 24 ppm Simplex/48 ipm Duplex
» Scan Size: Max. 8.5 x 34", Min. 2x 276"
» 50-Sheet Auto Document Feeder
» 2-in-1 Mode & Continuous Mode
» USB Direct; Android Device Support
» Kofax VRS & TWAIN Compatible » USB 2.0 Connectivity

(BRADS2000E)

Canon imageFORMULA DR-C240

Office Document Scanner

» Optical Resolution: 600 dpi
» Scan Speed: 45 ppm B&W
30 ppm Color

» Maximum Scan Area: 8.5 x 14"
» Minimum Scan Area: 2.0 x 2.8”
» Color Depth: 24-bit

» Automatic Duplexing at up to 90 ipm
» 60-Sheet Automatic Document Feeder

(CADRC24D) ...........

650.00

COMPUTERS

EPSON Perfection V850

Pro Scanner

» Scans Prints, Film, and Slides
» Optical Resolution: 6400 dpi
» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Maximum Scanning Area: 8.5x 11.7" | &
» DIGITAL ICE Scratch & Dust Removal
» SilverFast SE 8 Software Included

» USB 2.0 Connectivity

(EPV850)

_Callor Log-On

Canon CanoScan LiDE120
Color Image Scanner

» Optical Resolution: 2400 x 4800 dpi
» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Color Depth: 48-bit Internal / External
» Letter-Size Scan Speed, 300 dpi: 16 sec

» Four EZ Buttons & Advanced Z-Lid

» Scan to Cloud Function » Powered via USB Port
» ENERGY STAR Certified and RoHS Compliant

(CAL120)

plustelc SmartOffice PS286 Plus

Document Scanner

» Duplex Scanning in Color/Grayscale/B&W

» |Scans Paper Documents and Rigid Cards

» Automatic Document Feeder (50 Pages)

» Create Searchable PDF & MS
Office Files

» Scan To Folder / Network
Email / FTP / Printer

» Scan Speed: 25 PPM » Daily Duty Cycle - 1500 pages

(PLMOPS286) . 256.35

Canon imageFORMULA DR-C225

Office Document Scanner

» Scan Documents and Cards

» Optical Resolution: 600 dpi

» Scan Speed: 25 ppm /50 ipm

» Color Depth: 24-bit

» Duplex Scanning

» Maximum Scan Area: 8.5 x 14"
» Long Document Mode: 118.1”

(CAIFDRC225SC)

EPSON FastFoto FF-640
High-Speed Photo Scanning System

» Scans Photos and Documents

» Optical Resolution: 600 dpi

» Maximum Scan Size: 8.5x 120"

» Minimum Scan Size: 2x 2°

» 4x 6" Scan Speed: 60 ppm/300 dpi
» Document Speed: 45 ppm at 300 dpi
» Single-Pass Duplex ADF

» FastFoto Software with Smart Photo Fix » USB 2.0 Connectivity

(EPFF40) v 649.99




COMPUTERS

PORTABLE SCANNERS / LABEL MAKERS

IRIScan Book 3

Bocumem o knowiedge: POrtable Scanner

» 900 dpi
» Save Scans to \
microSD =
» Scan to JPEG or PDF
» Runs on AAA Batteries
» OCR Software Included

(IR457688) 94.99

Canon imageFORMULA P-2151l Scan-tini
Personal Document Scanner
» 600 dpi Optical
Resolution
» Color Scan Speed
10 ppm /20 ipm
» Color Depth: 24-Bit
» Min Document Size: 2.0 x2.8" » Max Document Size: 8.5 x 39.4”
» 20-Sheet Automatic Document Feeder » Duplex Scanning
» Built-In Card Scanner » Power Over USB » USB 3.0 Connectivity

(CAP21511) 251.99

PORTABLE SCANNERS

< ScanSnap iX100
FU"TSU Wireless Mobile Scanner
» 600 dpi Optical

Resolution
» Min Document Size: 1x 1"
» Max Document Size: 8.5 x 34"
» Scan Speed: 5.2 Secands per Page
» Automatic Stitching of Two-Page Spread
» USB Rechargeable Li-lon Battery » Battery Life: 260 Scans
(FUIX100WMS) 191.00

brother DS-620 Mobile

Document Scanner

» 600 x 00 dpi b . -

» 8 ppm Black and Color

» Scan Documents up
t08.5x 32

» OCR Software

» USB-Powered, No Outlet Necessary

» Scan to Email, Folder, PDF

» Weighs Under 1 tb

(BRDS620)

........ .99.99

DYMO LabelWriter 450 Turbo

USB Label Printer

» Thermal Printing Technology

» Prints 71 Labels/Minute

» Windows & Mac
Compatibility

69.95

(DYLWA50T)

brother PT-P700
PC-Connectable
Label Printer

» Print Resolution: 180 dpi

» Create Labels up to 1" Wide & 11.8" Long
» Thermal Print Technology

» Automatic Cutter

» Print Speed of 1.2" per Second

» USB Port for PC Connectivity » Runs on AC or Battery Power
» Windows and Mac Compatible

[BRPTP700)

\

61.73

LABEL PRINTERS

EPSON WorkForce DS-30

Portable Scanner

» USB-Powered:
No Outlet Required
» Lightweight
Design Ideal For Travel
» Scan Directly To Popular Cloud Services
» Includes OCR Software For Windows/Mac
» Mac & PC Compatible » Includes Travel Case
(EPDS30)

149.99

[ ] Magic Wand

Portable Scanner

» 900 dpi » 8.27" Scan Width

» 98" Maximum Scan Length

» Scan Almost Any Flat Surface

» Battery Operated

» Stores Images on microSD Card

(VUMWPSBS) 49.99

DYIMIO LabelWriter 4XL
Label Printer
» No Ink or Toner Required
» Labels up to 4™ (10.16cm) Wide
» Windows XP, Vista &

Mac Compatible

179.99

(DYLW4XLB)

brother 0L-700

High-Speed Professional
Label Printer

» Print 93 Labels/Minute
» Print Long Banners Up To 3.0°
» Print Postage Stamps & Barcodes
» High Resolution Printing

(300 x 600 dpi) » Auto Cutter
» No Ink Needed » Create/Print Labels Without Software
» Label & Banner Templates Included

(BROL700)

79.00

Bravo 4200

TECHNOLOGY, INC. AutoPrinter

» Automatically Prints CDs and DVDs

» Print Only, No Drives

» 100 Disc Capacity

» 4800 dpi Inkjet Printing

» USB 3.0 Connectivity

» Windows & Mac
Compatible

Bravo 4200 (PRBRAV04200)

1,595.00

OPTICAL MEDIA PRINTERS

DYIVIO Rhino 5200
Labeler Hard Case Kit

» Lithium lon Battery Included

» Easily Print Labels On The Job

» Print Labels Up To 19 mm Wide

» Backlit For Low Light Installations

» Pre-Programmed Symbol Library

» Slip-Resistant Rubber Grip » Print Bar Codes
» Complies W/ ANSI/TIA/EIA-606-A Standards
(DY1756589)

Call or Log-On

brother PT-D210
Portable Label Maker
» Standalone Operation
» Print Resolution: 180 dpi = &0,
» Works with TZe Tape Family ;
) . . o

» Max Tape Size: 0.47" x 26.2 <
» Max Print Speed of 0.8” per Sec. j b
» Prints up to 2 Lines &

30 Label Memory » 1-Line LCD Display & QWERTY Keyboard
» Thermal Print Tech. & Manual Cutter » Runs on 6 x AAA Batteries

(BRPTD210) 32.00

EPSON Discproducer
Autoprinter
» Windows Compatible
» 100-Disc Capacity
» Print Up to 95 Discs an Hour
» Max Printing Resolution

1440 x 1440 dpi
» All-In-One Software » USB Interface
» Reliable Media Handling Tech » Compact Rugged Construction
(EPPP100AP) 1,950.00

[

MICROBOARDS

crosoaros PE-Pro Autoprinter
Optical Disc Printer |
» 100-Disc Capacity
» 4800dpi » USB 2.0
» Mac & Windows Compatibility
» Asingle set of ink cartridges can
produce anywhere between 850 and
1,500 discs

[MIPFP1000) 2,195.00

800-947-3308 - 212-444-6691




Budlee Create 3D

Printing Pen

» Simplified & Intuitive
Controls

» Two Speeds &
Two Temp Settings

» Lightweight,
Aluminum Design

» Ambient Light Bar

(3D00DCREUS)

@ makerBot: Replicator+
Desktop 3D Printer

» 11.6x 7.6 x 6.5 Build Volume
» 100-400 Micron Layer Resolution
» Single Extruder Nozzle
» Uses 1.75mm MakerBot
PLA Filaments » Print from USB,
Ethernet, or Wi-Fi » Flex Build Plate with Grip Surface
» Open Print Chamber » Factory-Leveled
» Supports CAD, STL, and more

(MAMPO07825) e 2,499.00

> Nobel 1.0 Stereolithography
-~ ;
AYZA& 3D Printer & Scanner

» Uses Stereolithography Technology

» 5x5x7.9" Build Volume

» 25-Micron Layer Resolution

» Uses Phatopolymer Resin

» Plug-&-Play Printer Requires No Software
» Connect via USB Stick or USB Cable

» Accepts .stl or .3w Files H

» 2.6" Display » Mac & Windows Compatible

(Xy3L10xusooc) 1,060.00
robo N

3D Printer

» Build Volume: 5 x5 x 6"

» 20-300 Micron Layer Resolution

» Single Extruder Nozzle

» Print from Wi-Fi and USB

» 3.5” Color Touch Screen

» Automatic Self-Leveling Print Platform
» Travel Speed: up to 250mm/s » Print Speed: up to 16mm3/s
» Windows, Mac, i0S, and Linux Compatible

[ROC2CS3DP) 799.99

MdTTEI o FOMM 3D Scanner

» Max Height & Diameter
Scan: 9.8x7"

» Max Weight Scan: 6.6 bs

» HD CMOS Sensor
with Two Lasers

» USB 2.0 Interface

» Mac & Windows Compatible

(MAMFSIVIR) 466.99

www.BandH.com

3D PRINTERS & SCANNERS

CRE! 3D Pen
Starter, Black/Silver

» One CreoPop 3D Pen

» 3 Ink Cartridges (Red, Orange, Cyan)

» Uses Light-Sensitive Photopalymer Inks
» Charges via USB

» Operates Cordlessly After Charging

» No Hot Parts; Safe for Children

» Accepts Wide Variety of Inks

(CRSKUOO1) ...... Call or Log-On

€ FLASHFORGEUSA (reator Pro
3D Printer

» Build Volume: 8.9 x5.7x5.9" (
» 100 Micron Layer Resolution

» Dual Extruders for 2-Color Printing
» Uses ABS & PLA Filament

» Print from SD Card or USB

» Integrated LCD Screen

» Sturdy Metal Frame

» Mac, Windows, & Linux Compatible

(FL3DFFGNPRO)

899.00

> da Vinci 1.0 All-in-One
-~ i
ﬂﬂ”'ﬁ 3D Printer & Scanner

» Build Volume: 7.9 x 7.9 x 7.5”

» 100-Micron Resolution

» Scan Volume: 5.9 x5.9”

» 250-Micron Scan Resolution

» Uses 1.75mm ABS & PLA Filament
»STL, .3W, .DAS File Formats Supported
» 2.6 Four-Line Display Panel

» Windows & Mac Compatible

(XY3ST0AXUSOC) .

799.99

%) DREMEL 30 3D Idea 3D40 Builder
D
_IDEA BUILDER 3p printer

» Build Volume: 10x 6 x 6.7
» 100-Micron Resolution
» Only Uses Dremel 1.75mm
PLA Filament
» Pre-installed Single Extruder
» 4GB of Internal Storage, USB Port - ;
» Removable Build Plate » 3.5" Full-Color IPS Touchscreen
» Wi-Fi, Ethernet, & Mobile Apps » Mac & Windows Compatible

(DR3D4001) 1,299.00

vV Handheld 3D Scanner
» Portable, Full Color 3D Scanner
» Scan Volume: 8 x 12
» Operating Distance: 14 to 18
» Maximum Resolution: 350 Microns
» Uses Xenon LED Flash Bulbs, No Lasers
» 0.1 Second Scan, 30 Second Processing
» Fuel3D Studio Software Included » Exports STL, PLY, & 0BJ Files
» Built-In Tripod Mount » Compatible with Windows 7 and Up

(FUHH3DSSYS) 1,490.00

COMPUTERS

~1==3) Micro 3D Printer

» h.3xh.6x45" Build Volume

» 50-Micron Layer Resolution

» One Extruder » Supports
ABS, PLA, Nylon, & more

» Micro Mation Sensor Chip

» Aerospace Grade Ceramic
Heater System » Self-Leveling Build Plate » Filament
Compartment » USB Interface » 1.75mm PLA Filament Included

(M3M3DPFBLK)

€ FLASHFORGEUSA Dreamer
3D Printer

» 9.1x5.9x5.5" Build Volume
» 100-Micron Resolution
» Dual Extruders for

2-Color Printing
» Compatible with ABS, PLA

& PVA Filament
» Print from SD Card, USB, or Wi-Fi » Mutli-Language LCD screen
» Multiple User LED Pixel Strips » Self-Calibrating Build Platform

(FL3DPRINTERD) 998.99

da Vinci Junior 1.0

>
-~ 3
/fﬁ(lm 3D Printer

» Build Volume: 5.9 x5.9x 5.9”

» 100-Micron Layer Resolution

» Uses 1.75mm PLA Filament

» Print via USB 2.0 Cable & SD Card

» STL, .3WFile Formats Supported :

» Single Extruder » 2.6” Display Panel -__.'Ql
» Auto Calibration, Enclosed Build Chamber

» Windows & Mac Compatible

(XY3F1J0XUS00)

AFINIA 3D H400
3D Printer

» 4T x 4.7 x 47 Build Volume

» 150-350 Micron Layer Resolution

» Single Extruder Nozzle

» Uses 1.75mm ABS and PLA Filaments

» Print from USB 2.0 and Wi-Fi

» Heated Print Bed » Enclosed Print Chamber

» Auto-Nozzle Height Detection » Factory-LeveledWindows, Mac,
and i0S Compatible

(AFH400)

599.00

AFINIA 3D ES360

3D Scanner with Turntable

» Max Free Scan Volume:
27.6%x27.6x27.6"

» Max Auto Scan Volume:
85Hx86x79"

» 170 - 200 micron Point Distance

» White Light Source » 1.3MP Resolution

» Supported File Formats: STL, ASC, 0BJ

» Windows Compatible

(AFES360)




COMPUTERS

LASER PRINTERS

RICOH SPC250DN

Color Laser Printer

» Print Resolution: 2400 x 600 dpi

» Print Speed: 21 ppm

» Maximum Print Size: 8.5 x 14

» Mabile Device Printing

» Automatic Duplexing; USB Host Part
» 250-Sheet Input Tray & 1-Sheet Bypass
» USB 2.0, Ethernet, & Wi-Fi Connectivity
(RISPC2500N) e 104.51

brother HL-L8350CDW

Wireless Color Laser Printer

» Print Resolution: 2400 x 600 dpi
» Print Speed: 32 ppm

» Paper Capacity: 300 Sheets

» First Print Out Time: < 15 Sec.

» Automatic Duplex Printing

» Maximum Print Size: 8.5 x 14"

» Front-Access USB Direct Printing
» Wi-Fi 802.11b/g/n, USB 2.0, and Ethernet

(BRHLL8350CDW) e 365.78

brother HL-L2340DW
Monochrome Laser Printer
» Max Resolution: 2400 x 600 dpi
» Max Document Size: 8.5 x 14"
» Print Speed: 27 ppm

» Automatic Duplex Printing

» One-Line LCD Display

» One-Sheet Manual Bypass

» Input Capacity: 250 Sheets » USB 2.0 and Wi-Fi Connectivity
(BRHLL2340DW) R 109.00

LaserJet Pro M402n

Monochrome Laser Printer

» Print Resolution: 600 x 600 dpi e

» Maximum Print Size: 8.5 x 14"

» Minimum Print Size: 3 x "

» Print Speed: 40 ppm

» Mabile Printing

» 7-Line Backlit LCD; USB Host Port
» 100-Sheet & 250-Sheet Input Trays » Monthly Cycle: 80,000 Pgs.
» USB 2.0 and Ethernet Connectivity

(HEM402N) S 269.00

Canon imageCLASS MF414dw

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax - =
» Print Resolution: 1200 x 600 dpi

» Maximum Print Size: 8.5 x 14”

» Print Speed: 35 ppm

» Scanner Glass Size: 8.5 x 11.77

» 3.5" Color Touchscreen LCD; Direct USB
» 50-Sheet Multipurpose & 250-Sheet Trays
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(CAMF414DW) [ 399.00

COLOR LASER PRINTERS

LaserJet Pro M477fdw

All-in-One Printer - 3
» Print, Scan, Copy, Fax b
» Print Resolution: 600 x 600 dpi Fee— s
» Print Speed: 28 ppm b

» Optical Scan Res.: 1200 x 1200 dpi T
» Maximum Document Size: 8.5 x 14"
» Auto Duplexing » 4.3" Color Touchscreen; USB Host Port
» USB 2.0, Ethernet, and Wi-Fi with NFC

(HEM477DW)..

629.00

brother MFC-9330CDW

Wireless Color Laser Printer

» Print, Scan, Copy, Fax
» Print Resolution 600 x 2400 dpi
» Automatic Duplex Printing
» Wi-Fi. Ethernet, AirPrint, Cloud Print
» Print/Scan with USB Drive
Mobile Device » Input Capacity
261 Sheets » Scan Resolution 1200 x 2400 dpi
» Monthly Duty Cycle 30,000 Pages » Internal Memory 192 MB

(BRMFC9330CDW) 369.99

MONOCHROME LASER PRINTERS

brother MFC-L2700DW

All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Resolution: 2400 x 600 dpi

» Max Print Size: 8.5 x 14”

» Automatic Duplex Printing

» Flatbed Max Scan Size: 8.5x 11.7°
» 35-Sheet ADF & 250-Sheet Input Tray
» Monthly Cycle: 10,000 Pages » USB 2.0, Ethernet & Wi-Fi
(BRMFCL2700DW) 169.99

LaserJet Pro M225dn

All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 1200 x 1200 dpi
» Print Speed: 26 ppm /16 ipm

» Document Size: Max. 8.5 x 14

» Optical Scan Resolution: 600 dpi
» 35-Sheet ADF / 250-Sh; Input Tray
» USB 2.0 & Ethernet Connectivity

(HEM225DN) .

279.00

Canon imageCLASS MF236n

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 600 x 600 dpi

» Print Speed: 24 ppm

» Optical Scan Resolution: 600 x 600 dpi
» Flatbed Scan Area: 8.5x 11.7

» Max Document Size: 8.5 x 14

» 250-Sheet Input Tray & 3b-Sheet ADF
» Monthly Duty Cycle: 15,000 Pages » USB 2.0 & Ethernet Connectivity

(CAMF236N)... 199.00

LaserJet Enterprise M553dn

Color Laser Printer ——
» Print Resolution: 1200 x 1200 dpi N
» Maximum Print Size: 8.5 x 14
» Minimum Print Size: 3 x "
» Print Speed: 40 ppm :
» Automatic Duplex Printing » 4-Line Dimmable Color LCD
» Input Capacity: 650 Sheets » Monthly Duty Cycle: 80,000 Pages
» USB 2.0 and Ethernet Connectivity
(HEMB53DN)

Call or Log-On

brother MFC-L8850CDW

Wireless Color All-in-One Laser Printer

» Print, Copy, Scan, Fax » Print Resolution: 2400 x 600 dpi
» Max Print & Scan Size: 8.5 x 14”

» Print Speed: 32 ppm

» Auto Duplex for AU Functions

» Optical Scan Res.: 1200 x 2400 dpi

» 50-Page Auto Document Feeder

» Supports Mobile Device Printing

» Wi-Fi 802.11b/g/n, USB 2.0, & Ethernet

(BRMFCL8850CD)

brother DCP-L2540DW

Wireless All-in-One Laser Printer

» Print, Copy, Scan

» Print Resolution: 2400 x 600 dpi
» Automatic Duplex Printing

» Optical Scan Res.: 600 x 2400 dpi
» Flatbed Scan Size: 8.5x 11.7"

» USB 2.0, Ethernet, & Wi-Fi Connectivity

(BRDCPL25400W) 139.99

LaserJet Pro M203dw
Laser Printer
../
» Maximum Print Size: 8.6 x 14
» Minimum Print Size: 3 x 5" ‘(
» First Print Out Time: 6.6 Seconds ’
» Automatic Duplexing at up to 18 ppm » 250-Sheet Tray &
(HEM203DW) e 199.00
W Xpress M2835DW
Monochrome Laser Printer
» Print Speed: 29 ppm
» Max Document Size: 8.5 x 14"
» Automatic Duplex Printing
» Multi-Purpose / Bypass Paper Feed
» Monthly Cycle: 12,000 Pages » USB 2.0, Ethernet, Wi-Fi with NFC

» Print Resolution: 1200 x 1200 dpi = — 0
» Print Speed: 30 ppm
10-Sheet Priority Tray » USB 2.0, Ethernet, & Wi-Fi Connectivity
» Max Resolution: 4800 x 600 dpi ‘
aa—
» Min Document Size: 3 x 5"
» Input Capacity: 261 Sheets
(SAM28350W) e 89.00

800-947-3308 - 212-444-6691




Canon PIXMAMX922
Wireless Color All-in-One Inkjet Office Printer
» Print, Scan, Copy, Fax %
» 9600 x 2400 Color dpi
» 15 ipm Black, 10 ipm Color
» Wi-Fi, Ethernet, AirPrint
» Cloud » Auto Duplex
» 2400 x 4800 dpi

Optical Scan Resolution
» ADF for Multipage Scan, Copy, Fax » Print on CD, DVD, Blu-ray

[CAMX922) . 99,99

-

L R LI}
-

7) PageWide Pro 577dw

All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax

» HP PageWide Technology

» 2400 x1200 dpi Color Print Res
» Max Document Size: 8.5 x 14”

» Print Speed: Up to 42 ppm (1S0)
» Auto Duplex Print, Scan, & Copy
» Print & Scan with USB Drive

» Wi-Fi, USB 2.0 & Ethernet

[HES770W) oo Calll or Log-On

EPSON WorkForce WF-3620

Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax

» Resolution: 4800 x 2400 dpi

» 8.5x 14" Max Document Size
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» 250-Sheet Tray

» Wi-Fi & Ethernet Connectivity

(EPWF3620) ... Call or Log-On

EPSON WorkForce WF-7610

Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax

» Resolution: 4,800 x 2,400 dpi
» Max Document Size: 13 x 19"
» Automatic Duplex Printing

» Scan Res: 1,200 x 2,400 dpi
» 4.3" Color LCD Touchscreen
» 35-Sheet ADF & One 250-Sheet Tray

» Monthly Cycle: 20,000 Pages » Wi-Fi and Ethernet Connectivity

(EPWF7610) ... Call or Log-On

brother WorkSmart Series MFC-J460DW

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 6000 x 1200 dpi

» Duplex & Borderless at
upto85x11” .

» Scan Res: 2400 x 1200 dpi fm s, SO

» Max Document Size: 8.5 x 14”

» 1.8” Color LCD; USB Host Port » Mobile Printing Support

» 100-Sheet Input Tray & 20-Sheet ADF » USB 2.0 and Wi-Fi

[BRMFCJAB0DW . 19:99)

INKJET PRINTERS

Canon PIXMATS9020
Wireless All-in-One Inkjet Printer
» Print, Scan, Copy
» Print Resolution:
9600 x 2400 dpi
» Max. Print Size: 8.5 x 14"
» Print Speed: 15 ipm
Black / 10 ipm Color
» Optical Scan Resolution: 2400 x 4800 dpi » 6-Color Ink System
Duplex Printing » 5.0" Touchscreen LCD; SD Card Slot
(CATS020W) . 189,99

7 Officejet Pro 8710
All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax
» Print Res: 4800 x 1200 dpi
» Print at 22 ppm

Black & 18 ppm Color
» Borderless

and Auto Duplex Printing
» Max Flatbed Scan: 8.5 x 11"
» USB 2.0, Ethernet, & Wi-Fi

(HEQIB7T0)

wo...Callor Log-On

EPSON' WorkForce WF-3640

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 4,800 x 2,400 dpi
» Max Document Size: 8.5 x 14”
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» Two 250-Sheet Trays

» Wi-Fi & Ethernet Connectivity

(EPWF3640)

199.99

EPSON Expression Home XP-430

Small-in-One Inkjet Printer

» Print, Scan, Copy

» Print Resolution: 5760 x 1440 dpi
» Maximum Print Size: 8.5 x 44"

» Optical Scan Resolution: 1200 dpi
» Maximum Scan Size: 8.5x 11.7
» 2.5” LCD Touchscreen & SD Card Slot
» Four DURABrite Ultra Pigment-Based Inks

» Apple AirPrint & Google Cloud Print » USB 2.0 & Wi-Fi Connectivity

(EPXPA0) . 99,99

brother MFC-J6930DW

Wireless All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Print Resolution: 4800 x 1200 dpi |

» Speed: 22 ppm Black / 20 ppm
Color » Max Print Size: 11 x 17

» Optical Scan Resolution
2400 x 1200 dpi

» Flatbed Scan Area: 11.7x 17" » Auto Duplexing; 50-Sheet ADF

» 100-Sht Multipurpose & 500-Sheet Trays » 3.7" Touchscreen LCD;

(BRMFCJO930DW . 29121

COMPUTERS

Canon PIXMAMG5721
Wireless All-in-One Inkjet Printer
» Print, Scan, Copy

» Max Resolution: 4800 x 1200 dpi

» Max Printable Area: 8.5 x 14"

» Print Speed: 12.6 ipm Black
9ipm Color » Optical Scan o
Resolution: 1200 x 2400 dpi » Max Scan Size: 8.5 x 11.7"

» Automatic Duplex; Borderless Printing

» Five-Color Hybrid Ink System » 2.5” LCD; Mobile Printing

[CAMBBT21BS). o O8LTT

" OfficeJet 4650

All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax

» HP Instant Ink Program Ready

» Print Res.: 4800 x 1200 dpi

» Print Speed: 9.5 ppm
Black/ 6.8 ppm Color -

» Auto Duplex and Borderless Printing

» Max Document Size: 8.5 x 14"

» USB 2.0 and Wi-Fi Connectivity

[HEQJA650) ..o

- 99.99

EPSON  WorkForce WF-2630

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Resolution: 5760 x 1440 dpi
» Max Paper Size: 8.5 x 47.2"

» Borderless Prints up to 8.5 x 11"
» Optical Resolution: 2400 dpi

» 100-Sheet Input Tray

» 30-Sheet ADF

» Duty Cycle: 3,000 Pages » Wi-Fi and USB 2.0 Connectivity

(EPWF2630A10P) 99.99

EPSON Expression Premium XP-630
Small-in-One Inkjet Printer

» Print, Scan, Copy

» Max Res: 5760 x 1440 dpi

» Max Print Size: 8.5 x 11"

» Borderless Prints up to 8 x 10"
» Automatic Duplex Printing

» Scan Resolution: 2400 dpi

» Max Scan Size: 8.5 x 14"

» Memory Card Slot and USB Port » USB 2.0 and Wi-Fi Connectivity

[EPXPO30) . 149,99

brother MFC-J5720DW Business Smart Plus
Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Print Res: 6000 x 1200 dpi

» Max Print Size: 11 x 17"

» Borderless Printing to 8.5 x 117

» Auto Duplex Print, Scan, Copy

» Optical Scan Res: 2400 x 2400 dpi
» 3.7" Swipe LCD Touchscreen » Input Capacity: 500 Sheets
» USB 2.0, Ethernet, & Wi-Fi Connectivity

[BRMFCIBT200W) ..

i 229.99

www.BandH.com BgH
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Canon PIXMAPR0-100

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi
» Print 8 x 10" in 51 Sec.
» §Ink Cartridges

Including 3 Monochrome
» Wi-Fi, Ethernet, AirPrint,

PictBridge » Print Sizes up to 13 x 19"
» (D, DVD, Blu-ray Printing » Print Studio Pro for Phatoshop, DPP
(CAPP100) S 379.99
PIXMA PRO-10 (cAPP10)

Canon PIXMAiP8720

Wireless Inkjet Photo Printer

» Print Res.: 9600 x 2400 dpi
» Upto 13 x 19" Print Size

» 14.5Black ipm

» 10.4 Color ipm ——
» 6-Color Ink System with Gray o =N
» Prints Borderless 4 x 6" Photo in 36 sec

» Can Print on CD, DVD, and Blu-ray Discs

» Auto Power On and Off Settings » Wi-Fi 802.11 b/g/n

(CAIP8720) [ 249.99

EPSON' SureColor P400

Wireless Color Inkjet Printer

» Max Res.: 5760 x 1440 dpi

» Max Print Area: 13 x 129"

» Borderless Prints to 13 x 19"
» Roll Media up to 13" Wide

» Epson MicroPiezo AMC Print Head
» AccuPhoto HG Imaging Technology » 8 UltraChrome HG?2 Pigment-

Based Inks » Advanced Media Handling & Disc Printing
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSPA40D)

Call or Log-On

EPSON Expression Photo XP-960

Small-In-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Res.: 5760 x 1440 dpi

» Max Print Size: 8.5 x 14"

» 6-Color Claria Photo HD Ink Set
» Print Speed: 9.5 ppm Black / 9 ppm Color

» Auto Duplex Printing & Copying » Scan Resolution: 4800 dpi
» Max Scan Size: 8.5 x 11.7" » Memory Card Slot & USB Port
» USB 2.0, Ethernet, & Wi-Fi

(EPXP960) e 299.99

PHOTO PRINTERS

Canon imagePROGRAF PR0-1000
17” Professional Photographic Inkjet Printer
» Max Resolution: 2400 x 1200 dpi
» Max Print Size: 17 x 22"
» Speed: 17 x 22"
in 4 Min 10 Sec
» Borderless at up to 17" Wide
» FINE Printing Technology » L-COA PRO Image Pracessing Engine
» 12 LUCIA PRO Pigment-Based Inks » 3.0" Color LCD
» Canon PRINT App, PIXMA Cloud Link » USB 2.0, Ethernet, & Wi-Fi

(CAPP1000).... 1,299.99

Canon PIXMAiP7220

Wireless Color Photo Printer

» 9600 x 2400 Color dpi
» 15 ipm Black
10ipm Color
» Borderless Photos
upto85x11”
» Wi-Fi & AirPrint
» Auto Double-Sided Printing
» CD & DVD Printing » Full HD Movie Print
(CAIP7220).....

89.99

EPSON' SureColor P600

Wireless Color Inkjet Printer

» Max Resolution: 5760 x 1440 dpi

» Max Printable Area: 13 x 129"

» Borderless Prints up to 13 x 19"

» Accepts Roll Media up to 13" Wide

» 9 UltraChrome HD Pigment-Based Inks

» Auto-Switching Black Ink Technology » Tilting 3.5" Color LCD
Touchscreen » Advanced Media Handling & Disc Printing

» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSP0O).....

Call or Log-On

EPSON Artisan 1430
Wireless Color Inkjet Printer
» 5760 x 1440 Optimized dpi
» 2.81S0 ppm Black
and Color » Borderless
Prints up to 13 x 19"
» Print from Mobile Device
» Wi-Fi » PictBridge
» Print Directly on CD & DVD
» Individual Ink Cartridges

(EPAT430) ...

Call or Log-On
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Canon

o

Toner for Laser Printers

Ink for InkJet Printers

Canon PIXMAiP2820
Inkjet Photo Printer \ ‘

» Color Print Resolution: —
4800 x 600 dpi

» §ipm Black &
4 ipm Color

» Printupto 8.5x 14" -‘_

» Can Print on US #10 Envelopes £

» Works with Plain and Glossy Paper » Quiet Mode

» 60-Sheet Automatic Document Feeder » USB Connection

(CAIP2820)

=

Canon PIXMAiP110
Mobile Inkjet Photo Printer

» Max Res: 9600 x 2400 dpi

» Max Print Size: 8.5x 23

» Print Speed: 9 ipm Black

5.8 ipm Color

» Borderless 4 x 6" Photo 53 Sec.
» Borderless Printing up to 8.5” Wide
» 50-page Auto Document Feeder

» USB 2.0 & Wi-Fi » Wireless PictBridge & Mabile Printing

(CAIPT10) [ 199.75

Canon PIXMAiX6820

Wireless Inkjet Printer

» Print Res.: 9600 x 2400 dpi
» Upto 13 x 19" Print Size
» Prints Borderless

4x 6" Photo in 36 sec
» 802.11 blg/n

Wi-Fi Connectivity » 150-Sheet Automatic Feeder
» 14.5 Black ipm & 10.4 Color ipm » 5-Color Ink System
» Auto Power On & Off Settings » Ethernet Port

(CAIX6820) [ 89.99

EPSON' PictureMate PM-400

Personal Photo Lab

» 5760 x 1440 dpi

» Print 4.0 x 6.0 Photo in 36 Seconds

» Print from Memory Cards al
» Borderless Prints ﬂ;f il 1
» 2.7" Color LCD Preview Display |

» Support for SD Cards .

» USB 2.0 and Wi-Fi Connectivity

» Capacity: 50 Sheets Plain Paper
(EPPM400) e 249.99

INK, TONER & CARTRIDGES

Ink for Large Format Printers

n B:H 800-947-3308 + 212-444-6691

To view a full listing of all
Ink, Toner & Cartridges

or visit our website
BandH.com/w15100




EPSON' SureColor P800

17” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Print Size: 17 x 22"

» Print Speed: 8 x 10" in 113 Sec.

» Borderless Printing up to 17 Wide
» Epson MicroPiezo AMC Print Head
» 9 UltraChrome HD Pigment-Based Inks

» Auto-Switching Black Ink Technology » Advanced B & W Made

» Opt. Adapter for 17 W Roll Media » USB 2.0, Ethernet, & Wi-Fi

(EPSCPO0SE)

EPSON' SureColor 75270
36” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 36

» Speed: 22 x 34" Plot in 5 Seconds
» Handles Media up to 59 mil Thick
» Holds Roll Media with 2" or 3" Cores
» 5-Color UltraChrome Pigment Ink Set
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT5270SR)

") Designjet T120
24” Color Inkjet ePrinter

» Resolution: 1200 x 1200 dpi J

» Print Speed: 40 A1
Prints / Hour

» Ethernet, Wi-Fi
AirPrint, ePrint

» Print Sizes Up To 22x34” (D)

» Roll Printing Up To 24” Wide

» Compatible With Media up to 280gsm

(HET12024)

- =
HA e

- 999.00

Canon imagePROGRAF PR0-2000
24” Prof. Photo Large-Format Inkjet Printer

» Max Printable Width: 24"

» Max Resolution: 2400 x 1200 dpi
» FINE Print Head Technology

» L-COA PRO High-Speed Engine

» 12 LUCIA PRO Inks; No Black Switching
» Sub-Ink Tank System; 32068 Hard Drive
» 35" LCD Touchscreen; USB Direct Print
» USB, Ethernet, & Wi-Fi Connectivity

(CAPP2000) ... 2,695.50
Canon imagePROGRAF iPF8400SE
44” Large Format Printer

S

» Resolution: 2400x1200dpi
» LUCIA EX 6-Color Inks
» Holds 2 & 3" Rolls
with 5.9” Diameter
» Max Print Size: 44" x 59’
» Media up to 31.4 mil Thick
» Variety of Borderless Printing Options » Internal Memory: 384MB
» USB 2.0 & Ethernet Interfaces » Printer Stand & Media Basket
(CAIPFB400SE)

www.BandH.com

LARGE FORMAT PRINTERS

EPSON' SureColor P6000
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 24"

» Print Speed: 16 x 20" from 2:02
» PrecisionCore TFP Print Head

» PrecisionDot Screening Technology
» 9 UltraChrome HD Ink Set

» Auto-Switching Black Ink Technology
» 2.7" Color LCD Screen; Built-In Cutter » USB 2.0 and Ethernet

(EPSCP6000SE] .. 2,495.00

EPSON' SureColor T3270
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 24"

» Speed: 22 x 34" Plot in 28 Seconds
» Handles Media up to 59 mil Thick

» Holds Roll Media with 2" or 3" Cores
» b-Color UltraChrome Pigment Ink Set
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT3270SR) . 2,795.00

P Designjet T520

24” Color Inkjet ePrinter —

» Print Resolution: 1200dpi
» Print Speed: 275 Sg. Feet;/Hour
» Ethernet & Wi-Fi Connectivity
» Qutput 24.0” Wide Sheets & Rolls
» Roll Feed With Automatic Cutter
» Print On Heavy Media Up
To 280gsm
» Internal Memory: 16B
(HETB2024) .o

w..Callor Log-On

Canon imagePROGRAF iPF6400
24” Wide Format Inkjet Printer

» Print Resolution: 2400x1200dpi
» Ethernet Connectivity
» Ink: 12-Cartridge Lucia Ex System
» On-The-Fly Ink Replacement
» Plug-Ins For Photoshop

and Microsoft Office
» Supports Heavy Media Up To

59 Mil Thick » Internal Memory: 384 MB

(CAIPF6400) ......... 2,845.00

Canon imagePROGRAF iPF780

36” Large Format Printer

» Max Res: 2400 x 1200 dpi

» Max Print Size: 36" x 59’

» Speed: 24 x 36" Draw in 21 sec

» Five-Color Dye / Pigment
Reactive Ink Set

» Sub-Ink Tank System

» Economy Print Mode » Optimized Module for AutoCAD

» PosterArtist Lite Software » USB 2.0 and Ethernet Connectivity

(CAIPF780)............. 3,820.75

COMPUTERS

EPSON' SureColor P7000 Standard Edition
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 24

» Print Speed: 16 x 20" from 2:02

» PrecisionCore TFP Print Head

» PrecisionDot Screening Technology
» 11 UltraChrome HDX Inks with LL Black
» Auto-Switching Black Ink Technology

» 2.7" Color LCD Screen; Built-In Cutter » USB 2.0 and Ethernet

(EPSCP7000SE)

EPSON' SureColor P5000 Standard Edition
17” Wide-Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 17"
(Borderfree) » PrecisionCore TFP
Print Head Technology

» Precision Dot Screening Tech

» 11 UltraChrome HDX Pigment Inks with LLK » Auto-Switching
Black Ink Technology » Auto-Switching Roll Feed & Front Tray
» 2.7" LCD Screen; Auto Cutter » USB 2.0 and Ethernet Connectivity

(EPSCP5000SE)

7 Designjet 23200PS

44” Photo Printer
» Optical Resolution: 1200 dpi
» Print Up To 44x66” Sheets
& 44" Rolls
» Print On Heavy Media
Including Canvas

» 12-Cartridge Ink System With 4 Blacks

» Embedded X-Rite Spectrophotometer » Ethernet Connectivity

» Large 256 MB Built-In Memory » Built-In 80GB Hard Drive
(HEZ3200PSQ) oo Call oF Log-On

Canon imagePROGRAF PRO-4000

44” Professional Photo Large-Format Inkjet

» Print Resolution: 2400x1200dpi

» Max Printable Width: 44"

» FINE Print Head Technology

» L-COA PRO High-Speed
Processing Engine » Color
Densitometer for Calibration

» 12 LUCIA PRO Inks; No Black Switching » Sub-Ink Tank System;
32068 Hard Drive » USB 2.0, Ethernet, & Wi-Fi Connectivity

(CAPP4000)

Canon imagePROGRAF iPF670

24” Large Format Printer

. T ———
» Max Res: 2400 x 1200 dpi =i —

» Max Printable Width: 24

» Print Speed: 23.4x 33.1"
from 28 sec

» High-Density Print Head Technology

» Five-Color Dye/Pigment Reactive Ink Set

» Sub-Ink Tank System » Economy Print Mode

» MS Office Plug-In & AutoCAD Module » USB 2.0 and Ethernet

(CAIPF670)
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— Introduction to Inkjet Paper —

Surface Finishes

Glossy
Instantly recognizable by its reflective, smooth appearance, a
glossy finish is most commanly thought of as the go-to paper for
printing photographs. This is due to the paper's
i ability to display deep blacks with saturated,
vibrant colors that make images pop. The
coatings used on these kinds of papers
also provide a water resistant guality that
can make sure your prints will last for a
years after your make them. Along with these
benefits, glossy papers generally provide a sharp, crisp image that
will benefit photographs and graphics with fine details.

PAPER AND INKJET MEDIA

Matte
On the oppasite end of the spectrum from glossy, matte papers
offer an appearance that more closely resembles that of traditional
art papers. Many matte papers feature a textured
appearance that can add another layer of
artistry to your final print. The texture can be
subtle or extremely obvious, as in the case
of mould-made cotton-based papers, which
allows users to choose the ideal surface for
presenting their work. Additionally, the matte
surface is less susceptible to showing fingerprints and marks during
handling, making it a somewhat easier paper type to work with.

Luster
Known by names such as satin, semi-matte/gloss, silk, pearl,
and more; Luster offers a surface in-between glossy and matte,
usually with a fine tooth and texture, and a slight
reflective quality. This type of surface gives
f the paper an excellent range from white to
black, outstanding color reproduction, and,
depending on the specific paper, the tooth
or texture to further accentuate your art's
content. Luster balances the benefits of both
glossy and matte papers, and as is a very popular
option for many professional printers.

Basic Information & Specifications

Weight & Thickness

When looking for paper, basis weight and thickness are related
specifications that tie into a paper’s overall feel and quality.
Weight refers to the heft of a paper and demonstrates a paper’s
feel and strength over time. It is important to know as not all
printers can accept thick fine art paper.

Materials and Coatings

The material the paper is made of, which could be: wood fiber,
canvas, cotton rag, vinyl, rice, bamboo, or athers, plays a large part in
how the printed images will look, due to how it holds the ink and the
physical characteristics of each. These coatings can have their own
effect on the print as well, giving each combination a unigue look.

Brightness, Whiteness, & Tone

These specifications indicate the overall appearance of a paper;

each characteristic will have a significant effect on print quality. The
brightest part of your image is limited by the brightness of the paper
itself, while the overall color and tone is determined by the whiteness,
which is usually listed as a warm (natural), neutral, or cool color.

Other Considerations

Opacity

Important for display purposes, opacity tells users how transparent
a sheet of paper or banner material is. This plays a role in deciding
what types of material are best suited to your specific application.

Roll / Sheets

Many papers are found in both sheets and rolls, with each offering
its own benefits. Rolls allow for long panoramas and work wonder-
fully with large format printers for high volume printing. Sheets, on
the other hand, offer convenience for smaller formats.

Single / Double-Sided

Due to the necessity of coatings on modern papers, most are not
coated on both sides in order to save on costs. If you require double-
sided printing for a book or ather application, you will need to make
sure your selected paper is optimized for two-sided printing.

To view a full listing of
all Inkjet Media & Paper [gfels

USES

Fine Art Designed for archival purposes
and display, so-called fine art paper offers
classic materials and coatings that will
lend their own quality to the print. This can
include prints of artwork, photos, or even
important documents that require the utmost
in quality and preservation.

Canvas While not a paper, per se,
canvas offers a well-known aesthetic. It
lends a sense of gravitas to your prints
and the ability to display your artwork in
a more creative fashion. Also, recently

developed coatings, such as metallic, are

breathing new life into this classic art surface.

ICC Profiles

B&H’s Excellent Selection

Brands

Epsan, Canon, Itford, Hahnemuhle, and more can be found at B&H,
with each brand offering their own unique paper styles, materials, and
technologies. Check back often to find the latest brands & papers.

Selection

Canvas, metallic, cotton rag, vinyl, and more are among the papers
types you'll find at B&H. With practically any type of paper for
nearly any situation, and more and more varieties being added all
the time, we have a vast selection of papers to suit your needs.

Sizes

Find everything from your standard 4 x 6" phato paper to large 72"
wide rolls for epic panoramas. Available in sheets and rolls, you
can be assured that no matter how large or small your project is
you will be able to get the paper you need at B&H.

or visit our website
BandH.com/w15103

Photo Prints Astaple of modern

inkjet printing, photographs are perhaps the

most popular reason people will print at

home, and as such, photographic paper is

¥ one of the widest paper selections there is.
This includes the vast array of standard glossy

paper most people are accustomed to, as well as
heavyweight textured papers suitable for gallery exhibitions.

/m\ Office Found in practically every
workspace and home, office printing paper

£ is optimized for documents, both large and

small. [tis generally lightweight, bright

white, and has a coating designed to handle
¥ the speedy inkjet printers available today.

Specialty Users with very specific
purposes and applications require uncommon
styles and types of printing materials to
accomplish their goals. Luckily, B&H carries
" many unique options such s clear film,
adhesive vinyl, rice paper, and more that will
assist you in getting your job done.

Adhesive Vinyl

Proofing Making sample prints no longer has to cost an arm
T ~ and a leg with the availability of many different
proofing papers on the market today. This

lightweight paper type offers surfaces that

) are similar to higher-end papers, in order to

/- provide a comparably less expensive option
/ to see how a final print will turn out.

Carolina thar
C1S 18 Point

Even with the best paper in the world, digital printing still relies heavily on computing to turn your digital images and graphics into physical prints. This is where ICC profiles come in
handy. Many manufacturers offer profiles to download alongside their different papers that will help tell the printer how to manipulate the ink and colors, so that you will have a final print

that looks as close as possible to the screen that you are viewing it on. These are optimized for specific printer and paper combinations to ensure you get the best print possible.
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Imaging Products
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cnn{on@ s“ Hahnemihle

Canon EPSON Kodak ILFORD B

NKkPRESS

BreaTHING COLOR’

ADVANCED INKJET MEDIA

INNOvA4R Perma./=:s * b =i

MORE THAN PAPER

THE COATING COMPANY

() MOAB Perorico

Inkiet Media

800-947-3308 - 212-444-6691






